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Introduction to JasperReports Server
JasperReports® Server builds on JasperReports® Library as a comprehensive family of
Business Intelligence (BI) products, providing robust static and interactive reporting, report
server, and data analysis capabilities. These capabilities are available as either stand-alone
products, or as part of an integrated end-to-end BI suite utilizing common metadata and
provide shared services, such as security, a repository, and scheduling. The server exposes
comprehensive public interfaces enabling seamless integration with other applications and
the capability to easily add custom functionality.

This section describes functionality that can be restricted by the software license for JasperReports
Server. If you don’t see some of the options described in this section, your license may prohibit you
from using them. To find out what you're licensed to use, or to upgrade your license, contact
Jaspersoft.

The heart of the Jaspersoft® BI Suite is the server, which provides the ability to:

• Easily create new reports based on views designed in an intuitive, web-based, drag
and drop Ad Hoc Editor.

• Efficiently and securely manage many reports.

• Interact with reports, including sorting, changing formatting, entering parameters,
and drilling on data.

• Schedule reports for distribution through email and storage in the repository.

• Arrange reports and web content to create appealing, data-rich Jaspersoft
Dashboards that quickly convey business trends.

For users interested in multi-dimensional modeling, we offer Jaspersoft® OLAP, which runs
as part of the server.

While the Ad Hoc Editor lets users create simple reports, more complex reports can be
created outside of the server. You can either use Jaspersoft® Studio or manually write
JRXML code to create a report that can be run in the server. We recommend that you use
Jaspersoft Studio unless you have a thorough understanding of the JasperReports file
structure. See Adding Reports Directly to the Repository and the Jaspersoft Studio User
Guide for more information.

You can use the following sources of information to learn about JasperReports Server:
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• Our core documentation describes how to install, administer, and use JasperReports
Server and Jaspersoft Studio. Core documentation is available in PDF format on the
Product Documentation website. You can also access PDF and HTML versions of
these guides online from the Documentation section of the Jaspersoft Community
website.

• Our Ultimate Guides document advanced features and configuration. They also
include best practice recommendations and numerous examples. You can access
PDF and HTML versions of these guides online from the Documentation section of
the Jaspersoft Community website.

• Our Online Learning Portal lets you learn at your own pace, and covers topics for
developers, system administrators, business users, and data integration users. The
Portal is available online from the Professional Services section of our website.

• Our free samples, which are installed with JasperReports Library, Jaspersoft Studio,
and JasperReports Server, are available and documented online. Please visit our
GitHub repository. See Adding Reports Directly to the Repository and Jaspersoft
Studio User Guide for more information.

• If you have a subscription to our professional support offerings, please contact our
Technical Support team when you have questions or run into difficulties. They're
available on the web at https://www.jaspersoft.com/support.

JasperReports Server is a component of both a community project and commercial
offerings. Each integrates the standard features such as security, scheduling, a web services
interface, and much more for running and sharing reports. Commercial editions provide
additional features, including Ad Hoc views and reports, advanced charts, dashboards,
Domains, auditing, and a multi-organization architecture for hosting large BI deployments.

This chapter contains the following sections:

• Logging In

• The Getting Started Page

• The Library Page

• Browsing the Repository

• Searching the Repository

• Using Repository Resources

• Sorting the Repository List

https://community.jaspersoft.com/documentation/
http://community.jaspersoft.com/documentation
http://community.jaspersoft.com/documentation
https://community.jaspersoft.com/wiki/new-online-learning-portal-courses
http://www.jaspersoft.com/
https://github.com/Jaspersoft/jasperreports
https://www.jaspersoft.com/support
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Logging In
Launch JasperReports Server by entering http://<hostname>:8080/jasperserver-pro in a
web browser, where <hostname> is the name of the computer that hosts JasperReports
Server. The Login page appears.

Figure 1: Jaspersoft Login Page

To log in to the server, JavaScript and cookies must be enabled in your browser.

Rhino JavaScript engine has been removed from JasperReports Server. With the removal of Rhino JS,
reports created using JavaScript do not function unless you add Rhino JS back to your deployment.
This can be done by stopping the web server, downloading version 1.7.14, which at the time of writing is
not known to have any CVEs. This file can be replaced into the WEB-INF/lib folder, and reports that rely
on JavaScript will again be functional.

Before logging in, review the information on the login page. There are links to the online
help and additional resources.

You can log in as the following users:

• superuser/superuser to manage configuration and organizations .

• jasperadmin/jasperadmin to manage a single organization.

• joeuser/joeuser to see an end user's view.
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• demo/demo to view the demo dashboard, if samples were installed.

For security reasons, administrators should always change the default passwords immediately after
installing JasperReports Server, as described in the JasperReports Server Administrator Guide.

To log in to the server

Procedure
1. Enter your user ID and password.

If you installed an evaluation server with the sample data, you can log in with the sample user IDs and
passwords. For more information, click Need help logging in?

If the Organization field appears in the Login panel, enter the ID or alias of your organization. If you
don’t know it, contact your administrator. For more information, see Logging into a Server with Multiple
Organizations.

The default administrator login credentials are superuser/superuser and jasperadmin/jasperadmin.

2. If you want to use a different locale and time zone than the server uses, click Show
locale & time zone.

The Locale and Time zone fields appear in the Login panel. Select your locale and
time zone from the dropdown menus.

3. Click Login.

If you entered a valid user ID and password, the server displays the Getting Started
page, as shown in Getting Started Page.

Logging into a Server with Multiple Organizations
If the administrator has configured your server to use the multi-tenancy feature, it supports
multiple organizations. Each organization has its own private area for storing files and
resources. The default Login dialog for a multi-tenant server has an additional field:
Organization. The left side of Login Methods for Multiple Organizations shows this field.
Enter the ID or alias of your organization. For example, enter the ID of the default
organization: organization_1.

You don’t have to enter the organization ID each time you log in. The first time you log in,
include the organization ID in your login URL, as shown on the right side of Login Methods
for Multiple Organizations. Bookmark the URL and use it for subsequent logins. The
Organization field does not appear in the dialog when you specify it in the URL.
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http://<hostname>:8080/jasperserver-pro/login.html

http://<hostname>:8080/jasperserver-pro/login.html?
orgID=organization_1

Figure 2: Login Methods for Multiple Organizations

The superuser account does not specify an organization because it is the system-wide
administrator. If the Organization field appears in the Login dialog when you log in as a
superuser, leave it blank. If you try to log in as a superuser with an orgID in the URL, the
server returns an error.

Disabled Accounts
Failed login attempts can disable an account. The number of remaining attempts is
displayed after a failed login attempt.
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In the event of a disabled account due to multiple failed login attempts, contact your
administrator to unlock the account.

Refer to the JasperReports Server Administrator Guide and JasperReports Server Security
Guide for more information on disabling or limiting this feature.
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The Getting Started Page
From the Getting Started page, you can quickly access the most frequently used features of
the server.

Figure 3: Getting Started Page

Core Workflows
The Getting Started page for standard users has multiple blocks that link to the core
workflows of JasperReports Server that may include some or all the following options:

• Ad Hoc Views - Select or create a visualization for basic reporting and analysis.

• Reports – Create an interactive report from an Ad Hoc view, or select an existing
report.

• Dashboards - Combine related visualizations into a single-page layout, or select from
existing layouts.

• Data Sources - Select or define a connection to a database or other data source.
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• Domains - Add structure to your data source for use in a visualization.

• Users and Settings - Configure your server instance and manage user settings. This
block is visible only to users with administrator privileges.

Each workflow block on the Getting Started page may contain buttons linking to pages or
wizards to create related elements. Each workflow block links to a filtered repository list
containing relevant items. Click these blocks to access the resources. Users with
administrator access may have more of these options available to them.

The Getting Started Column
On the left side of the page, there are two lists to help you locate and access relevant
information and assets.

• Recent Items - Includes links to up to five recently viewed repository items, such as
reports, Ad Hoc views, and dashboards.

• Video Tutorials - Includes links to video tutorials for various JasperReports Server
features.

• Popular Resources - Includes links to educational and support resources.

Menu Items
The menu items along the top of the Getting Started page are available from every page on
JasperReports Server. The Returns to the Getting Started page and the Library, View,
Manage, and Create menus offer the options described in the table below.

Menu Description

Returns to the Getting Started page.

Library Displays a pared-down repository page that contains the Ad Hoc views, reports,
and dashboards the currently logged in user has rights to

View • Search Results - Displays the repository of resources filtered by criteria
selected in the Filters panel.
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Menu Description

• Repository - Displays the repository of files and folders containing
resources, such as reports, report output, data sources, and images.

• Schedules - Lists the reports that you have scheduled.

• Messages - Lists system messages, such as an error in a scheduled
report.

Manage • Organizations - Opens the Manage Organizations page.

• Users - Opens the Manage Users page.

• Roles - Opens the Manage Roles page.

• Server Settings - Opens the Server Settings | Log Settings page.

Create • Ad Hoc View - Launches the Ad Hoc Editor for designing views
interactively.

• Report - Launches the Create Report dialog for creating a report based
on an Ad Hoc view and a report template.

• Dashboard - Launches the Dashboard Designer for laying out multiple
reports with input controls, labels, and images.

• Domain - Launches the Domain Designer for setting up a Domain.

• Data Source - Launches the New Data Source page for specifying the
attributes of the new data source.

If you log in as an administrator, the Home page has additional options and menu items
for managing users, roles, organizations, and settings, such as repository folder names.
Administrator functions are documented in the JasperReports Server Administrator Guide.
The links to the Online Help, Log Out, and a search field appear on all JasperReports
Server pages. For more information about searching, see Filtering Search Results.

JasperReports Server Keyboard Shortcuts
JasperReports Server provides keyboard shortcuts to help you navigate its web UI without
the use of a mouse or other pointing device. These shortcuts are available on the Login
page, the Home page, the Library Page, the Repository page, the Search Results page, and
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the interactive Report Viewer, allowing you to log in, move between major navigational
elements of these pages, select and open reports, and navigate tabular reports.

Shortcuts include:

Key Action

Left Arrow Navigate left one column, cell, or item.

Right Arrow Navigate right one column, cell, or item.

Up Arrow Navigate up one row, cell, or item.

Down Arrow Navigate down one row, cell, or item.

Enter Select an item or navigate into an inner
control.

Escape Cancel an action or navigate out to an outer
control.

Tab Navigate to the next major region or the
form field. Focus moves from left to right.

Note that, on some pages, the Shift key can also be used with the arrow keys or Tab:

• When used with the arrow keys, Shift multi-selects items, such as reports listed in
the Library page.

• When used with Tab, Shift changes the direction that focus moves from left to right
to right to left.

In addition, the web UI has improved compatibility with screen readers, which assist
visually impaired users in using computers. The implementation follows the WAI-ARIA (Web
Accessibility Initiative Accessible Rich Internet Applications Suite) technical specification.
WAI-ARIA has been certified for certain versions of JAWS (Job Access With Speech) with
certain browsers:

• Microsoft Edge with JAWS 2018 - 2021

• Google Chrome with JAWS 2018 - 2021

For information on the compatible versions of browsers, see the Jaspersoft Platform
Support Guide.
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To increase JasperReports Server's accessibility further, we recommend that you enable
the Easy Access theme, which increases color contrast and highlighting in the web UI. It
can improve the user experience of those with visual impairment. For more information on
the themes, see the JasperReports Server Administrator Guide.

The Library Page
The Library page offers a more focused view of the repository objects. It contains only the
Ad Hoc views, reports, and Dashboards that the currently logged-in user has the rights to
view and work with.

Click Library to view your Library list.

Figure 4: Library Page

From the Library page, you can:

• Run and schedule reports.

• Open Ad Hoc views and generate reports from them.

• Run and edit dashboards.

• Run OLAP views.

All of these functions are available by right-clicking the item that you want to work with
and selecting an action from the context menu.
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Created vs. Modified Dates
The Library table has two columns that refer to when the repository items were created
and last modified.

Generally, the created date is earlier than the modified date. In some situations, however,
the created date may be after the modified date. This can happen for one of two reasons:

• When an existing report (A) is modified, then subsequently copied into a new report
(B). In the Library list, report B’s created date is the day it was created, but its
modified date reflects the last time report A was changed.

• An existing report is exported from one system and imported into another. In the
Library list, the reports created date is the date it was imported into the new
system, and the modified date is the date it was last modified in the original system.

Browsing the Repository
The repository is the server’s internal storage for reports, analysis views, and related files.
The repository is organized as a structure of folders containing resources, much like a file
system. However, unlike a file system, the repository is stored as a private database that
only JasperReports Server can access directly.

To browse the repository, select View > Repository. From the repository page, you can
access the reports, themes, and other files stored on the server. You can browse the
repository contents that you have permission to view by expanding the icons in Folders.
Click a folder name to view its contents to see the Repository page as shown in Repository
Folders Panel.
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Figure 5: Repository Folders Panel

Searching the Repository
You can search the entire repository, subject to permissions, or narrow the search using
filters. Filters restrict a search by name, who changed the resource, type of resource, date
of the resource, and schedule.

Searching the Entire Repository
To search the repository, select View > Search Results. The search results page appears.
Instead of only viewing resources by folder, use intuitive search criteria, such as who
modified the resource and when, to find pinpoint resources.

On the search results page, use either the Filters panel or Search field to find resources.
The search results page displays results of searches and filters.
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Figure 6: Search Results Page

To search all resources in the repository

Procedure
1. Select one of these filters: All available, Modified by me, or Viewed by me.

2. Click the icon in the search field to clear the search term if there is one.

3. Select All types, as shown in Search Results Page.

4. Click .

The search results appear listing files that your user account has permission to view.
Click a resource in the list to view it or right-click a resource to see what functions
are available from the context menu.
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The server remembers your settings on the Search Results page, so the most commonly
needed resources remain visible when you return to the page.

Filtering Search Results
If you enter a search term and click at the top of any server page, the server does not
use filters. The search uses these default settings:

• Include subfolders.

• Start at the top-most folder visible to the user.

• Search for reports, report outputs, OLAP views, or other resources.

• Sort alphabetically by name.

If you click View > Search Results and click the search results page, the server uses the
filters you set in the Filters panel.

In Search Field and Search Results, you can see the results of a search for the term
“account” using the filters All available and All types.

Figure 7: Search Field and Search Results

The search term that you enter in the search field is not cleared automatically. To clear the search

term, click the icon in the search field.

You can refine a search using filters. For example, filters can help you find your most
recently viewed reports. You can set each filter independently. You can set the following
types of filters:

• User
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• Resource

• Access time

• Scheduled report

The user filter has the following settings:

Filter Setting Description

All Available
(default)

All resources.

Modified by me Selects only resources that were last modified by the user who is logged
in.

Viewed by me Selects only resources that were run and viewed by the user who is
logged in. This filter not only applies to visualization types, but also to
resources that are included in reports such as images.

The resource type filter has the following settings:

Filter Setting Description

All types (default) All resources.

Reports Displays only reports, both JRXML reports and Ad Hoc reports.

Report outputs Displays only the output from reports that were scheduled or run in the
background. Report output can be any of the supported export types,
such as HTML and PDF.

Dashboards Displays only dashboards.

OLAP views Displays only analysis views (if you implement Jaspersoft OLAP).

Domains Displays only Domains.

Data sources Displays only data sources.

The access time filter has the following settings. All times are relative to the user’s effective
time zone:
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Filter Setting Description

Any time (default) All resources.

Today Resources viewed or modified since the previous midnight.

Yesterday Resources viewed or modified during the previous day ending at
midnight.

Past week Resources viewed or modified during the past 7 days, including today.

Past month Resources viewed or modified during the past 30 days, including today.

The scheduled report filter has the following settings:

Filter Setting Description

Any schedule
(default)

All resources.

Scheduled Only reports that have scheduled jobs.

Scheduled by me Only reports that have jobs scheduled by the currently logged in user.

Not scheduled Only reports that do not have scheduled jobs and all other resource
types.

Remember these do's and don'ts when searching for resources:

• Do use word fragments.

• Do search for the display name or part of the display name of a resource.

• Do search for words or fragments in the description of a resource.

• Do use multiple words.

• Don’t search for folder names.

• Don’t enter quotes around terms or symbols between terms.

• Don’t worry about using upper- or lower-case letters in search terms.
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Using Repository Resources
After finding a resource in the repository, naturally you want to do something with it.
Options are:

l Click the name of a report to run and view it.

l Right-click the name of a resource to access other operations on the context menu,
for example Edit or Open in Designer. Items appear on the context menu according
to your permissions.

l Click anywhere in the row except the resource name to select a resource. Ctrl-click
anywhere in the rows to select multiple resources. Use the context menu or buttons
above the results list: Run, Edit, Open, Copy, Cut (move), or Delete. If the button is
unavailable, the resource does not support the operation or you do not have
permission for the operation. For example, the Open button is available when you
select a dashboard or an Ad Hoc report if you have permission to write to it.
You might also need permission to access the folder or dependent file, such as an
image of a resource. For example, to schedule a report, you need to have
read/write/delete permission on the folder where the server saves the report output.
For more information about permissions, see the JasperReports Server Administrator
Guide.

• Open In Editor is available on the context menu when you right-click the reports and
files. This editor opens text files like .css, .properties, .json, .xml, .csv, .jrtx, and
.jrxml. In the case of the report unit, it shows a dialog with all the files from the
report unit that you can open by clicking the file. For more information on the report
unit, see Overview of a Report Unit.
You can edit most of the files in the text editor while in the case of .jrxml files, a
JRXML editor opens. For more information on JRXML editor, see Jaspersoft
Community Site.

https://community.jaspersoft.com/wiki/tibco-jasperreports-web-studio-professional-edition
https://community.jaspersoft.com/wiki/tibco-jasperreports-web-studio-professional-edition
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Figure 8: JRXML Editor for JRXML File

The following two icons may appear in the Repository panel:

•  - Indicates that the report has saved options for its input controls. Click the
 icon to list the saved options. For more information, see Running a Report with
Input Controls or Filters.

•  - Indicates that the report is scheduled to run or is running in the background.
Click this icon to view the list of jobs scheduled for the report. For more information,
see Scheduling Reports and Dashboards.

Moving Folders
If you have read permission on folders and resources, you can copy and cut them from one
folder and paste them to another if you have write permission on the destination folder.
The server pastes all contents of the folder into the new location.

You can drag-and-drop the objects instead of using the paste menu item. Move folders one
at a time. You can move other resources in batches.

Relocated objects inherit permissions from the destination folder, losing the permissions in place
before the move. To change permissions on an object, set the permissions explicitly.

To move folders and resources by cutting and pasting
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Procedure
1. Log in to the server as a user who has these permissions:

l Read permission on the folder or resource to move

l Write permission on the destination folder
For example, log in as joeuser (use the password, joeuser).

2. Click View > Repository.

3. In the Folders panel, right-click Reports >Samples and select Add Folder.

4. In the Add Folder dialog, enter a name, such as Financial Reports, and click Add.

The Financial Reports folder appears as a subfolder of Samples and inherits Joe
User’s default permissions (read-write-delete) on the parent folder.
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Figure 9: New Financial Reports Folder

5. The Financial Reports folder deserves a more prominent location. Move it up one
level:

a. In Folders, right-click Financial Reports, and select Cut.

b. Right-click Reports, and select Paste.

The Financial Reports folder now appears in Reports at the same level as
Samples.
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Note:
You can relocate a folder, subject to permissions, anywhere in the
repository with one exception: The server doesn’t support copying
and pasting a folder to the same location. If the Paste command is
disabled when you right-click a destination folder, you don’t have
write permission on the folder.

Sorting the Repository List
To change the order of the list of reports and other resources, use the Sort By controls:

• Click Name to sort alphabetically (A at the top). This is the default sort order.

• Click Modified Date to sort by the latest modified time and date (most recent at the
top).

Accessibility
Accessibility is the ability to access any application with ease. Websites, applications, tools,
and technologies must be designed and developed in a way that makes it easy for
everyone to use them. Accessibility enables people with special abilities to access, interact,
and navigate through an application. This provides a better user experience and improves
usability.

The main purpose of accessibility is to promote inclusivity among all users, including users
with special abilities.

Organizations are keen to integrate accessibility. There are international guidelines of
compliance that must be followed for web accessibility including:

• Web Content Accessibility Guidelines (WCAG) 2.1 also known as ISO/IEC 40500

• Country-based accessibility guidelines, such as 508c in the U.S.A.

Voluntary Product Accessibility Template (VPAT) is a template used to document the
product's conformance with accessibility standards and guidelines.

For JasperReports Server, WCAG 2.1 level A and level AA are implemented. Assistive
technology such as, screen reader and voice recognition systems, are used to access the
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application. In addition, keyboard navigation is made easier for the ease of use while not
using a mouse.

WCAG is implemented on the Login, Home, Repository, Library, and Search Result
pages. The field that must be entered first, on any of these pages, is focused on and the
control is already available on that field. You can use the Tab key, arrow keys, Enter key
and the Shift + Tab keys, on the keyboard, to navigate around the page.

There are a few limitations of accessibility in JasperReports Server, including:

l Library:

o Non-text elements are not read by the NonVisual Desktop Access (NVDA) screen
reader.

o Unable to navigate to the Favorite icon using the keyboard.

l Repository:

o While navigating from Folder > Add Folder, the dialog name is not tagged as a
heading.

o Unable to navigate to the Favorite icon using the keyboard.

l Favorites:

o Favorite button is not accessible using the Tab and arrow keys.

o Interactive role missing for list items.

l Search Results:

o Labels missing for the expandable/collapsible buttons in the Filter section.

o Interactive role missing for list items in the Filter section.

l Loginand Home:

o Footer content overlaps at 400%.

l Repository tree, List, and Toolbar:

o The screen reader does not provide the status message after selecting the Cut,
Copy, and Paste options.

l The End button on the keyboard does not move focus to the last cell or last row
where infinite scrolling is used.

l Touchscreen devices and mobile devices do not support accessibility.
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l The Favorite icon is the last element read by the screen reader on each Repository
List row, even though it is the first element.

Report Exporter and Viewer
In addition, when the reports are embedded in other applications, it is the HTML output
produced by the JasperReports Library HTML exporter which is displayed there. The report
exporter is enhanced to introduce semantic information in the output, so that the screen
reader can understand the information in the report.

For images in the report, it is mandatory to include an alternate text for the screen reader
to understand and read it out. For the tables in the report, the screen reader first
introduces the report, reading out the number of rows and columns. It then follows it up
by reading out the information in the table.
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Working with Dashboards
This section describes functionality that can be restricted by the software license for JasperReports
Server. If you don’t see some of the options described in this section, your license may prohibit you
from using them. To find out what you're licensed to use, or to upgrade your license, contact
Jaspersoft.

A Jaspersoft dashboard displays several reports in a single, integrated view. A dashboard
can include input controls for choosing the data displayed in one or more dashlets, and
custom dashlets that point to URLs for other content. By combining different types of
related content, you can create appealing, data-rich dashboards that quickly convey
trends.

Figure 10: Sample dashboard

This chapter contains the following sections:

• Viewing a Dashboard

• Overview of the Dashboard Designer

• Creating a Dashboard

• Specifying Parameters in Dashlets

• Editing a Dashboard

• Scheduling a Dashboard

• Getting the Embed Code for Visualize.js
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• Exporting Dashboards and Dashlets

• Tips for Designing Dashboards

Viewing a Dashboard
You can view a dashboard if you have the proper permissions. The following procedure
walks you through opening one of JasperReports Server's samples, the Supermart
dashboard.

To view the Supermart dashboard

Procedure
1. Log in as user demo, using the password demo.

Passwords are case-sensitive. Use the lowercase when you type demo.

The Supermart Top View dashboard opens in the dashboard viewer.

Figure 11: Supermart Dashboard Example

2. Click one of the USA gauges.
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3. Select USA, then click Close to change the data displayed.
The two dashlets with Country data update to display data for USA only.

You can click the funnel icon to select one or more countries from a filter panel.

4. Click the Sales Metrics Dashboard.
A new dashboard opens. The Sales Metrics Dashboard includes reports on sales by
region, state, and city.

5. On the Sales Metrics Dashboard, click Back to return to the Supermart Dashboard.

Use the Back button instead of the browser back button. This ensures the best experience
with respect to the state of the previous page.

6. When done, click View > Repository to go to the repository page.

If a dashboard does not appear when you click its name in the repository, it may
already be open in another window or tab of your browser.

If you have the proper permissions, you can easily switch from viewing a dashboard to
editing it.

To edit the Supermart dashboard

Procedure
1. Open the Supermart dashboard in the dashboard viewer.

2. Click the Viewing button on the title bar and select Editing from the dropdown list.

3. Edit the dashboard by adding, removing, resizing, or dragging content.

For more information about working with dashboard content, see Creating a
Dashboard.

4. When you are satisfied with the dashboard, hover your cursor over and select
Save Dashboard. To create a new version of the dashboard, select Save Dashboard As
and specify a new name.

If you close the dashboard without saving the changes, you are prompted to save or cancel the
changes made to the dashboard.
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Overview of the Dashboard Designer
The Dashboard Designer is a web-based UI for embedding reports, Ad Hoc views, and other
BI objects into a single, interactive space. You can compile dashboards that include pre-
existing elements, such as reports and views, and create new charts, tables, and crosstabs
from your data sources directly from the designer.

Each element on your dashboard is called a Dashlet. Dashlets have unique names and
resource IDs, and editable settings that vary depending on the Dashlet type.

Your permissions to access the repository may limit the content you can add and the
location where you can save the dashboard.

This section includes:

• The Dashboard Designer Interface

• Dashlets and Dashboard Elements

• Previewing a Dashboard

• Dashboard Settings

• Dashlet Settings

• Parameter Mapping

The Dashboard Designer Interface
The following figure shows the basic layout of the Dashboard Designer.
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Figure 12: The Dashboard Designer UI

The Dashboard Designer UI includes the following panels:

• Available Content. From here, you can drag content onto the Dashboard Canvas.
This panel includes the following sections:

• New Content, which lists the content elements you can create for your
dashboard.

• Existing Content, which lists the Ad Hoc views and reports you can access from
the Repository.

• Filters, which list all filters associated with any resource added to the dashboard.

• Toolbar Buttons. See the table below for details.

Icon Name Description

Save
Dashboard/Save
Dashboard As

Hover the cursor over the icon to open a menu of
save options.

Undo the last
change

Click to undo the most recent action.

Redo the last Click to redo the most recent undone action.
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Icon Name Description

change

Reset the
dashboard to its
last saved state

Click to revert the dashboard to the most recently
saved state.

Show parameter
mapping dialog

Click to open the Parameter Mapping dialog. See
Parameter Mapping for more information.

Show/hide grid
overlay

Click to display or hide a grid.

Toggle Filter Group
Pop-up

Click to display or hide a filter pop-up window. This
button only appears when you enable filter dashlet
pop-ups in Dashboard Settings.

Get Embed Code Click to display the Dashboard Embed Code dialog.
See Getting the Embed Code for Visualize.js for
more information.

Schedule
dashboard

Click to display the New Schedule dialog. See
Scheduling a Dashboard for more information.

Close Dashboard You can use this button to close the dashboard and
return to the page from where a dashboard is
accessed.

• Dashboard Canvas. This is where you create and edit your dashboard. It includes the
following sections:

• Title Bar, which displays the name of the dashboard (in the figure above, the
name is "New Dashboard"). It also includes the Editing/Viewing button, which
allows you to switch between editing the dashboard and displaying it as viewed
by the end user.

• Main Creation Area, where you build your dashboard. Drag elements from the
Available Content panel here to get started.

• Dashboard Settings. This section displays the properties specific to the dashboard.
See Dashboard Settings for more information.
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Dashlets and Dashboard Elements
Each element added to your dashboard is called a Dashlet.

To add a Dashlet to your dashboard, simply select a content element and drag it onto the
dashboard canvas. Certain content, such as charts and crosstabs, open an embedded Ad
Hoc editor, which is the same editor used to create Ad Hoc views. See Overview of the Ad
Hoc Editor for more information.

Dashlets can include the following elements, which you can access from the Available
Content panel:

• New Content:

• Chart: It allows you to create a chart using an embedded Ad Hoc editor.

• Crosstab: It allows you to create a crosstab using an embedded Ad Hoc editor.

• Table: It allows you to create a table using an embedded Ad Hoc editor.

• Text: A free-form text entry field. Use free text items to add titles and
instructional text to the dashboard.

• Web Page. Any URL-addressable web content. The dashboard can point to web
content.

• Image: An image from the repository or that is accessible by a web address URL.
For example, you might include a dashlet that displays your corporate logo. The
logo's image file can be either in your repository or on the server of your
corporate website.

• Existing Content: Reports and Ad Hoc views are accessible to you.

• Filters: If a dashlet you include on the dashboard is designed to use input controls or
filters, you can add that capability to the dashboard. The server maps input controls
to one or more dashlets.

• Title Bar: You can enable a title bar in the Dashlet Settings. The title bar includes the
following elements:

• The Dashlet name, as entered in the Dashlet Settings.

• Dashlet toolbar, which can contain the following:
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Icon Name Description

Maximize Click to open the dashlet as a larger view.

Refresh Click to refresh the dashlet.

Export Click to export the dashlet and save the output to
your computer. See Exporting Dashboards and
Dashlets for more information.

For more advanced functionality, you can access the settings panel that lets you edit the
overall appearance of your dashboard, modify the functionality of your dashlets, and
create mappings between your dashboard input controls and your dashlets.

Previewing a Dashboard
You can preview your dashboard in display mode to see how it appears when an end-user
views it.

To preview a dashboard

Procedure
1. Click the Editing button and select Viewing from the dropdown list. The dashboard

opens in display mode.

2. To close the preview and return to the Dashboard Designer, click the Viewing button
and select Editing from the dropdown list.

Dashboard Settings
You can view and edit the basic appearance of the dashboard, and determine the refresh
settings, through the Dashboard Settings.

To view and edit the Dashboard Settings

In the Dashboard Designer, Dashboard Settings display in the settings panel.
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Figure 13: Dashboard Settings

Canvas
• Background color: Select the canvas background color by using the color picker

or by entering a color value (hex, rgb, and rgba color formats are supported).

• Set custom size (pixels): Click the Set custom size (pixels) switch to turn it on,
when you want the dashboard to be displayed at a specific width and height
instead of dynamically resizing based on the browser window. The Width and
Height inputs can be used to set the required width and height.

General
• Show Export button: Click the Show Export button switch to turn it on, to show

the Export button in the dashboard viewer.

• Auto-refresh: Click the Auto-refresh switch to turn it on. The Interval inputs can
be used to set the required refresh interval.
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Dashlet
l Show Filter Dashlet as pop-up window: Click the switch to turn the setting on, when

you want the filter dashlet to appear as a pop-up window instead of a dashlet pinned
on the dashboard.

l Show borders: This setting is on by default. Click the switch to turn the setting off, to
hide the dashlet borders.

l Outer margin (pixels): Enter the required width, in pixels, of the margins between
dashlets.

l Inner padding (pixels): Enter the required width, in pixels, of the padding inside each
dashlet.

l Title bar:

o Text: Text color for the title bars of all the dashboard's dashlets. Select the
color by using the color picker or by entering a color value (hex, rgb, and rgba
color formats are supported).

o Background: Background color for the title bars of all the dashboard's dashlets.
Select the color by using the color picker or by entering a color value (hex, rgb,
and rgba color formats are supported).

Dashlet Settings
You can view and edit basic information and appearance for each dashlet on your
dashboard using Dashlet Settings. For some dashlets, you can also create parameters that
you can then map to in Parameter Mapping. The available settings vary based on the type
of dashlet that you are working with.

To view and edit Dashlet Settings

Select the dashlet to show its settings in the settings panel. The Hyperlinks settings are
available for Ad Hoc views and Ad Hoc view dashlets created inside the dashboard, as well
as text and image dashlets. The Text Format settings are available for text dashlets.
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General and Dashlet Appearance Settings for Reports and
Ad Hoc View Dashlets

Figure 14: General and Dashlet Appearance Settings for Reports and Ad Hoc View Dashlets
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General Settings
• Dashlet name: Editable field for the displayed dashlet name.

• Resource ID: Non-editable ID taken from the original dashlet name.

• Source Data: Non-editable path of the source data.

The label name for this setting is different for different resource types:

• Source Data: For new Ad Hoc views created in dashboards (Chart, Crosstab, and Table)

• Source Ad Hoc View: For the existing Ad Hoc views

• Source Report: For the reports

• Auto-refresh: Click the Auto-refresh switch to turn it on. The Interval inputs can be
used to set the required refresh interval.

Dashlet Appearance Settings
• Show title bar: Choose to show or hide the title bar, which includes the Dashlet

name, Refresh button, Maximize button, Back button, and Export button.

• Show Visualization Selector button: Choose to show or hide the Visualization
Selector button.

• Scale report to fit: Use the dropdown menu to determine how the element is scaled
in the dashlet. Scale report to fit is available for report dashlets Scale to fit is not
available for Ad Hoc view dashlets.
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Hyperlinks Settings

Figure 15: Hyperlinks Settings

The Hyperlinks settings are available for Ad Hoc views and Ad Hoc view dashlets created inside
the dashboard, as well as text and image dashlets.

l Enable hyperlinks: Click the Enable hyperlinks switch to turn it on.

l Action: Select the link behavior for this dashlet:

o Update page: Select this option to update the dashboard's contents when a
user clicks a link in the dashlet.

o Open new page: Select this to have the dashlet open a web page or report,
dashboard, or an Ad Hoc view in the repository in a new browser tab or
window when a user clicks the dashlet. Click Browse to select a resource from
the repository.

You can link directly to a web page using http: syntax:
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http://en.wikipedia.org/wiki/$P{Customer Country}

A repository URL must begin with repo:. For example,

repo:/public/Samples/Ad_Hoc_Views/05._Unit_Sales_Trend

You can add a parameter to a hyperlink for a web page, dashboard, Ad Hoc
view, or report. See Specifying Parameters in Dashlets for more information
about adding parameters to hyperlinks.

o Replace page: Select this option to replace the current dashboard page with a
web page or report, dashboard, or an Ad Hoc view in the repository when a
user clicks the dashlet. Click Browse to select a resource from the repository.
The syntax for links and parameters is the same as the Open new page option.

If the dashlet replaces the page with an Ad Hoc view, then it opens in the Ad
Hoc View Designer. A Back button appears on the toolbar after the dashlet
opens a report or dashboard that takes you back to the previous dashboard.

o Replace dashlet: Select this option to replace the current Ad Hoc view in a
dashlet with some other Ad Hoc view, Report, or Report Option in the
repository when a user clicks the dashlet. Click Browse to select a resource
from the repository. The syntax for links and parameters is the same as the
Open new page option.

• Available parameters: If you want to add a parameter in the hyperlink, use a name in
this list to have Parameter Mapping create the link to the parameter automatically.

• Add parameter: For text and image dashlets, you can define a parameter to include
in the hyperlink. Click the Add parameter button and in the fields that display, enter
the parameter's name and value. Click to save the new parameter.
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Figure 16: Adding a New Parameter to a Dashlet

l Map Parameters: If hyperlinks have been enabled, the Map Parameters button is
active. Click Map Parameters to open the Parameter Mapping dialog box. See
Parameter Mapping for more information.
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General, Text Format, and Dashlet Appearance Settings
for Text Dashlets

Figure 17: General, Text Format, and Dashlet Appearance Settings for Text Dashlets

General Settings
• Dashlet name: Editable field for the displayed dashlet name.

• Resource ID: Non-editable ID taken from the original dashlet name.

• Text: Editable field for the text displayed in the dashlet.
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Text Format Settings

The Text Format settings are only available for text dashlets.

• Scale to fit: Use the dropdown menu to determine how the text is scaled in the
dashlet. This overrides the specified font size.

• Font: Use the select input to select the font.

• Size: Enter the font size or click the arrows to select a value.

• Color: Color for the text displayed in the dashlet. Select the color by using the color
picker or by entering a color value (hex, rgb, and rgba color formats are supported).

• Style: Apply the text style using the associated toggle buttons. Multiple options can
be selected.

• Horizontal alignment: Apply the horizontal alignment using the associated toggle
buttons. Only one option can be selected.

• Vertical alignment: Apply the vertical alignment using the associated toggle buttons.
Only one option can be selected.

Dashlet Appearance Settings
• Show borders: This setting is on by default. Click the switch to turn the setting off, to

hide the dashlet border. If you select to show the dashlet border, you can choose
the border color.

• Background color: Select the dashboard background color by using the color picker
or by entering a color value (hex, rgb, and rgba color formats are supported).
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General and Dashlet Appearance Settings for Web Page
Dashlets

Figure 18: General and Dashlet Appearance Settings for Web Page Dashlets

General Settings
• Dashlet name: Editable field for the displayed dashlet name.

• Resource ID: Non-editable ID taken from the original dashlet name.

• URL: Editable field for the URL displayed in the dashlet.

• Auto-refresh: Click the Auto-refresh switch to turn it on. The Interval inputs can be
used to set the required refresh interval. This setting overrides the Auto-refresh
setting at the dashboard level.

Dashlet Appearance Settings
• Show title bar: Choose to show or hide the title bar, which includes the Dashlet

name, Refresh button, and Maximize button.

• Show scroll bars: Choose to show or hide scroll bars.
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General and Dashlet Appearance Settings for Image
Dashlets

Figure 19: General and Dashlet Appearance Settings for Image Dashlets

General Settings
• Dashlet name: Editable field for the displayed dashlet name.

• Resource ID: Non-editable ID taken from the original dashlet name.

• URL/Repository URI: Editable field for the location of the image displayed in the
dashlet. This can include parameters. Click Browse to select an image from the
repository.
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Dashlet Appearance Settings
• Show borders: This setting is on by default. Click the switch to turn the setting off,

to hide the dashlet border. If you select to show the dashlet border, you can choose
the border color.

• Show title bar: Choose to show or hide the title bar, which includes the Dashlet
name, Refresh button, and Maximize button.

• Scale image to fit: Use the dropdown menu to determine how the image is scaled in
the dashlet.

General and Dashlet Appearance Settings for Filter
Dashlets

Figure 20: Filter Dashlet Settings

General Settings
• Dashlet name: Editable field for the displayed dashlet name.

• Resource ID: Non-editable ID taken from the original dashlet name.
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Dashlet Appearance Settings
• Filters per row: The default value is 1. To show more than one filter per row, select a

different value in the associated select input.

• Show Apply button: This setting is on by default. Click the switch to turn the setting
off, to hide the button.

• Show Reset button: This setting is off by default. Click the switch to turn the setting
on, to show the button.

• Dashlet buttons position: Use the dropdown menu to select bottom or right.

Parameter Mapping
Parameter Mapping helps you refine your filters by letting you specify which dashlets and
which parameters are affected by a filter.

To open Parameter Mapping

Procedure
1. Open a dashboard with filters, such as the Sales Dashboard created in Creating a

Dashboard, in the Dashboard Designer.

2. Click to open Parameter Mapping.

Figure 21: Parameter Mapping for the Sales Dashboard

Parameter Mapping displays the filter-to-dashlet mapping, and includes the following
columns and buttons:
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• Source Dashlet, the name of the dashlet where the filter originates. It can also
display Filter Group (multiple filters in a single dashlet) or Manually Created
Filter (filter created using Parameter Mapping, as described below).

• Filter/Parameter, the name of the filter.

• Dashlet Affected, with a dropdown menu including all dashlets that can be
affected by that filter.

• Filter/Parameter Affected, with a dropdown menu including all parameters
associated with the selected dashlet in the Dashlet Affected column.

• Add button , used to add additional dashlet/parameter combinations to a
filter.

• Delete button , used to delete a dashlet/parameter combination.

From Parameter Mapping, you can add, delete, or edit an existing dashlet/parameter
combination, and create a new filter to add to the dashboard.

To add a filter using Parameter Mapping

Procedure
1. Open a dashboard with filters, and open Parameter Mapping as described above.

2. In the filter row, click to add the new filter . A row containing new affected dashlet
and filter/parameter dropdown menus appears.

3. Using these new line-items, select the dashlet and parameter combination you want
to apply to the dashboard.

4. Click OK to apply and save or Cancel to discard your changes.

To delete a filter using Parameter Mapping

Procedure
1. Open Parameter Mapping.

2. In the filter row, click to delete. The filter row disappears from Parameter
Mapping.

To create a new filter via Parameter Mapping
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Procedure
1. Open Parameter Mapping.

2. Click Create New Filter. A new row is added to the manager.

3. In the Filter column, enter a name for the new filter. Click outside the text box to
apply the name.

4. Click and select the dashlet and parameter combination you want to apply to the
new filter.

5. Click OK to apply and save, or Cancel to discard the new filter.

To delete a newly created filter

Procedure
1. In Parameter Mapping, click in the filter row you want to delete. The Dashlet

Affected and Filter/Parameter affected dropdown menus disappear.

2. Click again in the row that you want to delete. The Filter row disappears.

3. Click OK to apply and save, or Cancel to discard the new filter.

Creating a Dashboard
This section describes the creation of a simple dashboard.

To add a report or Ad Hoc view to a dashboard, you must have permission to view those elements.

To create a simple dashboard

Procedure
1. Click Create > Dashboard. The Dashboard Designer appears, displaying the list of

available content and the canvas.

2. In the Existing Content section of the Available Content panel, find report 16.
Interactive Sales Report.

3. Click and drag the report onto the Dashboard Canvas.
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Figure 22: Dragging report onto Dashboard Canvas

4. In Available Content, find 04. Product Results by Store Type Report.

5. Click and drag the report onto the canvas, until the left half of the Interactive Sales
Report turns blue.

The Product Results by Store Type Report appears on the canvas, next to the
Interactive Sales Report. Both report dashlets are sized to fit side-by-side on
the canvas.

6. Select the Product Results by Store Type Report dashlet, the dashlet settings displays
in the settings panel.

7. Use the Scale report to fit dropdown to select Dashlet.

The resized Product Results by Store Type Report now displays the entire crosstab in
the dashlet.

8. Click and drag the report 05. Accounts Report onto the canvas, until the lower half of
the Interactive Sales Report turns blue.

The Accounts Report is placed under the Interactive Sales Report, and both dashlets
are resized to fit on the right half of the canvas.

9. Go to the Dashboard Settings on the settings panel.

10. Click the Show borders switch under Dashlet settings to turn the setting off.

In Simple Dashboard Canvas with three reports you can see how the dashboard
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canvas looks at this point.

Figure 23: Simple Dashboard Canvas with three reports

11. Click the Editing button and select Viewing to preview the dashboard.

The end user view of the dashboard appears.

12. Click the Viewing button and select Editing to return to the designer.

13. Click , then select Save Dashboard.

14. In the Save As window, change the default name, New Dashboard to Sales Dashboard
and locate a folder, such as the /Dashboards folder.

15. Click Save.

You can include a report with the Detail Chart Enabled property as enabled or disabled in
the dashboard.

Adding New Content
In addition to pre-existing reports and Ad Hoc views, you can create content for your
dashboard directly from the Dashboard Designer, including:

• Charts

• Crosstabs

• Tables
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• Text

• Web page links

• Images

Adding Charts, Crosstabs, and Tables
The Dashboard Designer includes an embedded Ad Hoc Editor, which allows you to create
charts, crosstabs, and tables for your dashboard without leaving the designer environment.

Any chart, crosstab, or table you create within the Dashboard Designer is available only on
the current dashboard. Otherwise, they function like standard Ad Hoc Editor-created
versions of these elements. They are saved as an Ad Hoc view and placed in a dashlet on
your dashboard.

To add a new chart, crosstab, or table to your dashboard

Procedure
1. In the New Content section of the Available Content panel, click and drag the type of

element you want to add to your dashboard (Chart, Crosstab, or Table) onto the
dashboard canvas.

The Ad Hoc Editor opens, and the Select Data dialog appears.

2. Browse to or search for the data source that you want to use.

l Click for a tree view of the files.

l Click for a list view of the files.

l Use the text search field to locate a specific data source.

3. Depending on your selected data source, the remaining steps may vary. Follow the
displayed instructions. for more information about this process, see Ad Hoc Sources:
Topics, Domains, and OLAP Connections.

4. When you complete the data source selection process, click OK. The Ad Hoc Editor
opens.

The embedded Ad Hoc Editor works just like the standard editor. For information on
working with the editor, see Working with the Ad Hoc Editor.
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Figure 24: Embedded Ad Hoc Editor

5. When you finish creating your view, click to save.

6. In the Save to Dashboard dialog, enter a dashlet name, and click Save. The dashlet is
added to your dashboard.

Adding Text
You can add a text field dashlet for titles and instructional text.

To add a text dashlet

Procedure
1. In the New Content section of the Available Content panel, click and drag the Text

item onto your dashboard. The Dashlet Text window opens.

2. Enter the text that you want to appear on your dashboard.

3. Click OK. The dashlet is added to your dashboard.

Edit the dashlet name and font appearance in Dashlet Settings. See Dashlet Settings
for more information.
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Adding a Web Page
You can add a dashlet to display a web page on your dashboard.

To add a web page dashlet

Procedure
1. In the New Content section of the Available Content panel, click and drag the Web

Page item onto your dashboard. The Dashlet URL window opens.

2. Enter the URL that you want to appear on your dashboard.

3. Click OK. The dashlet is added to your dashboard.

Edit the dashlet name in Dashlet Settings. See Dashlet Settings for more information.

Adding an Image
You can add a dashlet to display an image, such as a corporate logo, on your dashboard.

To add an image dashlet

Procedure
1. In the New Content section of the Available Content panel, click and drag the Image

item onto your dashboard. The Dashlet URI window opens.

2. Enter the URI for the image that you want to appear on your dashboard. Use the
repo: syntax for images in your repository.

3. Click OK. The dashlet is added to your dashboard.

Edit the dashlet name in Dashlet Settings. See Dashlet Settings for more information.

Adding Controls to a Dashboard
The Interactive Sales Report was designed to be run with input controls. When you add a
report that has input controls to a dashboard, the controls don’t appear until you explicitly
add them, one-by-one. The controls can either be added directly to the dashboard as a
dashlet or accessed from the toolbar as a pop-up window. When the report runs,
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dashboard users provide input using the control. Data based on the user input appears in
the dashboard. For example, using the input control, you select Mexico. The report on the
dashboard shows orders from Mexican companies.

Keep these points in mind when viewing a dashboard that has input controls:

• An input control may appear as a text field, a drop-down, a check box, a multi-select
list box, or a calendar icon.

• If one of the dashlets in a dashboard does not refer to an input control, that dashlet
does not update when you change that input control’s value. Only dashlets that use
the input control reflect the change.

• The buttons on the toolbar allow you to undo and redo recent
changes made to the dashboard, including changes using an input control.

• If the button appears on the toolbar, then the dashboard was set up to display
input controls as a pop-up window instead of a dashlet. Click the button to view the
controls.

To add controls as a dashlet

Procedure
1. If the Sales Dashboard created in Creating a Dashboard is not open, locate the

/Dashboards folder in the repository. Right-click the dashboard name and select
Open in Designer from the context menu.

The Sales Dashboard appears in the designer, as shown in Simple Dashboard Canvas
with three reports, and the input controls available appear in the Filters section of
the Available Content panel.

2. In the Filters section, expand the 16. Interactive Sales Report folder.

The input controls associated with the Interactive Sales Report appear.

3. Drag the Country input control onto the canvas, and place it above the Product
Results by Store Type dashlet.

The Country input control and its label appear above the Product Results by Store
type report on the canvas.

4. Drag the Product Family and Product Department controls onto the Country input
control dashlet. These input controls are added to the same dashlet. Resize the
dashlets as needed to view all of the input controls.
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5. Click and select Save Dashboard, then click the Editing button and select
Viewing to preview the dashboard.

6. Click in the Country text box to display the available countries. In this input control,
you have the following options:

l The three countries: Canada, Mexico, and USA.

l All, which selects all available values in the input control.

l None, which deselects all available values in the input control.

l Invert, which deselects any selected values, and selects the unselected
values.

7. Use the options to select Mexico from the values list, and click Apply at the bottom of
the dashlet. The data displayed in the Interactive Sales Report changes, but is not
updated in the other reports, as they do not have an input control named Country.

8. Click the Viewing button and select Editing to return to the Dashboard Designer.

You can also change the labels, or display names, of individual input controls and filters
within a dashlet.

To rename an input control or filter

Procedure
1. With the Sales Dashboard open in the Dashboard Designer, select Product Family in

the input control dashlet, filter settings display in Dashlet Settings in the settings
panel.

2. Change the Filter label from Product Family to Type.

3. Select the Product Department input control, filter settings display in Dashlet
Settings in the settings panel. Change the Product Department filter label to
Department. The input control labels are updated.
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Figure 25: Parameter Mapping for the Sales Dashboard

To add controls as a pop-up window

Procedure
1. With the Sales Dashboard open in the Dashboard Designer, go to the Dashboard

Settings on the settings panel.

2. Click the Show Filter Dashlet as pop-up window switch to turn it on.

The input controls dashlet disappears from the dashboard and appears on the
toolbar. This button is also displayed when you're viewing the dashboard.

3. Click and select Save Dashboard, then click the Editing button and select
Viewing to preview the dashboard.

4. Click to view the filter pop-up window.
Like the dashlet, selecting the options in the pop-up changes the data displayed in
the Interactive Sales Report.

5. Click to close the filter pop-up window.

6. Click Viewing button and select Editing to return to the Dashboard Designer.

Refining a Dashboard’s Layout
After completing the layout, refine the look and feel of the dashboard.

To refine the dashboard’s layout
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Procedure
1. If it is not open, locate the Sales Dashboard you created in Creating a Dashboard,

typically in the /Dashboards folder.

2. Right-click the dashboard name. Select Open in Designer from the context menu.

3. When the dashboard opens in the designer, select Viewing to preview.

The end user’s view of the dashboard appears.

4. In the Country field, select a new value.

The reports do not update because the dashboard includes the Apply button.

5. Return to the Dashboard Designer and select the Country filter dashlet, to show the
dashlet settings in the settings panel.

6. Click the Show Apply button switch to turn it off, and click the Show Reset button
switch to turn it on.

The dashlet's Apply button disappears, and the Reset button appears.

7. Reposition the Reset button to the right side of the dashlet using the Dashlet
buttons position dropdown menu.

8. Select Viewing to preview. The end user view of the dashboard appears.

9. Change the value in the Country input control. The dashboard reflects the change
immediately.

10. Return to the Dashboard Designer and click Save > Save Dashboard. The dashboard
is saved to the repository.

Specifying Parameters in Dashlets
You can add parameters to dashlet names, text dashlets, web page dashlets, image
dashlets, and hyperlinks in Ad Hoc viewdashlets. When you add a parameter, you must
map a filter in the dashboard to the parameter. See Mapping parameters in Parameter
Mapping for more information.

Simple parameters

For the text dashlets, web links, and dashboard names, use the syntax $P{parameter_
name} to directly pass the parameter value to the web page. Examples:
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l In a text dashlet, enter the parameter in the Text box:
Product Family: $P{Product Family}

l In a web page dashlet or a web link in an Ad Hoc view dashlet hyperlink, enter the
parameter in the Web Page Address (URL) text box:
http://en.wikipedia.org/wiki/$P{Store Country}

l In a repository or web URI for an image dashlet, enter the parameter. Enter the
parameter in the Web Address/Repository URI text box:
repo:/public/Samples/Reports/$P{Store Country}/flag.png

l Dashlet name: Enter the parameter in the Dashlet Name box:

Unit Sales for $P{Product Family}

For repository hyperlinks in an Ad Hoc view dashlet, use the syntax ?filter_in_target=$P
{dashlet_param}. For example, the following link sets the c_country_1 input control in the
05. Unit Sales Trend report to the value of a Store Country parameter in the dashlet.

repo:/public/Samples/Reports/05._Unit_Sales_Trend?c_country_1=$P{Store
Country}

To find the correct name for a filter in a target resource, open the Dashboard Designer in a
new window, and add the resource to the canvas. Then expand the resource's folder in the
Filters panel and hover over the filter whose name you want to see.

Parameters in multi-valued input controls

For multi-valued input controls, you can define a separator for the input control values:

l For text dashlets, web links, and dashboard names, use the syntax $P{parameter_
name ? "separator"}. The following example in a text box displays results like Product
Family: Drink + Food:
Product Family: $P{Product Family ? " + "}

l For repository links in an Ad Hoc view or image dashlet, use the syntax ?$P{"filter_in_
target=", dashlet_param, ? "&"}. For example, the following link allows multi-select
with the c_country_1 input control in the 05. Unit Sales Trend report:
repo:/public/Samples/Reports/05._Unit_Sales_Trend?$P{"c_country_1=",
Store Country, "&"}

When Mexico and USA are selected, this expands to the following link:
repo:/public/Samples/Reports/05._Unit_Sales_Trend?c_country_1=Mexico&c_
country_1=USA
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Auto-complete parameters
When you type the $ symbol into a dashlet's text box, a dropdown list of available
parameters is displayed. Select a parameter from the list or continue typing to narrow
down the list of parameters. The auto-complete parameters feature is available for text
fields, image links, and web links, but it is not available for the dashlet name field.

Figure 26: Text dashlet showing available parameters

Mapping parameters in Parameter Mapping
After you have created a parameter, create a mapping for it as follows:

Mapping parameters in dashboard names and text, image, or web page
dashlets

Procedure

1. In the Dashboard Designer, click to open Parameter Mapping.

2. In the filter row where you want to add the new filter, click . A row containing new
affected dashlet and filter/parameter dropdown menus appears.

3. Using these new line-items, select the dashlet where you added a parameter, then
select the parameter.

4. Click OK to apply and save or Cancel to discard your changes.
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Mapping parameters in Ad Hoc view hyperlinks

To have JasperReports Server create a parameter mapping automatically:

Procedure
1. In the Dashlet Settings of the Ad Hoc view dashlet, use one of the names in the

Available parameters list as the name of your parameter.

2. Click OK to close the dialog box and create the mapping.

To create a mapping in Parameter Mapping:

Procedure
1. In the Dashlet Settings of the Ad Hoc view dashlet, click Create Links in Parameter

Mapping... to open Parameter Mapping.

2. In the filter row where you want to add the new filter, click . A row containing new
affected dashlet and filter/parameter dropdown menus appears.

3. Using these new line-items, select the dashlet where you added a parameter, then
select the parameter.

4. Click OK to apply and save or Cancel to discard your changes.

Creating a Web Page Dashlet
When working with Web Page dashlets in the Dashboard Designer, you can include a
parameter reference in the dashlet's URL. The parameter references an existing filter in
another dashlet, and uses that filter to display a specific web page relevant to the filtered
information.

The following example takes you through the steps for creating a simple dashboard in the
Dashboard Designer, adding a sample chart with geographic filters, and creating a Web
Page dashlet that displays a Wikipedia page for the country the sample chart is filtered on.

First, create the simple dashboard

Procedure
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1. Log in to JasperReports Server as superuser.

2. Click Create > Dashboard.

The Dashboard Designer appears, displaying the list of available content and the
canvas.

3. In the Existing Content section of the Available Content panel, find report 08. Key
Performance Metric Trend.

4. Click and drag the report onto the Dashboard Canvas. Note that the Filters section
now includes the 08. Key Performance Metric Trend folder.

Next, add the filter input control to the dashboard

1. In the Filters section, expand the 08. Key Performance Metric Trend folder.

The input controls associated with the 08. Key Performance Metric Trend report
appears.

2. Drag the Store Country input control onto the canvas.

Now, add the Web Page dashlet with the parameter reference and add it to
the filter

Procedure
1. In the New Content section of the Available Content panel, click and drag the Web

Page item onto your dashboard.

The Dashlet URL window opens.

2. Enter the following URL:
http://en.wikipedia.org/wiki/$P{Store Country}

3. Click OK.

4. In the Dashlet Settings, change the Dashlet name to Wiki.

5. Click OK.

6. Click the Ad Hoc menu to open Parameter Mapping.

7. In the Store Country filter group, click .

A row containing the new affected dashlet and filter/parameter dropdown menus
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appears.

8. In the Dashlet Affected column, select Wiki from the new Select dashlet... dropdown
menu.

9. In the Filter/Parameter Affected column, select Store Country from the new Select
parameter... dropdown menu.

10. Click OK.

Finally, preview the new dashboard functionality

Procedure
1. Click the Editing button and select Viewing to preview the dashboard.

2. Click in the Store Country text box to display the available countries.

3. Select Canada from the values list in the Store Country input controls, and click
Apply at the bottom of the dashlet. The data in the Key Performance Metric Trend
report is updated to display only information about Canada, and the wiki dashlet
displays the Wikipedia page for Canada.

In Dashboard with web page parameters you can see how the dashboard preview looks at
this point:

Figure 27: Dashboard with web page parameters



JasperReports® Server User Guide

70 | Working with Dashboards

4. Click the Viewing button and select Editing to return to the Dashboard Designer.

5. Click , then select Save Dashboard.

6. In the Save As window, change the default name, New Dashboard to Key
Performance Metric Trend Dashboard and locate a folder, such as the /Dashboards
folder.

7. Click Save.

Adding a Hyperlink to Ad Hoc View Dashlets
When working with Ad Hoc view dashlets in the Dashboard Designer, you can specify a link
that opens when a user clicks the dashlet. You can optionally include a parameter that
references an existing filter in another dashlet, and uses that filter to display a specific web
page relevant to the filtered information.

The following example takes you through adding a hyperlink to the Ad Hoc view dashlet
created in Creating a Web Page Dashlet. The example also shows how to add a parameter
to a hyperlink.

First, open the dashboard

Procedure
1. If the Key Performance Metric Trend dashboard created in Creating a Web Page

Dashlet (above) is not open, then locate the /Dashboards folder in the repository.
Right-click the dashboard name and select Open in Designer from the context menu.
The Key Performance Metric Trend dashboard appears in the designer.

Create an Ad Hoc view hyperlink

Procedure
1. Select the 08. Key Performance Metric Trend dashlet to show its settings in the

settings panel.

2. Go to the Hyperlinks settings in Dashlet Settings.
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Figure 28: Hyperlinks settings in Dashlet Settings

3. Click the Enable hyperlinks switch to turn it on.

4. Choose Open new page from the Action menu.

The URL/Repository URI input is displayed.

5. Enter repo:/public/Samples/Reports/04._Product_Results_by_Store_Type_Report for
the URL/Repository URI.

To see the report's path, hover over the report's name in the Existing Content pane.
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6. Press Enter or Tab, or change the mouse focus anywhere in the canvas for the
changes to take effect.

Preview the new dashboard functionality

1. Click the Editing button and select Viewing to preview the dashboard.

2. Click the Ad Hoc view dashlet.
The 04. Product Results by Store Type Report gets open in a new tab.

3. Return to the tab containing the Key Performance Metric Trend dashboard and click
the Viewing button and select Editing to return to the Dashboard Designer.

Add a parameter

Procedure
1. Select the Key Performance Metric Trend dashboard dashlet to show its settings in

the settings panel and go to the Hyperlinks settings.
The Available parameters section shows the parameters available in the Ad Hoc view.

2. Modify the URL to add a parameter that provides a value for an input control in the
target report:

l You need to know the correct name of the input control in your target report.
In this case, it is sales__store__store_contact__store_country_1 in the 04.
Product Results by Store Type Report.

l Create a parameter. If you create a parameter name, it is helpful to use a name
that is not used in Parameter Mapping. In this example, use LinkCountry. For
more information about parameters, see Specifying Parameters in Dashlets.

The link is as follows:

repo:/public/Samples/Reports/04._Product_Results_by_Store_Type_
Report?sales__store__store_contact__store_country_1=$P{LinkCountry}

If you use one of the names in the Available Parameters list, the mapping to the
parameter is created for you. In this example, if you use Store Country instead of
LinkCountry, you do not need to create links in Parameter Mapping.

This example does not show how to add support when more than one country is
selected. For more information, see Specifying Parameters in Dashlets.

3. Click Map Parameters. Parameter Mapping is displayed.
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Figure 29: Parameter Mapping

4. In the Store Country filter group, click .
A new row with affected dashlet and filter/parameter dropdown menus appears.

5. In the Dashlet Affected column, select 06. Sales Mix by Gender from the new Select
dashlet... dropdown menu.

6. In the Filter/Parameter Affected column, select LinkCountry from the new Select
parameter... dropdown menu.

7. Click OK.

Finally, preview the new dashboard functionality

Procedure
1. Click the Editing button and select Viewing to preview the dashboard.

2. Click in the Store Country text box to display the available countries.

3. Select Mexico from the values list, and click Apply at the bottom of the dashlet.

4. Click the Ad Hoc view dashlet.
The 04. Product Results by Store Type Report gets open in a new tab.

5. To verify that the parameter has been passed correctly, click in the 04. Product
Results by Store Type Report.
The Input Controls dialog box opens, with Mexico set.

6. Return to the tab that contains your dashboard.

7. Click the Viewing button and select Editing to return to the Dashboard Designer.

8. Click , then select Save Dashboard.
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Editing a Dashboard
You can edit a dashboard if you have the proper permissions.

To edit a dashboard

Procedure
1. Select View > Repository and search or browse for the Dashboard you want to

modify.
By default, the repository includes the /Dashboards folder where you can store
dashboards.

2. Right-click the dashboard and select Open in Designer from the context menu. The
designer appears, displaying the dashboard.

3. Edit the dashboard by adding, removing, resizing, or dragging content.
For more information about working with dashboard content, see Creating a
Dashboard.

4. When you are satisfied with the dashboard, hover your cursor over and select
Save Dashboard. To create a new version of the dashboard, select Save Dashboard As
and specify a new name.

If you close the dashboard without saving the changes, a dialog box prompts you to save or cancel
the changes made to the dashboard.

Scheduling a Dashboard
You can schedule a dashboard from the dashboard view mode and the edit mode
(dashboard designer).

To schedule a dashboard

Procedure
1. On the dashboard toolbar, click to open the New Schedule dialog.
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Figure 30: New Schedule Dialog

The New Schedule dialog has the following tabs:

l Schedule – When to run the scheduled job, and how often.

l Parameters – If the dashboard was designed with input controls, which parameters
the scheduled job uses.

l Output Options – The name of the output file, the output format and locale, and
where the output file is stored.

l Notifications – Email options for sending the output to recipients and for sending
administrative messages.

2. Create the schedule, as described in Creating a Schedule.

3. Click Save. The Save dialog appears.

4. In the Scheduled Job Name field, enter a name for the job. The description is
optional.

5. Click Save to save the schedule. The job appears in the list of saved jobs for
dashboards.

For information on viewing, modifying, or deleting the schedules, see Scheduling Reports
and Dashboards.
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Getting the Embed Code for Visualize.js
Visualize.js is the JavaScript library available with JasperReports Server to embed
dashboards and reports in custom web apps. If you create an app with Visualize.js, this
feature gives you the JavaScript code needed to embed the current dashboard in your app.
You can then write additional code to interact with the dashboard programmatically, for
example to update a filter depending on other actions in your app. For more information,
see the JasperReports Server Visualize.js Guide.

You can get the embed code for a dashboard from the dashboard view mode and the edit
mode (dashboard designer).

To get a dashboard embed code

1. On the toolbar, click to open the Dashboard Embed Code dialog.

Figure 31: Dashboard Embed Code Dialog

The dialog shows the Visualize.js code and a preview of the dashboard as it is
currently saved.

2. Click the Copy Code button to copy the embed code to the clipboard.

3. Click the Open in JSFiddle button to load the embed code into JSFiddle, an online
JavaScript viewer and interactive editor.

4. Click the Close button to return to the dashboard.
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Exporting Dashboards and Dashlets
You can export a dashboard or a dashlet and save it on your computer. Dashboards can be
exported as a screenshot or in a detailed mode as a document. Dashlets can be exported in
a detailed mode as a document. Exporting a dashboard or dashlet requires the following:

• The export button has been enabled for the dashboard or dashlet. See Dashboard
Settings and Dashlet Settings for more information.

• Chrome/Chromium is installed on the computer hosting JasperReports Server. For
information on configuring Chrome/Chromium for dashboards, see the System
Configuration chapter in the JasperReports Server Administrator Guide.

To export a dashboard or a dashlet

Procedure
1. Select View > Repository and search or browse for the Dashboard you want to export.

2. Click the link to open the dashboard.

3. Hover your cursor over for the dashboard or individual dashlet and select the
export format from the drop-down list.
The available formats for dashboards are:

Type Format

Screenshot PNG Image (.png)
PDF Document (.pdf)
Microsoft Word (.docx)
OpenDocument Text (.odt)
Microsoft PowerPoint (.pptx)

Detailed PDF Document (.pdf)
Microsoft Excel (.xlsx)
Comma Separated Values (.csv)
Microsoft Word (.docx)
Rich Text Format (.rtf)
OpenDocument Text (.odt)
OpenDocument Spreadsheet (.ods)
Microsoft PowerPoint (.pptx)
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The available formats for dashlets are:

l PDF Document (.pdf)

l Rich Text Format (.rtf)

l Comma Separated Values (.csv)

l OpenDocument Text (.odt)

l OpenDocument Spreadsheet (.ods)

l Microsoft Word (.docx)

l Microsoft Excel - Paginated(.xlsx)

l Microsoft Excel (.xlsx)

l Microsoft PowerPoint (.pptx)

4. Save the dashboard or dashlet in the export file format, for example PDF, or open it
in the application.

You can export a dashboard containing a report with Detail Chart Enabled property as
enabled or disabled. This property does not impact output formats like PDF, Excel, PPTX,
etc.

If you perform the export while a dashlet is reloading its content, the dashlet will appear as a
grayed-out box in the exported file.

Localizing Controls
You can design dashboard controls to accommodate different languages. First, use the $R
syntax to define prompts and static lists of values. Next, attach resource bundles to the
report that contain translations of the prompts and lists of values. Finally, add the report
to the dashboard. For more information about how to localize input controls, see
Localizing Reports.

Tips for Designing Dashboards
Charts and small crosstabs are best suited to dashboards. However, you can design table
reports that work well in the dashboard. Such reports tend to be very narrow and are
typically used with input controls to limit the number of rows they return.



JasperReports® Server User Guide

79 | Working with Dashboards

Keep reports small because dashboards typically contain more than one. In particular,
reports should not be too wide, as horizontal room is always at a premium in a dashboard.
The server strips margins from an Ad Hoc report when displaying the report on a
dashboard.

Input Control Tips
When designing input controls for a dashboard, keep these guidelines in mind:

• To pass a value to an external URL, the URL Parameter Name you give to the input
control must match the name of a parameter that the URL can accept. The value of
the input control must also be a value the URL can accept. The target URL is likely to
have additional requirements and limitations. For example, the name of the
parameter may be case-sensitive. In this case, the value you enter in the URL
Parameter Name field is also case-sensitive.

The input control must pass data that the URL can accept. Otherwise, the server may be
unable to retrieve the correct data from the external URL.

Time-Date Wildcards
When creating dashlets, you can enter a wildcard into a text input field to display the
current date or time:

• $Date: Displays the current date in the Month Day, Year format. For example,
January 15, 2019. You can also customize how the date is displayed using the
following parameters:

• $Date{MM-DD-YYYY}. For example, January 15, 2019 is displayed as 01-15-2019.

• $Date{DD/MM/YYYY}. For example, January 15, 2019 is displayed as 15/01/2019.

• $Date{dddd MMMM DD, YYYY}. For example, January 15, 2019 is displayed as
Friday January 15, 2019.

• $Time: Displays the current time in the 12 hour format with am/pm, but without the
leading 0 for hours. For example, 1:25 pm. You can customize how the time is
displayed using the following parameters:

• $Time{HH:mm}. Displays the time in the 24 hour time format. For example, 1:25
pm is displayed as 13:25.



JasperReports® Server User Guide

80 | Working with Dashboards

• $Time{hh:mm a}. Displays the current time in the 12 hour format with am/pm
and the leading 0 for hours. For example, 01:25 pm.

• $Time{HH:mm:ss}. Displays the current time in the 24 hour time format with
seconds. For example, 1:25:30 pm is displayed as 13:25:30.

• $Time{hh:mm:ss a}. Displays the current time in the 12 hour format with
seconds, am/pm, and the leading 0 for hours. For example, 1:25:30 pm is
displayed as 01:25:30 pm.

• $Time{HH:mm:ss z}. Displays the current time in the 24 hour time format with
seconds and the time zone. The time zone is selected on the login page. For
example, 1:25:30 pm in the Pacific Standard time zone is displayed as 13:25:30
PST.

• $Time{hh:mm:ss a z}. Displays the current time in the 12 hour format with
seconds, am/pm, the time zone, and the leading 0 for hours. The time zone is
selected on the login page. For example, 1:25:30 pm in the Pacific Standard time
zone is displayed as 01:25:30 pm PST.

The wildcards are available for text fields, image links, and web links, but it is not available
for the dashlet name field.

When you type the $ symbol into a dashlet's text box, a dropdown list with the time-date
wildcards and other available parameters is displayed. Select the wildcard that you want
from the list or continue typing to narrow down the list.

Figure 32: Time-Date Wildcard Auto-complete
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Running Reports and the Report Viewer
JasperReports Server makes it easy to run reports. When you run a report, it opens in the
interactive Report Viewer. With the Viewer, you can personalize and refine the displayed
report data. If the report has input controls, you run the report with one set of data and
then another.

This chapter contains the following sections:

• Overview of the Report Viewer

• Running or Creating a Simple Report

• Getting New Perspectives on Data

• Navigating the Report

• Exporting the Report

• Scheduling a Report

• Getting the Embed Code for Visualize.js

• Running a Fusion Chart

• Running a Report with Input Controls or Filters

• Running a Report Book

The tutorials in this chapter and throughout this guide assume you’ve installed the sample
data provided with the server.

Overview of the Report Viewer
The Report Viewer allows you to view a report, export content to various output formats,
and apply formatting, sorting, and filters to control how the data is displayed.

This section describes the functions available in the Report Viewer. You can find more
detailed information about using this functionality throughout this chapter.

To open a report in the Report Viewer
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Procedure
1. Locate your report in the library or repository.

2. Click the report name, or right-click the report name and select Run. In the
repository, you can also click the report row and select Run from the tool bar. The
report opens in the Report Viewer.

Report Viewer Tool Bar
The Report Viewer tool bar contains a number of controls for working with your report.
These controls are described in Report Viewer Tool Bar Icons.

Icon Name Description

or View Alert
List

Click to open a panel that contains the list of
alerts.

When there are no alerts, this icon is a plain bell.

When there are one or more alerts, the bell icon
has a dot.

Refresh report
with latest data

Click to refresh the report data from the data
source.

Close Report Exits the Report Viewer and takes you to the
previous screen.

Save Place the cursor over this icon to open a menu of
save options.

Export Click to export the View into one of the available
formats.

Get embed
code

Click to display the Report Embed Code Panel.
For more information, see Getting the Embed
Code for Visualize.js.

Report Viewer Tool Bar Icons
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Icon Name Description

Schedule
report

Click to display the New Schedule dialog. For
more information, see Scheduling a Report.

Undo Click to undo the most recent action.

Redo Click to redo the most recently undone action.

Undo All Click to revert the report to its most recently
saved state.

Turn on alert
mode

or

Turn off alert
mode

Click to turn on or turn off the alert mode.

Input Controls Click to see the input controls applied to this
report. For more information, see Simple Input
Controls.

Zoom Out Click to zoom out on the report.

Zoom In Click to zoom in on the report.

Zoom Options Click this icon to open the Zoom Options
dropdown menu.

Search Enter your search term here to find a text string
in your report. Click the dropdown menu to
toggle search preference settings.
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Icon Name Description

First Click to jump to the first page of the report.

Previous Click to go to the previous page in the report.

Next Click to go to the next page in the report.

Current Page Shows the number of the currently displayed
report page.

Last Click to jump to the last page of the report.

Bookmarks Click to display the Table of Contents pane. This
pane is available only on reports with enabled
Bookmarks.

Column Menu
Reports that contain table components are enabled for user interactivity. Table
components are defined in Jaspersoft Studio or from Ad Hoc Views. When a table is
enabled for interactivity, the column formatting, filtering, and sorting are managed from a
menu displayed by clicking the column you want to apply changes to. These menu icons
are described in Export File Types.

Icon Name Description

Formatting/
Show column/
Hide column

Select Formatting to open the Format Column box.

Select the Show column or Hide column.

Column filters Click to open the Filter column box.

Column Formatting Icons
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Icon Name Description

Sort ascending Click to sort fields in the selected column in ascending order.

Sort descending Click to sort the fields in the selected column in ascending order.

Column size Click and drag this icon to make columns wider or narrower.

Data Snapshots
Some reports have an optional data snapshot feature enabled. A data snapshot is a cached
copy of the data included in a specific report. Data snapshots allow you to access a
report's data (including input control settings) without having to retrieve it from the data
source, which in some cases can save a significant amount of time.

When a report is opened in the Report Viewer, data is retrieved from the data snapshot. If
the snapshot does not exist, then a live query is made to the data source. A snapshot is
created when a report is saved from the viewer, or via the scheduler. The Report Viewer UI
displays a date and time stamp that indicates when the report data was last refreshed with
live source data.

The system administrator can enable or disable the data snapshot feature.

It should be noted that a report can have only one snapshot. For instance, if you edit and
save a report that already has a snapshot associated with it, a new snapshot overwrites the
previously created snapshot.

Report Viewer Responsiveness
A responsive report adapts its output to the current size of the screen. When you open a
responsive report in the Report Viewer and resize the screen, the Report Viewer lets you
view the rendered report based on the screen size. If the screen size is smaller, you can see
a rendered report suited for the smaller screen and so on. The response of the Report
Viewer to the different screen sizes makes it responsive.
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In the main JRXML of the report unit (See Overview of a Report Unit for more information),
the following property is used to communicate to the Report Viewer that the report is
responsive.

For example:

<property name=“net.sf.jasperreports.htmlviewer.responsive.breakpoints” value=“1000,
1200"/>

In this example, the integer values separated by comma declares the screen size intervals.
The Report Viewer reads this property when the report is run and retriggers the report to
run every time the screen size changes.

When you resize the screen, the Report Viewer reruns the report with the new REPORT_
CONTAINER_WIDTH value. REPORT_CONTAINER_WIDTH is a built-in parameter used to
control the rendering of a certain part template.

For example: If you define three screen size intervals:

• Smaller than 1000px

• Between 1000px and 1200px

• Greater than 1200px

Then, there will be three JRXML parts for each interval, and only the suited part appears
for the current screen size, read from the built-in REPORT_CONTAINER_WIDTH parameter
when the report is run.

If your report does not define screen size intervals, it is not considered responsive and the Report
Viewer runs the report only once and will not be responsive when the screen is resized.

Running or Creating a Simple Report
You can view and work on a report in the Report Viewer in a number of ways:

• Running an instance of an existing report

• Creating a new report from an existing Ad Hoc view

Running a Simple Report
This section describes how to run a tabular report that lists account data.
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To run a report

Procedure
1. Log in to the server as an administrator, such as jasperadmin.

2. On the Home page, click the large icon in the Reports block.
The search results appear, listing your own files and other files that your user
account has permission to view. If you log in as jasperadmin, 05. Accounts Report
appears in the search results.

Figure 33: Search Results Listing

3. To run a report, click the name of a report in the repository. For example, click 05.
Accounts Report. The report appears, as shown in Output of the Accounts Report.

Figure 34: Output of the Accounts Report
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If you are running a report with multiple pages, the first page of the report appears before the entire
report is loaded. You can begin scrolling through report pages as they load, as indicated in the
pagination controls in the upper left corner of the Report Viewer.

If you want to cancel loading the report before it is complete, click the Cancel Loading button that
appears next to the pagination controls.

Rhino JavaScript engine has been removed from JasperReports Server. With the removal of Rhino
JS, reports created using JavaScript do not function unless you add Rhino JS back to your
deployment. This can be done by stopping the web server, downloading version 1.7.14, which at
the time of writing is not known to have any CVEs. This file can be replaced into the WEB-INF/lib
folder, and reports that rely on JavaScript again becomes functional.

Creating a Report
You can create a report directly from the Jaspersoft Server Home page. This method allows
you to select an existing Ad Hoc view and generate a report from it, without going through
the Ad Hoc Editor.

To create a report from the Home page

Procedure
1. On the Home page, click Create in the Reports block. The Create Report wizard

opens.

2. Select the Ad Hoc view that you want to use as the basis for your report.

3. Select a report template. To use a template other than the default, select Custom
Report Template, click Browse, and select the desired template. See Report
Templates for more information.

4. Click OK. If asked, enter the input controls needed. See Using Input Controls.

You can now begin working with your report. If you close the report without saving the
changes, you are prompted to save or cancel the changes made to the report.

Report Templates
When you create a report, the Create Report wizard displays layout options for generating
and exporting the report:
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l Default Report Template applies basic layout options to your report. This is usually
the Actual Size template.

l Custom Report Template allows you to browse to an existing template.
JasperReports Server includes a number of templates are available by default,
including:

o A4 Landscape

o A4 Portrait

o Actual Size

o Letter Landscape

o Letter Portrait.

Other report templates may be available. Report templates can be created in
Jaspersoft Studio and uploaded to JasperReports Server.

l Report Generator allows you to create a highly customized report design. This option
is not often enabled. See your JasperReports Server administrator for more
information.

Most commonly, you choose the Default Report Template.

Using Report Templates for PDF
If you are exporting your report to PDF, choose your option based on the size of the
output.

• For most PDF exports, you can use Actual Size, which supports a maximum size of
14400px by 14400px.

• For reports with an output height exceeding 14,400 px, use a paginated report
template that is wide enough for your report. For example, if you have a long report
with width less than 842px, you can use the paginated A4 Landscape theme. A
report designer can create additional custom templates in Jaspersoft Studio.
Contact your administrator for more information.

• Reports with output width exceeding 14,400 px are truncated in PDF. Redesign your
report or use a different export format.
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Getting New Perspectives on Data
The report shown in the Output of the Accounts Report was created using the Ad Hoc
Editor. As this type of report runs, you can interact with it in the Report Viewer to visualize
the data in different ways. Column formatting allows you to highlight certain columns and
fields, and filtering and sorting report output on-the-fly can provide timely views of the
data that answer your questions. For example, suppose you’re running the Accounts Report
and want to know how many accounts have offices nearby. Highlighting the phone number
column with red text and filtering it to show only accounts in your area code would reveal
this data.

Column Formatting
You can customize the basic formatting of column headings and fields, using the Format

Column dialog. Hover over and click Formatting... The Format column dialog appears.

Figure 35: Format Column Dialog

You can alter a column’s basic formatting or apply conditional formatting to a column.

In longer reports, columns have floating headers. If your report extends past your browser frame,
use the vertical scroll bar to move up and down the list. If you do not see a vertical scroll bar, try
increasing the width of your browser window.

This section discusses how to apply formatting to column headings and values. For
information on conditional formatting, see Conditional Formatting.
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Column formatting options include:

• Text

• Font type, size, and style

• Background color

• Font color

• Text alignment

To customize your column formatting

Procedure
1. Run your report, so it opens in the Report Viewer.

2. Click the column that you want to format.

3. Hover over and click Formatting.

4. Click the Basic Formatting tab, and change the following options if needed:

l Apply to - Select the part of the column you want to apply the formatting to.

l Heading text - Type a new heading text to replace the current text.

l Font – Scroll through the menu to select a font.

l Size - Scroll through the menu to select a font size.

l Style - Click to select Bold, Italic, or Underlined text.

l Background Color - Click to open the background color picker, then click to
select the background color.

l Font Color - Click to open the font color picker, then click to select the text
color.

l Alignment - Click to select the Left, Center, or Right alignment.

5. If needed, click Previous Column or Next Column to change the formatting for an
adjacent column.

6. Click OK.
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Conditional Formatting
The Report Viewer allows you to format column headings and fields, to highlight data that
meets specific criteria. For instance, if you want to call out fields for store sales above
$100,000, you can do so by applying text and background formatting to those stores that
meet those numbers.

With conditional formatting, you can apply the formatting options listed in Column
Formatting. However, it is a slightly more complex process than applying formatting
options to entire columns. This section describes those complexities, including:

• Condition hierarchy

• Condition button states

• Applying conditional formatting

Condition Hierarchy
If you have multiple conditions applied to a single field, then their order affects how they
function. Conditions are read and applied from bottom to top, and the topmost condition
overrides the ones below.

For example, imagine you have more than one condition applied to the same format
element: red text for all stores over 20,000 square feet, and blue text for all stores over
30,000 square feet. As shown in Condition Hierarchy Example, placing the formatting rule
for stores over 20,000 above the rule for stores over 30,000 causes the topmost rule to
override the one below:
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Hierarchy Result

Figure 36: Condition Hierarchy Example

Condition Button States
Because conditions higher up in the hierarchy can affect those below, the font style
selection buttons each have three states:

• Unchanged, which means it inherits the previous condition-based style, if any.

• Set, which means the style is applied to the text that meets the condition.

• Not Set, which means the style is not applied to the text that meets the condition,
and is removed if a conflicting condition lower in the conditional formatting
hierarchy has marked that style as “Set”.

By default, the buttons are in the “Unchanged” state. Clicking the buttons toggles you
through the three states.

See Style Button States for examples of the style button states.
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Unchanged Set Not Set

Bold

Italic

Underline

Style Button States

The background and font color pickers have buttons for similar states, but these states
behave slightly different:

• Unchanged, which means the field inherits the previous condition-based color, if
any.

• Set, which means the color is applied to the text or background of the field that
meets the condition.

• No Fill (background only), which means no color is applied to the background that
meets the condition. Regardless of conditions lower in the hierarchy, the
background inherits the table’s default color.

Both have two buttons at the top of the window, along with the color selection boxes.

You control these states through the background color picker and the font color picker
windows, using the following buttons:

• No Fill (background only), which applies to the No Fill state described above.

• Reset, which returns the text or background to the Unchanged state.

• The color selection boxes, which apply to the Set state.

See Color Picker Button States for examples of the color picker button states.
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Unchanged Set No Fill

Background Color

Text Color N/A

Color Picker Button States

Applying Conditional Formatting
You apply conditional formatting much like you do standard column formatting, as
described in Column Formatting with the extra step of creating the condition by which the
formatting is applied.

To create a condition

Procedure
1. Run your report, so it opens in the Report Viewer.

2. Click the header or field of the column that you want to format.

3. Move your mouse over and click Formatting.

4. Click the Conditional Formatting tab. The Conditional Formatting options appear:

Figure 37: Conditional Formatting Tab

5. In the Apply to box, select the part of the column you want to apply the formatting
to.
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6. Click Add. This adds a line item in the Conditions List.

7. Fill in the following information:

l Operator: Use the dropdown menu to define how the condition is compared to
the column data.

l Condition: Enter the condition criteria.

l Format: Select the formatting applied to fields meeting the defined condition.
Take care while setting the button states, as described in Condition Button
States.

8. Repeat if needed to add multiple conditions to a column.
If you have multiple conditions, you may want to reorder them, to ensure they do not

conflict with each other. Use the and to move conditions in the hierarchy.

9. If needed, click Previous Column or Next Column to change the conditional
formatting for an adjacent column.

10. Click OK. The condition is applied to the column.

Interactively Filtering Report Output
If the report output contains more information than you want, interactively filter it to
display just what you need. You conditionally filter the report output by first selecting the
column to use as a basis for filtering. Next, you enter a filter condition, then a value for
comparison. The server compares each field of the column to the value that meets the
condition. In Interactive Filtering Conditions you can see the conditions available for each
type of column: numeric, date, and text.

Numeric Date Text

Equals Equals Equals

Does not equal Is not equal to Is not equal to

Greater than Is between Contains

Interactive Filtering Conditions
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Numeric Date Text

Greater than or equal to Is not between Does not contain

Less than Is on or before Starts with

Less than or equal to Is before Does not start with

Is between Is on or after Ends with

Is not between Is after Does not end with

To interactively filter report data

Procedure
1. As you run the type of report shown in Output of the Accounts Report, click the

column you want to use for filtering the report. Continuing with the example in
Running or Creating a Simple Report, click the Phone column in the Accounts report.

2. Click the .
The Filter column dialog appears, as shown in Filter Column Dialog. By default, Show
all rows is selected.

3. To build your filter, click the radio button to select Show only rows where.
The comparison operator dropdown and value entry box become active.

4. Select a comparison operator from the dropdown. For example, select Starts with to
compare phone numbers starting with certain numbers.

5. Enter a value for comparison with the data in the column. For example, enter the
area code: 408-.

Figure 38: Filter Column Dialog

6. Click OK.
The view of the report changes to show the filtered output. For example, now the
Accounts Report only shows accounts in the 408 area code.
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Figure 39: Filtered Report Shows Only Accounts in Area Code 408

A small star icon appears in the heading of the filtered column, to the right of the
heading text.

7. To clear the filter indicator and once again display all the accounts, reopen the Filter
column dialog and select Show all rows, then click OK.

Interactively Sorting a Report
You can also sort data in report output interactively. For example, you can sort the data
alphabetically in ascending or descending order within each city listed in the Accounts
Report.

To interactively sort report output

Procedure
1. As you run the type of report shown in Output of the Accounts Report, click the

column you want to use for sorting the report. For example, click the Name column
in the Accounts report.

2. Click (sort ascending) or (sort descending). The report refreshes, and data
appears sorted by the selected column in the selected order. In this example, for

instance, if you select , the grouped rows of data are sorted alphabetically in
ascending order within each group. Row 1 of the Burnaby, Canada group is now D &
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Z McLaughlin Electronics, Ltd and row 1 of the Cliffside, Canada group is Abbott-Liff
Electronics Holdings.
The heading text in the column used to sort report data appears red, and the up or
down arrow icon in the column header indicates that report output now appears in
ascending or descending order, respectively.
To change the sort order of the groups themselves, you have to modify the report
query.

Moving, Resizing, and Hiding Columns
Columns are easily moved, resized, and hidden in your report.

l To move a column, click the column you want to move, then drag the column left or

right into the new position. The indicates where the column is placed.

l To resize a column, click the column you want to resize, then drag the until the
column is the size you want.

l To hide a column, click the column you want to hide, then move your mouse over

the and select Hide column.

Setting Output Scale
You can determine the display size for any report by using the report scaling options in the
Report Viewer tool bar.

l Click to zoom in on the report.

l Click to zoom out on the report.

l Click to open the Zoom Options drop-down menu, and select the
percentage by which you want to increase or decrease the size of the displayed
report.
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Using the Bookmarks Panel
When working with a report that contains bookmarks, they are displayed in a floating
panel. Using this panel, you can jump to designated sections of the report.

Figure 40: The Bookmarks Panel

l To display the Bookmarks panel, click in the Report Viewer tool bar.

l To jump to a bookmarked section of the report, click the name of the section in the
Bookmarks panel.

Navigating the Report
If your report has multiple pages, you can use the pagination controls to move through the
report quickly.

To navigate the published report



JasperReports® Server User Guide

101 | Running Reports and the Report Viewer

l Use at the top of the Report Viewer to navigate to the previous page.

l Use to navigate to the next page.

l Use to go to the end of the report.

l Use to go to the beginning of the report.

l If you know the number of the page you want to view, enter the page number in the
Current Page indicator box.

Exporting the Report

To export the report

Procedure
1. To view and save the report in other formats, click the Export button.

2. Select an export format from the drop-down. The export options are listed in Export
File Types.

Option Usage

PDF Document (.pdf) Choose a report template based on report
size. Use the Actual Size report template for
reports with dimensions less than or equal to
14400px by 14400px. See Report Templates
for more information.

Comma Separated Values (.csv) Characters outside the Latin 1 character set
can cause the Excel spreadsheet to look
unacceptable. Try saving the file and
importing it using Excel's Import
functionality.

Microsoft Word (.docx) Do not export reports having more than 63
columns. In Microsoft Word, you cannot

Export File Types
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Option Usage

create tables having more than 63 columns.

Rich Text Format (.rtf) It creates a large output file and, therefore,
takes longer to export than PDF, for example.

OpenDocument Text (.odt) For best results, minimize the number of
rows and columns to make sure that they
don’t overlap.

OpenDocument Spreadsheet(.ods) Same as ODT.

Microsoft Excel - Paginated(.xlsx) Not recommended for exporting most tables
or crosstabs. Repeats headers and footers on
each page.

Microsoft Excel (.xlsx) Ignores page size and produces spreadsheet-
like output.

Microsoft PowerPoint (.pptx) Each page of the report becomes a slide in
the PowerPoint presentation.

Comma Separated Values - Metadata
(.csv)

If the required CSV metadata properties are
set in the report, it generates a data-oriented
document and provides consistent columns
of data, with or without column headers on
top of the document. Otherwise, an empty
document is generated. It does not preserve
the style and formatting information.

For more information about setting the CSV
metadata properties, see Exporting to CSV
Format Using Report Metadata.

Microsoft Excel - Metadata(.xlsx) If the required Excel metadata properties are
set in the report, it generates a data-oriented
document and provides consistent columns

https://jasperreports.sourceforge.net/sample.reference/jasper/index.html#csvmetadataexport
https://jasperreports.sourceforge.net/sample.reference/jasper/index.html#csvmetadataexport
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Option Usage

of data, with or without column headers on
top of the document. Otherwise, an empty
document is generated. It also keeps
relevant data with their style and formatting
information.

For more information about setting the Excel
metadata properties, see Exporting to XLSX
Format Using Report Metadata.

3. Save the report in the export file format, for example PDF, or open the report in the
application.

If you click the close while export process is running, you are prompted to
confirm if you want to stop the export process.

You can export a report with the Detail Chart Enabled property as enabled or disabled. This
property does not impact output formats like PDF, Excel, PPTX, etc., except the HTML output
format.

Scheduling a Report
You can schedule a report from the Report Viewer.

To schedule a report

Procedure

1. On the Report Viewer toolbar, click Schedule icon to open the New Schedule
dialog.

https://jasperreports.sourceforge.net/sample.reference/jasper/index.html#xlsxmetadataexport
https://jasperreports.sourceforge.net/sample.reference/jasper/index.html#xlsxmetadataexport


JasperReports® Server User Guide

104 | Running Reports and the Report Viewer

Figure 41: New Schedule Dialog

The New Schedule dialog has the following tabs: 

l Schedule – When to run the scheduled job, and how often.

l Parameters – If the report was designed with input controls, which parameters
the scheduled job uses.

l Output Options – The name of the output file, the output format and locale,
and where the output file is stored.

l Notifications – Email options for sending the output to recipients and for
sending administrative messages.

2. Create the schedule, as described in Creating a Schedule.

3. Click Save. The Save dialog appears.

4. In the Scheduled Job Name field, enter a name for the job. The description is
optional.

5. Click Save to save the schedule. The job appears in the list of saved jobs for reports.

You can schedule a report with the Detail Chart Enabled property as enabled or disabled. By
default, in the scheduled report, HTML5 charts are not interactive in the HTML output. To make
them interactive in the HTML output, you need to update the jasperReportsProSchedulerContext
bean in the applicationContext-adhoc.xml file.

For information on viewing, modifying, or deleting the schedules, see Scheduling Reports
and Dashboards.
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Setting Alert in the Report Viewer
From the Report Viewer, you can set up an alert in the report.

To set up an alert in the report

Procedure
1. Locate the report and run the selected report on which you want to set up an alert.

2. Create the alert as described in Creating an Alert.

Jive operations cannot be performed when alert mode is enabled.

For information about viewing, modifying, or deleting the alerts, see JasperReports Server
Alerts Feature.

Report Bursting
Report bursting is the process of running a report once and distributing its data to different
recipients relevant to them. For example, recipients in different countries need a report on
shipping data for their country. The recipients can receive the burst report through email.

Bursting a report needs a list of recipients to whom you want to send the burst report and
a bursting report containing a scriptlet attached to its dataset. This bursting report triggers
the bursting operation.

When you run a bursting report from the repository, it triggers the burst operation. The burst
report that you want to send to recipients is stored in the output folder in the repository. For
more information on the report bursting, see the Jaspersoft Studio User Guide.

You can also schedule the burst report. For more information on scheduling a report, see
Scheduling a Report.

Getting the Embed Code for Visualize.js
Visualize.js is the JavaScript library available with JasperReports Server to embed
dashboards and reports in custom web apps. If you create an app with Visualize.js, this
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feature gives you the JavaScript code needed to embed the current dashboard in your app.
You can then write additional code to interact with the dashboard programmatically, for
example to update a filter depending on other actions in your app. For more information,
see the JasperReports Server Visualize.js Guide.

You can get the embed code for a report from the Report Viewer.

To get a report embed code

Procedure
1. On the Report Viewer toolbar, click to open the Report Embed Code dialog.

Figure 42: Report Embed Code Dialog

The dialog shows the Visualize.js code and a preview of the dashboard as it is
currently saved.

2. Click the Copy Code button to copy the embed code to the clipboard.

3. Click the Open in JSFiddle button to load the embed code into JSFiddle, an online
JavaScript viewer and interactive editor.

4. Click the Close button to return to the report.

Running a Fusion Chart
The JasperReports Server commercial editions support Fusion charting, and include the
Maps Pro, Charts Pro, and Widgets Pro component libraries.
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Using the libraries, you can create visually appealing, animated, and interactive reports:

• Maps Pro - Color-coded maps covering all countries and regions of the globe.

• Charts Pro - Standard and stacked charts with animation and interactivity.

• Widgets Pro - Non-standard charts such as gauges, funnels, spark lines, and Gantt
charts.

These components are based on Fusion libraries, which generate HTML5 output that is
embedded in the HTML and PDF output. When a report containing a Maps, Charts, or
Widgets Pro element is exported in a format other than HTML or PDF, the space used by
the element remains blank.

Flash is no longer recommended.

For configuration information, see the JasperReports Server Administrator Guide for more
information.

Fusion charts are created in Jaspersoft Studio Professional as JRXML reports and uploaded
to the repository as a report unit.

To find and run a chart example

Procedure
1. In the repository, locate the sample report 14. World Map.

2. Click the report name to run the report.

3. In the Input Controls window, select Food as the product family that you want to
view sales trends for and then click OK. The report appears, as shown in World Map
Report with Flash Map.
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Figure 43: World Map Report with Flash Map

4. To interact with the map, mouse-over any of the countries to see the full country
name and, when it has data, the value for that country.

5. On the map, click Canada to launch the Interactive Sales Report, displaying the
information for Canada only. From there, you can modify the underlying report as
needed.

To upload JRXML reports, see Adding Reports Directly to the Repository.

Running a Report with Input Controls or Filters
An input control is graphical widgets that filter the data that appears in a report. The
perfect input control limits the data to what you want to see—and nothing more. When you
run a report based on a Domain Topic that defines a filter, the server can render the filter
as an input control. The JasperReports Server interface uses "input controls", "filters", and
"options" interchangeably.

If your system administrator has enabled the data snapshot feature (described in Data
Snapshots), it is important to note that the default input controls - that is, the input
controls as defined when the original Jaspersoft Studio- or Ad Hoc View-based report is run
- will overwrite any changes made to them the next time you run a report. For instance,
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suppose you run a report, update the input controls, then save the report. Later, when you
run a report from the Jaspersoft Studio or Ad Hoc View source again. That new report
replaces the report you ran earlier, and your input control changes are lost.

To avoid this, save a version of the report with your selected data preloaded. That way,
when subsequent reports are run from the same source, they will not overwrite your
report. See Saving Input Control Values for more information.

Simple Input Controls
The 16. Interactive Sales Report example has several input controls:

• Product Family

• Product Department

• Product Category

• Product Name

• Country

• Gender

Using input controls, you run the report with one set of data and then another. When
saved, an instance of the report with alternate input controls is called a Report Version,
and is labeled as such in the repository.

To run a report with simple input controls

Procedure
1. In the repository, locate and run the report 16. Interactive Sales Report.
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Figure 44: Interactive Sales Report

2. In the Filters panel, use the Country menu to select USA only.

Figure 45: Input Control Selection - Country

3. Click Close, then click Apply at the bottom of the panel. The report shows data for
the USA only.

4. Click , then select Save As. You are prompted to name the new report.

5. Enter a new name, then click Save.

Multi-select Input Controls
The 16. Interactive Sales Report has an example of a multi-select input control for Product
Name.
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To run a report with a multi-select input control

Procedure
1. In the repository, locate and run the report 16. Interactive Sales Report.

2. In the Filters panel, enter onion in the Search list for the Product Name input
control.
Only products containing "onion" are shown.

3. Click the first item in the list, then scroll down and Shift-click to select all the items
with "onion".

4. Click in the Search list again and delete the word onion.
All items are displayed, with ones that include "onion" selected.

5. Click the Selected tab to see that only items that are selected are displayed. Then
click the Available tab to view all the items.

6. Click Invert to invert the selection.
Now all items are selected except those items that contain "onion".

7. Click Apply at the bottom of the panel. The report shows data only for products that
do not contain the word "onion."

Figure 46: Multi-Input Control Selection
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Saving Input Control Values
You can save your selected input control values to use at another time to have the original
report and a copy of it. The JasperReports Server saves a version of the report with the
selected values as a child of the original report. This new version of the report appears as a
child of the original report in the repository, as shown in Filtered Version of Geographic
Results Report in Repository. Click next to the original report in the repository to see all
versions of it.

Your saved input control values also appear in a dropdown list when you open the input
controls dialog.

Figure 47: Filtered Version of Geographic Results Report in Repository

To save the input control values

Procedure
1. In the repository, locate and run the report 1. Geographic Results by Segment Report.

2. On the tool bar, click .

3. Select all of the onion products, as described in Multi-select Input Controls.

4. Click save at the bottom of the dialog.

5. Enter "Interactive Sales Report for Onion Products" as a name for the input control
values and click Save.
JasperReports Server saves the input control values as an option. A new dropdown
box appears at the top of the Filters panel.

Figure 48: Saved Input Controls Option
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6. Select Interactive Sales Report for Onion Products from the list of options and click
OK. The report shows data for onion-related products only.

Cascading Input Controls
Cascading input controls in a report reduce a large number of choices to a manageable
number. A single value chosen for a cascading input control determines which other values
appear as choices for input. For example, the choice of a country determines which states
or regions are listed as choices. For more information, see Selecting a Data Source for
Running the Complex Report.

To run a report with cascading input controls

Procedure
1. In the repository, locate and run the report 16. Interactive Sales Report.

The report runs, and appears with the Options panel open on the left side of the
Report Viewer.

2. In the Options panel’s Country multi select dropdown, select a different country, for
example Canada.
The other dropdowns in the Filters panel are automatically updated with Canadian
data.

Cascading input controls are implemented as queries that access the database to retrieve the
new values. The server displays an activity monitor while the query is running, and in the case
of long queries, you can click Cancel and select different values.

3. In the Product Name section, select a product to display in the report.

4. Click Apply to run the report with the chosen values.

Running a Report Book
Report books are multiple reports bundled into a single object, created in Jaspersoft
Studio. You can run and view report books from the Library page or the repository, much
like you would a standard report. However, report books contain some elements that are
not found in standard reports.
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To run a report book in the Report Viewer

Procedure
1. In the repository, click the name of the report book you want to run. For example,

click the sample 17. Report Workbook. The report appears, as shown below. 

Figure 49: Sample report book as seen in the Report Viewer

 The sample report book contains three bundled reports:

l Distribution by Country, a chart-type report.

l Customer Education, a crosstab-type report.

l Customers List, a table-type report.

Each of these reports can be accessed by a tab, along with the Table of
Contents page, located at the top of the Report Viewer.

2. Click the Chart tab to open the Customer Distribution by Country report. Note that
you can interact with this report as you would with a standard chart-based report in
the viewer.

3. Click the TocReport tab to return to the table of contents page.

4. Scroll down and click the Acapulco entry in the table of contents. The first page of
the Acapulco table entries is displayed.

5. Click to open the bookmarks pane.
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6. Click the Customer Education entry in the bookmarks pane. The Customer Education
crosstab report opens in the viewer.

7. Close the bookmarks pane by clicking the x in the upper right corner of the pane.

Drill-down Report
You can use a drill-down report to view more detailed data from the general view within
the report. When you drill down to the specific data in a main report, a subreport opens.

For example, a report displays the stores sales data of different cities using a pie chart. If
you hover over a pie segment and select it, a subreport of a specific city opens. You can
see the store sales data of that city.

A subreport can be opened in the same tab or in the new tab.

l When a subreport opens in a new tab, you can see a Close button . Using a
Closebutton, you can return to the screen from where a main report is accessed.

l When a subreport opens in the same tab, both a Close button , and a Back button
are displayed. Using a Back button, you can go back to the main report.

For the main report with input control, you can configure input controls in the following
display modes:

• Pop-up window

• Separate page

• Top of page

• In page

The input control values automatically reapplied to the main report when you return from
the subreport. Any report interaction through JIVE actions such as, sorting, filtering, or
formatting is also restored on the main report.

You can edit a drill-down report in JasperReports Server. If you close the report without
saving the changes, you are prompted to save or cancel the changes.
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Scheduling Reports and Dashboards
Using the JasperReports Server scheduler, you can run reports and take snapshots of
dashboards repeatedly and unattended during off hours or at other times. The reports and
dashboards are saved in a file format of your choice to the repository, the host machine, or
an FTP server. Scheduling these jobs to run in the background or during off hours can
reduce the performance impact on the server.

You can view a list of scheduled reports or dashboards on the View > Schedules page.

Administrative users have access to a set of Ad Hoc views with details of the completed
scheduled reports via the server monitoring feature. Administrators can monitor the
completed scheduled reports using these Ad Hoc views. This feature is available to users
with access to the Audit database. For more information on server monitoring, see the
JasperReports Server Administrator Guide.

This chapter contains the following sections:

• Overview of the Scheduler

• Creating a Schedule

• List of Scheduled Jobs

• Editing Schedules

• Pausing a Job

• Deleting a Job

• Running a Job in the Background

• Event Messages

Overview of the Scheduler
Using the scheduler, you can set up a schedule for generating reports or dashboard with
parameters, output options, and notifications:

• Schedule – When to run the scheduled job, and how often.
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• Parameters – If the report or dashboard was designed with input controls, which
parameters the scheduled job uses.

• Output Options – The name of the output file, the output format and locale, and
where the output file is stored.

• Notifications – Email options for sending the output to recipients and for sending
administrative messages.

The permissions of the user who schedules a job determines the data that is exposed. For
example, Gloria only has access to inventory data from the Southeast US region. A report
that she schedules only shows data from that region, even when the report is viewed by
users in other regions. Other users schedule the report themselves to see the data for their
own regions.

Sensitive data could be exposed to unauthorized users if you schedule a job as an administrative
user with no data restrictions because the output contain all requested data in the data source. Any
user who receives the output can view all the data regardless of the user’s access restrictions.

Scheduling a dashboard requires having Chrome/Chromium installed on the computer
hosting JasperReports Server. For information on configuring Chrome/Chromium for
dashboards, see the System Configuration chapter in the JasperReports Server
Administrator Guide.

By default, in the scheduled report, HTML5 charts are not interactive in the HTML output.
To make them interactive in the HTML output, you need to update the
jasperReportsProSchedulerContext bean in the applicationContext-adhoc.xml file.

You can schedule a report with the Detail Chart Enabled property as enabled or disabled, while
this property is not supported by pie charts, gauge charts, spider charts, horizontal bar charts, and
tile map charts.

Creating a Schedule

To create a schedule

Procedure
1. Locate the report or dashboard that you want to schedule in the repository.

2. Right-click the report or dashboard and select Schedule... from the context menu, or
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if it already has a schedule, click the Schedule icon . The Scheduled Jobs page
appears.

Figure 50: Scheduled Jobs Page

3. Click Create Schedule.

You can also create a schedule from the dashboard in view and edit mode, and from
the report viewer. On the toolbar, click the Schedule icon .

The Schedule tab of the scheduler appears.

Figure 51: New Schedule Tab

4. Set a start date, choosing whether to run immediately or on a specific date. If a
specific date is selected, click the calendar icon to select a start date and time.

5. Specify the time zone for the schedule. The default time zone is the time zone of the
server, the time zone you entered at log in. If you are in a different time zone, set this
field accordingly.
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6. Choose a recurrence setting, as described in Running a Job Repeatedly. If you select
Simple or Calendar Recurrence, additional controls appear on the page.

l None: Run the job once.

l Simple: Schedule the job to recur at a regular interval, specified in minutes,
hours, days, or weeks.

l Calendar: Schedule the job to recur on days of the week, days of the month,
specific dates, or date ranges.

Warning:
If you set up a job with simple recurrence to start immediately, the
job schedule will change after export/import or a server restart. This
happens because the job does not retain the previous run history
and therefore starts immediately after import or restart. If you have
a large number of scheduled jobs, all scheduled jobs with simple
recurrence will attempt to start at the same time after export/import
or restart. This can impact server performance. In addition, some
scheduled jobs may be locked out and they may continue to try to
run.

To ensure a recurring schedule does not change after export/import
or restart, either use a simple recurrence with a specific start time, or
set up calendar recurrence.

7. If the report or dashboard you are scheduling has input controls that prompt for user
input, click the Parameters tab.
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Figure 52: Set the Parameter Values Page for Scheduling a Report

Saved values, if there are any, appear in a dropdown list at the top of the page, as
shown in Set the Parameter Values Page for Scheduling a Report. In the Use saved
values dropdown, you can set the input controls defined for the report or dashboard
you are scheduling. You can set the input values for the scheduled job, and click
Save Current Values to save the input value as a named set of values.

For more information about using saved values and saving input values, see Running
a Report with Input Controls or Filters.

8. Choose a set of saved values, or set the input controls.

9. Click the Output Options tab and set the output format and location, as described in
Setting Output Options.

10. Click the Notifications tab and set up email notifications, as described in Setting Up
Notifications

11. Click Save. The Save dialog appears.

12. In the Scheduled Job Name field, enter a name for the job, for example, Weekly
Report. The description is optional.

13. Click Save to save the schedule. The job appears in the list of saved jobs for the
report or dashboard.
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Setting Output Options
On the Output Options tab, you can change these settings:

l File name – The base name for the output file in the repository. This name must be
unique. If you attempt to create a schedule with the same file name as an existing
output file, you will not be able to save the file name.

l Description – The optional description of the file that appears to users who view the
repository.

l Time Zone – The output time zone for generating the report.

l Output Locale – The locale settings for generating the report.

l The report must support locales, for example a report based on a Domain with locale
bundles. For more information on locale bundles, see JasperReports Server Data
Management Using Domains.

l Export Type – Click the dropdown menu and select one of the following export
types:

o Screenshot

o Detailed

Note:
The Export Type option is available only for dashboards.

l Formats – The available output formats. For dashboards, the available formats for
the selected export type is displayed. Select one or more formats. The default format
is PDF. When you select more than one, each format is stored as a separate file in the
selected output destination.

Format for Reports Format for Dashboards
(Screenshot)

Format for Dashboards
(Detailed)

Comma Separated Values
(.csv)
Web Page (.html)
Rich Text Format (.rtf)

Microsoft Word (.docx)
PNG Image (.png)
OpenDocument Text (.odt)

Microsoft PowerPoint

Microsoft Word (.docx)
PNG Image (.png)
OpenDocument Text (.odt)
Microsoft PowerPoint (.pptx)
PDF Document (.pdf)
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Format for Reports Format for Dashboards
(Screenshot)

Format for Dashboards
(Detailed)

Microsoft Word (.docx)
OpenDocument Spreadsheet
(.ods)
Microsoft Excel (.xlsx)
OpenDocument Text (.odt)
Microsoft Excel - Paginated
(.xlsx)
PDF Document (.pdf)
Microsoft PowerPoint (.pptx)
Comma Separated Values -
Metadata (.csv)
Microsoft Excel - Metadata
(.xlsx)

(.pptx)
PDF Document (.pdf)

Microsoft Excel (.xlsx)
Rich Text Format (.rtf)
Comma Separated Values (.csv)

OpenDocument Spreadsheet
(.ods)

l Canvas Size – Sets the size of the canvas when exporting a dashboard.

Note:
The Canvas Size field is available only for the Screenshot export type.

l File Handling – Select one or more checkboxes to specify handling for multiple
output files with the same name:

o Overwrite Files – Overwrites old output files with newer ones of the same
name.

o Sequential File Names by Timestamp – Appends a timestamp to the names of
files created by the job. Useful for the output of recurring jobs or for time-
sensitive reports where the output must be dated. When the timestamp is used,
the output filename is <basename>-<timestamp>.<extension>. Note that,
depending on the frequency of the schedule and the format of the timestamp,
it may be possible to have two output files with the same name; in this case,
modify the timestamp or use the Overwrite Files checkbox to specify the
behavior you want.

o Timestamp Pattern – When Sequential File Names by Timestamp is selected, a
required pattern for the timestamp, based on the java.text.SimpleDateFormat is
required. Valid patterns for output files can contain only letters, numbers,
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dashes, underscores, and periods. The default pattern is yyyyMMddHHmm, for
example 200906150601.

o For more information about the valid patterns for this field, refer to:
http://download.oracle.com/javase/6/docs/api/java/text/SimpleDateFormat.ht
ml

l Output Destination – To save the output file, select one or more checkboxes to
specify the output location. If you do not want to save the report output (for
example, if you only want to email the report) leave all checkboxes blank.

o Output To Repository – If checked, saves the report output to the specified
location in the repository. You must have write permission to the output folder.
JasperReports Server validates the path when you click Save. It displays an
error message if the location does not exist. You can change the repository
location that appears here by default. See JasperReports Server Administrator
Guide for more information.

o Output To Host File System – If checked, saves the report output to the
specified folder on the Server host machine. Check with your administrator for
the correct location to enter. Output To Host File System must be configured
by an administrator. If the checkbox is grayed out, saving to the host file
system has not been enabled for your system. See the JasperReports Server
Administrator Guide for more information

o Output To FTP Server – If checked, saves the report output to the specified FTP
server. You must have write permission to the selected directory on the
FTP server. Enter the following properties of your FTP server:

n Server Address – The host, IP address, or URL of the FTP server.

n Port – Specifies the FTP connection port.

n For FTP, the default port is 21.

n For FTPS, the default port is 990.

n For SFTP, the default port is 22.

n Transfer Protocol – Specifies the file transfer protocol that the server
uses. You can select one of the following:

n FTP.

n FTPS (FTP over SSL).

http://download.oracle.com/javase/6/docs/api/java/text/SimpleDateFormat.html
http://download.oracle.com/javase/6/docs/api/java/text/SimpleDateFormat.html
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n SFTP (FTP over SSH). If selected, the SSH Key Authentication
checkbox and SSH private key fields appear.

n SSH Key Authentication. Check if the server requires an SSH private key
for SFTP transfers.

n Path to SSH Private Key. When SSH Key Authentication is checked, the
location of the SSH private key in the repository is required.

n SSH Key Passphrase. When SSH Key Authentication is checked, enter the
passphrase for the SSH private key, if it has one.

n Directory – The directory on the FTP server where the report output is
saved.

n Username – The username for access to the FTP server.

n Password – The password for the username.

Figure 53: Output Page for Scheduling a Dashboard – Output Destination

When you click Save, the job appears in the list of scheduled jobs.
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Setting Up Notifications
On the Notifications page, you can set up email notifications to the recipients of the report
or dashboard and to administrators.

Note:
Notifications are sent to all users with the organization ROLE_ADMINISTRATOR
role, who belong to the same organization as the user who creates the
scheduled job.

Send a report when the scheduler runs
Enter one or more email addresses to send the output after the job has run. You can
configure the following:

l To – One or more email addresses separated by commas for sending email
notification.

Note:
By default, the mail server is not configured by the JasperReports Server
installer. To send email notifications, the administrator must configure the
mail server, as described in the JasperReports Server Installation Guide.

l CC – One or more email addresses separated by commas for sending an email
notification on the CC line.

l BCC – One or more email addresses separated by commas for sending a blind
carbon-copy email notification. The addresses in this field are not revealed to the
other recipients.

l Subject - The subject line of the notification email.

l Message - Content of the notification email.

l Choose one of the radio buttons to specify how email recipients access the output:

o Include reports/dashboard as repository links in email body - Sends a link to
the output in the repository. Not available unless Output to Repository is
selected on the Output Options tab.

o Include report/dashboard files as attachments - Sends the output as
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attachments to the notification email. If you have selected multiple output
formats, each one is attached as a separate file to the email notification.

o Include report/dashboard files as ZIP attachment - Zips all outputs into a single
archive file before attaching to the email.

o Include HTML report in email body - Displays the report directly in the email
body. This option is available only when Include report files as attachments or
Include report files as ZIP attachment is checked and HTML is selected as one
of the options on the Output File Options page. When this option is selected,
you cannot include a message in the email body. This option is not available
for dashboards.

Note:
Be careful when sending reports containing sensitive data by email,
either in the email body or as an attachment.

l Do not send emails for empty reports - A checkbox option that, if checked, prevents
the server from attaching empty report output files to email notifications. This
applies to parametrized reports where there is no data that matches the parameters.
This option is not available for dashboards.

Send job status notifications
Enter one or more email addresses to send notification of job success or failure to
administrators:

l To – One or more email addresses separated by commas for sending email
notification.

Note:
By default, the mail server is not configured by the JasperReports Server
installer. To send email notifications, the administrator must configure the
mail server, as described in the JasperReports Server Installation Guide.

l Subject – The subject line of the notification email.

l Send success notification – Checkbox option that, when checked, sends a notification
when the scheduled job runs.
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o Success Message – The message in the body of the notification email sent on
success.

l Send failure notification – Checkbox option that, when checked, sends a notification
when the scheduled job fails to run.

o Failure Message – The message in the body of the notification email sent on
failure.

l Include report/dashboard job information – A checkbox option that, if selected,
includes the report or dashboard's label, ID, description, and job status in the
notification email.

l Include stack trace – A checkbox option that, if selected, includes the stack trace for
failed jobs in the body of the email.

Figure 54: Notifications Page for Scheduling a Report

Running a Job Repeatedly
To run jobs automatically regularly, select a simple or calendar recurrence on the Schedule
tab:
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• Simple recurrence repeatedly runs the job at a regular interval set in minutes, hours,
days, or weeks.

• Calendar recurrence involves more settings: time of day, days of the week, or days of
the month, and months of the year.

In Simple Recurrence Settings you can see an example of how to set a simple recurrence.

Figure 55: Simple Recurrence Settings

Simple recurrence options are:

l Repeat every – The interval between jobs, in minutes, hours, days, or weeks.

l Run a set number of times – Runs the specified number of times.

l Run until a specified date – Runs until a calendar date is reached. Click the calendar
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icon to select the date.

l Run indefinitely – Runs at the specified time until you delete the job.

l Holidays – A holiday calendar specifies a list of days when the scheduled job does
not run. To use a holiday calendar, select it from the dropdown list. Only one holiday
calendar can be selected at a time. Holiday calendars are configured by an
administrator. If no calendars are available in this list, then this implies that this
option has not been configured for your system.

Note:
If your server recognizes Daylight Savings Time (DST), jobs scheduled using
simple recurrence may seem to occur one hour later (when DST ends) or
one hour earlier (when DST begins). If you want jobs to recur at the same
time of day and respect DST adjustments, use calendar recurrence.

Warning:
If you set up a job with simple recurrence to start immediately, the job
schedule will change after export/import. This happens because the
imported job does not retain the previous run history and therefore starts
immediately after successful import. To ensure a recurring schedule does
not change after export/import, either use a simple recurrence with a
specific start time, or set up calendar recurrence.

In Calendar Recurrence Settings you see an example of calendar recurrence settings.
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Figure 56: Calendar Recurrence Settings

Calendar recurrence options are:

l Months – The months during which the job runs.

o Every Month

o Selected Months

l Days – The days when the job runs.

o Every Day

o Selected Days

o Dates in Months – Enter dates or date ranges separated by commas, for
example: 1, 15.
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l Times – The time of day in minutes and hours when the job should run. The hours
use the 24-hour format.

You can also enter multiple minutes or hours, and ranges, separated by commas. For
example, entering 0,15,30,45 for the minutes, and 9-17 for the hours, runs the report
every 15 minutes from 9:00 a.m. to 5:45 p.m. Enter an asterisk (*) to run the job
every minute or every hour.

l End Date – Calendar recurrence runs until a calendar date is reached. Click to
select the date.

l Holidays – A holiday calendar specifies a list of days when the scheduled report does
not run. To use a holiday calendar, select it from the dropdown list. Only one holiday
calendar can be selected at a time. Holiday calendars are configured by an
administrator. If no calendars are available in this list, then this implies that this
option has not been configured for your system.

Administrators see the chapter on scheduling in the JasperReports Server REST API
Reference for more information on configuring calendars.

List of Scheduled Jobs
All scheduled jobs that you has defined appear on the View > Schedules and Alerts >
Schedules tab. Typical users can see only the jobs that they have defined. Administrators
can view the jobs defined by all users.

The view of the Schedules page has been improved with the newly added columns and
updates to existing column names.

The Schedules page shows the following:

Column Name Description

Job ID The unique identifier of a job.

Job
name/Description

Name of the scheduled job and description.

Resource/URL Repository URL of the job.
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Column Name Description

Status The status of the job in NORMAL, EXECUTING, COMPLETE, PAUSED,
ERROR, or UNKNOWN state.

User The owner who created the job.

Next run Filters by date and time to view the count and list of schedules that
will run next at the filtered time.

Last run Filters by date and time to view the count and list of schedules that
was run last at the filtered time.

Pause/Activate Enables or disables the job.

Actions Edit or delete the job.

Figure 57: The Schedules Page

In the Schedules page, you can now do the following tasks:

Functionality Description

Sort You can sort any column except the Actions column in ascending or
descending order. Hover on the column header and then click the sort
icon to view the schedules in ascending or descending order.

Filter You can filter to find information of the scheduled jobs of the report using
the Add Filter button. Based on the selected filter settings, the Schedules
page is refreshed without effecting the other filters on the page. Select the
Reset filters to reset the Schedules page to the default filter values.
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Functionality Description

Data refresh You can view the latest updated date and time of new schedules. Click the
data refresh icon to refresh the scheduled job with the recent date and
time.

Search You can find a scheduled job by job name from the list of available or
created schedule. Click the search icon to search by schedule job
name. The search criteria show results for only those job names that
match with the names available in the Job name/Description column.

Export You can export the schedule jobs in CSV format. Click the export icon
to download and view the report of all the scheduled jobs.

You can use the Schedules page's search field to find the scheduled job you want.

In the Status column, you can view the following job states:

Job States Description

NORMAL The job is scheduled. The status of this job state is displayed as ACTIVE on
the UI.

EXECUTE The server is generating the output. The status of this job state is
displayed as RUNNING on the UI.

COMPLETE The server has finished running the job and output is available in the
repository.

PAUSED The job has been disabled. Click the Pause/Activate toggle switch to
resume the schedule. The status of this job state is displayed as PAUSED
on the UI.

ERROR The scheduler encountered an error while scheduling or triggering the job.
This does not include cases where the job is successfully triggered, but an
error occurs while it runs.

UNKNOWN The scheduler encountered an error with the job trigger.

The Schedules page includes the following controls:



JasperReports® Server User Guide

134 | Scheduling Reports and Dashboards

Schedule Page Controls Description

Pause/Activate toggle switch, when enabled, the job
state is set to ACTIVE. When disabled, the job state is
set to PAUSED.

Edits the scheduled job.

Deletes the scheduled job. When the server receives a
request to delete a job that is running, the server
completes running the job before deleting it.

Displays the previous instance of the search term.

Displays the next instance of the search term.

Displays the number of schedule records. By default,
five rows per page are displayed. You can change the
number of rows per page to 5, 10, 25, or 100. Based
on your selection, records are displayed. The total
count of records in the schedule job page is
equivalent to the number of rows selected per page.

Viewing scheduled jobs for an individual report
or dashboard
Scheduled jobs appear in the repository with the Schedule icon (beside the report or
dashboard's name).

To view the list of scheduled jobs for a report or dashboard

Procedure
1. Locate the report or dashboard in the repository.

2. Click the Schedule icon or right-click the report or dashboard, and select
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Schedule from the context menu. The Scheduled Jobs page is displayed. The
Scheduled Jobs display information that is similar to the Schedules page.

Note:
You can filter search results for scheduled jobs in the repository using the
following options: Any schedule (scheduled and unscheduled reports),
Scheduled, Scheduled by me, or Not scheduled. For more information, see
Filtering Search Results.

The Scheduled Jobs page includes the following buttons:

Button Description

Back Returns to the repository.

Create
Schedule

Opens the Schedule tab to define a new job.

Run Now Opens the scheduler to run the job immediately. See Running a Job in the
Background.

Refresh List Refreshes the list of jobs, for example to see if a job has finished running.

As an Excel (.XLS) format is deprecated, old scheduled jobs that export reports to Excel
(XLS) or Excel Paginated (XLS Paginated) now export reports to Microsoft Excel (.xlsx) or
Microsoft Excel - Paginated (.xlsx) format.

Editing Schedules
If the start date for a schedule has not yet passed, you can edit the schedule. After the
start date for a schedule has passed, create a new schedule rather than changing the start
date.

To edit a schedule

Procedure
1. Click View > Schedules and Alerts > Schedules.
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2. Click the Edit icon in the row of the job that you want to update.

3. Edit the fields in the Schedule, Parameters, Output Options, and Notifications
tabs.

Note:
See Creating a Schedule section in JasperReports Server User Guide and
repeat from steps 4-10.

4. Click Save. The update occurs immediately.

Pausing a Job
To stop a job from running without deleting it, disable the job.

To pause a scheduled job

Procedure
1. Click View > Schedules and Alerts > Schedules.

2. In the row of the job that you want to stop, disable the Pause/Activate toggle switch.

Note:
You can resume the job by enabling the Pause/Activate toggle switch.
When a stopped job is re-enabled, it waits until the next scheduled time to
run.

Deleting a Job

To delete a scheduled job

Procedure



JasperReports® Server User Guide

137 | Scheduling Reports and Dashboards

1. Click View > Schedules and Alerts > Schedules.

2. Click the delete icon in the row of the job you want to delete. A confirmation
dialog with a warning message is displayed to confirm if you want to delete this job.

3. Click Delete to delete the scheduled job or click Cancel to cancel the delete action.

Running a Job in the Background
Running a job in the background generates a report or exports a dashboard without
interrupting your workflow. You can keep working in the server as the job runs. When the
job completes, you can export the job directly to any format and save it in the repository.
You can the share the output with others by sending it by email.

Running a job in the background is equivalent to scheduling it to run immediately without
recurrence.

To run a job in the background

Procedure
1. Locate the report or dashboard you want in the repository.

2. Right-click the report or dashboard and select Run in Background from the context
menu.

3. Set the output format and location, as described in Setting Output Options. By
default, the output is saved in the repository.

4. If the job you are running has input controls that prompt for user input, click the
Parameters tab. Choose a set of saved values, or set the fields one at a time.

5. Click the Notifications tab and set up email notifications, as described in Setting Up
Notifications.

6. Click Save. The job begins to run immediately.

Event Messages
When an event occurs (for example, a scheduled report returns error), JasperReports
Server sends the owner of the job a notification message. You can browse these messages
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to troubleshoot report scheduling problems in the server. For example, you can determine
that a job fails because its data source configuration uses incorrect credentials.

Note:
A common cause of the error message indicating that the job failed to execute is
an incorrectly configured mail server. The mail server must be manually
configured after installation for users to send email notifications.

The Messages page displays the list of events logged for the current user.

To open the Messages page

Procedure
1. On any page, click View > Messages. The Messages page appears.

2. To view a message, click its name. The message opens in the Message Detail page.

3. To activate the buttons on the Messages page, click in a blank area of the message
row that you want to manage. The buttons become enabled.

Figure 58: Message Management Buttons

4. Use the buttons on the Messages page to manage the list of messages.
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JasperReports Server Alerts Feature
You can use this feature to set alerts for reports from the Reports Viewer toolbar. Currently
this feature is only available for the Tables and the Crosstabs. Alerts notify you when the
specified Condition is met. You can create alerts to monitor the data and to notify yourself
when there is any significant change in the data.

For creating an alert, you must click the Turn on alert mode icon on the toolbar. This
enables the numeric fields or data points of the report for creating alerts. When creating an
alert, you must specify the condition for which alerts have to be generated. The alerting
feature is dependent on the Threshold, Data point, and Condition set while creating an
alert. You get notified via an email for an alert when the specified Condition matches the
Threshold value.

You can view a list of alerts on the Manage > Admin Console > Alerts tab.

This chapter contains the following sections:

l Alert Overview

l Creating an Alert

l List of Alerts

l Searching an Alert

l Editing an Alert

l Deleting an Alert

Alert Overview
By using the alert feature, you can set up an alert for the following tabs:

l Condition - Which condition an alert is using to notify you about the alert. You can
customize the condition based on the available options.

l Parameters - Which input controls are applied on the report. When a report has no
input controls, then the Parameters tab is disabled.
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l Schedule - Which recurrence and start time for the alert is to be set to schedule the
alert and get notified.

l Notifications - The email options to send alert notifications along with subject and
message to the recipients for an alert.

l Output - The name of the output file, output format, and time zone.

Sample Use case to Generate an Alert
For example, consider that you are working in a warehouse. You have to restock the
inventory based on the storage space. A report is generated that shows the inventory for
the products. You have to check the stock twice a day to maintain the inventory value. If
the inventory falls below 100 units, then new items must be ordered.

In this scenario, your data point is the inventory values, the threshold limit is 100, and the
condition is when the inventory value is less than 100 units.

To generate an alert:

Procedure
1. Turn on the alert mode to enable the inventory values.

2. Click any inventory number. This is your data point.

3. Select an inventory number to create an alert.

An email is sent to the user if any of the Inventory values meets the conditions set in the
alert.

As shown in the following table, only individual inventory values are considered for
checking the conditions set for generating an alert and not the total values.

Product Country Warehouse Inventory

iPhone US NYC-1 120

iPhone US NYC-2 300

iPhone Canada TOR-1 250

iPhone Canada TOR-2 50
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Product Country Warehouse Inventory

iPad US NYC-1 200

iPad US NYC-2 70

Total 990

Creating an Alert

To create an alert

Procedure

1. On the Report Viewer toolbar, click the Turn on alert mode icon . This enables the
numeric values or data points.

Figure 59: Enabling Alert mode
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Figure 60: Alert Mode Enabled

2. Click any data point to open the new Create Alert panel.

Figure 61: Create Alert Panel

The Create Alert panel has Condition, Parameters, Schedule, Notifications, and Output
tabs. For more information about the tabs, see Alert Overview.

3. Click the Condition tab to set the condition for the alert as described in Setting
Condition.

4. Click the Parameters tab to view the parameters for the alert as described in Viewing
Parameters.

5. Click the Schedule tab to set the recurrence and start time for the alert as described
in Setting Schedule.



JasperReports® Server User Guide

143 | JasperReports Server Alerts Feature

6. Click the Notifications tab and set up email notifications, as described in Setting
Notifications.

7. Click the Output tab and set the output format and location, as described in Setting
Output.

8. Click Create alert to add and save the alert.

9. Click the View Alert List icon in the Report Viewer to view the new alert or list of
alerts.

Note:
The list of alerts in the Alerts panel is only available for the report in which
the alert is set up.

The alert mode in the report remains enabled even after closing the Create Alert panel. To

disable the alert mode, click the Turn off alert mode icon in the toolbar. The change in
color around the alert bell icon indicates that alert mode is turned off.

Setting Condition
On the Condition tab, you can change the following settings:

l Alert name - The name of your alert. You can save the duplicate alert name without
any error.

l Condition - You can choose one of the following conditions for an alert:

o Equals

o Not equal to

o Less than

o Greater than

o Less than or equal to

o Greater than or equal to

By default, the Condition is set to Equals.

l Threshold - The threshold is the limit that you set to notify about the alert. The
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threshold value can be an integer, decimal point, or negative value. By default, the
Threshold is set to 0.

Figure 62: Condition Tab

Viewing Parameters
On the Parameters tab, you can view the input controls that are currently applied to the
report.

Figure 63: Parameters Tab Enabled
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Figure 64: Parameters Tab Disabled

Note:
l This tab contains read-only information.

l To modify the input control values, close the Create Alert panel, open the
input controls for the report, select the required values, and apply
changes.

l The Parameters tab is disabled when the report does not have any input
controls applied.

Setting Schedule
On the Schedule tab, you can change these settings:

l Interval - The required recurrence interval value. The recurrence interval must be an
integer greater than 0. By default, the interval value is set to 1.

l Timeframe - Schedule the alert to recur at a regular interval, specified in hours, days,
or weeks. By default, the timeframe value is set to Days.

l Start time - Set a start time, choosing whether to start now or on a specific date and
time. On selecting a specific date and time, the calendar option is enabled. Click the
calendar icon to select a start date and time.
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Note:
o By default, the Specific date and time remains disabled. You can

choose this option to select a start date and time.

o The start date and time must be in the future.

Figure 65: Schedule Tab

Figure 66: Schedule Tab with Specific Date and Time enabled

Setting Notifications
On the Notifications tab, you can set up email notifications to the recipients of the report.
On the Notifications tab, you can change the following settings:
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l Send alert to - One or more email addresses separated by commas for sending the
alert email notification when an alert condition is met.

l Subject - The subject line of the notification email.

l Message - The message for the body of the alert email. This is an optional field.

l Report access - The output of the report to be sent in the notification email can
either be a repository link or an attachment.

o Include report as repository link - The output is sent as a repository link of
the chosen folder path in the email body. You can browse to choose the folder
path in the Repository Content where you want the output to be saved. Click
the repository link to navigate to the folder location where the output is saved.

Note:
The Browse button gets enabled only on choosing the Include
report as repository link option.

Admin users (superuser) have access to all the folders in the Repository Content.
Other users do not have access to all the folders in the Repository Content. With the
Report access field in the Notifications tab, a user can now save output to the
selected folder having permissions.  

o Include report file as attachment - The output is sent as the file attachment
in the notification mail body. You get an attachment of the selected output
format in the notification email.

Note:
The output attachments are sent in the email body and are not in
the folder path of the Repository Content.
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Figure 67: Notifications Tab

Note:
If you have trouble receiving alerts to your email, then please contact your
administrator. For more information, see JasperReports Server Administrator
Guide.

Setting Output
On the Output tab, you can change these settings:

l File name - The base name for the output file in the repository. The default file name
is the resource ID of the output file in the repository.

l Time zone - The output time zone for generating the report. The default value is the
time zone that you are currently logged in.
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l Formats - The available output formats. Select one or more formats. The output is
generated in the chosen format. The default format is PDF. When you select more
than one, the output file is generated for each format.

Figure 68: Output Tab

List of Alerts
All scheduled alerts that you have defined appear on the View > Schedules and Alerts >
Alerts tab. You can also click the View Alert List icon of the Report title bar to view
scheduled alerts in the Alerts panel.

Note:
Currently in the View > Schedules and Alerts > Alerts tab, the Alerts page is a
new beta feature that might not be fully stable or supported. For more
information about the Alerts beta feature, see Admin Console Beta.

Typical users see only the alerts that they have defined in the View > Schedules and
Alerts > Alerts tab. Administrators can see the alerts defined by all users in the Alerts
page.

https://community.jaspersoft.com/wiki/admin-console
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Figure 69: View Alert List

Figure 70: List of Alerts in the Alerts Panel

In the above figure, superuser has set two alerts for the product. If there are no alerts for a
report, the Alerts panel contains a message with instructions on how to create an alert. To
create an alert, see Creating an Alert.
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Figure 71: Empty Alerts Panel

The Alerts panel shows the Alert name, the User (owner) who created the alert, and alert
Actions.

The Alerts panel includes the following controls:

Alert Panel Controls Description

Search the alert by alert name.

Clears or cancels the search term.

Edits the alert.

Deletes the alert.

Displays the previous page in the Alerts panel.

Displays the next page in the Alerts panel.
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Alert Panel Controls Description

Displays the alert records. You can select the number of
rows with alert records to view in the Alerts panel. The
default value is set to 5 rows per page.

Searching an Alert
You can search an alert by alert name in the Alerts panel.

To search for an alert:

Procedure
1. In the Report Viewer tool bar, click the View Alert List icon . The Alerts panel

opens.

2. In the Alerts panel, enter an alert name in the Search icon to search for an alert.

Note:
Only the specific alert name that meets with the search criteria of the Alert
name column is displayed in the Alerts panel.

Figure 72: List of alerts found in Alerts Panel
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3. If no alert name matches with your search term, then the list remains empty with a
message, as shown in the following figure. Click the Cancel icon to clear or cancel
the search term.

Figure 73: No Alerts found in Alerts Panel

The Alerts panel can display 5, 10, 25, or 100 alert records or row in the page. By default,
five rows per page are displayed. You can change the number of rows per page to 5, 10, 25,
or 100. Based on your selection, records are displayed in the Alerts panel.

Figure 74: List of Rows in Alerts Panel

The total count of records in the Alerts panel is equivalent to the number of rows selected
per page.

For example, consider you want to view 10 alerts with 5 rows per page in the Alerts panel.
Click the Rows per page to view 10 alerts in the Alerts panel. The Alerts panel displays
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records in two sets of pages. The first page displays five records with the total count of 1-5
rows per page. The remaining five alert records are displayed in the second page with the
total count of 6-10 rows per page. For more details, see the below figure.

Figure 75: Row per page in Alerts Panel

Editing an Alert
You can edit an alert from the Alerts panel.

To edit an alert

Procedure
1. Click the View Alert List icon to view the alerts in the Alerts panel.

2. Click the Edit icon in the row of the alert that you want to update.

3. In the Edit Alert panel, modify the Condition, Parameters, Schedule, Notifications,
and Output tabs.
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Note:
After editing the values, validation happens for the modified values of each
tab. Click anywhere outside the field name of any tab or switch between
any tabs to enable the Apply changes button.

4. Click Apply changes to save your changes or click Cancel to cancel the added
details. On selecting Apply changes, the update occurs immediately and the Alerts
panel opens with the list of updated alerts.

Figure 76: List of Updated Alerts

5. Click Close to close the Alerts panel.

Deleting an Alert
You can delete an alert from the Alerts panel.

To delete an alert

Procedure
1. Click the View Alert List to view the alerts in the Alerts panel.

2. Click the delete icon to delete the corresponding alert. A confirmation dialog with
a warning message appears to confirm if you want to delete this alert.
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Figure 77: Deleting Alert

3. Click Delete to delete the alert else click Cancel to cancel the delete action.

4. Click Close to close the Alerts panel.
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Working with the Ad Hoc Editor
This section describes functionality that can be restricted by the software license for JasperReports
Server. If you don’t see some of the options described in this section, your license may prohibit you
from using them. To find out what you're licensed to use, or to upgrade your license, contact
Jaspersoft.

The Ad Hoc Editor is the interactive designer for creating and editing an Ad Hoc view,
where you can explore and analyze data from your Topic, Domain, or OLAP data source. Ad
Hoc views can also be used to create content for reports.

This chapter discusses the Ad Hoc Editor and Ad Hoc views, and includes the following
sections:

• Overview of the Ad Hoc Editor

• Working with Tables

• Working with Charts

• Working with Standard Crosstabs

• Working with OLAP Connection-based Crosstabs

• Calculated Fields and Measures

• Using Filters and Input Controls

• Creating a View from a Domain

• Working with Topics

After you create an Ad Hoc view, you - and other users with the proper permissions - can
run the report, then further refine the displayed information and personalize the look of
the report in the Report Viewer. For more information on that process, see Running Reports
and the Report Viewer.

Overview of the Ad Hoc Editor
The Ad Hoc Editor is an interactive tool for creating views for various types of reports:
tables, crosstabs, and charts. You create these views by simply dragging and dropping
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elements. You can add and summarize fields, define groups, label and title the report, and
format data for each field. The effects of your changes are evident immediately, and you
can adjust the display to highlight the most relevant and compelling aspects of your data.

The Ad Hoc Editor provides analysis options (such as slice, pivot, and filter) to help you
recognize trends and outliers in your data. You can drill into specific details or analyze your
data at a very high level.

To open the Ad Hoc Editor

Procedure
1. Click Create > Ad Hoc View. This opens the Select Data dialog.

2. Choose your data source from the list and click OK.
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Figure 78: List of Data Sources in the Select Data Dialog

The Ad Hoc Editor contains the following panels, from left to right:

• Data Source Selection, which contains the fields, dimensions, and measures
available in the source Domain, Topic, or OLAP connection.

• Ad Hoc View, the main view design panel.

• Filters, which defines a subset of data to retrieve from the data source.

• Format Visualization, which displays the properties specific to the selected
visualization type.
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Figure 79: User Interface of the Ad Hoc Editor

We’ll discuss how to use these panels to create an Ad Hoc view later in this section.

Ad Hoc Sources: Topics, Domains, and OLAP
Connections
The following repository objects provide a prepared connection to a data source for Ad Hoc
view creation:

• Topics, JRMXL files are created externally and uploaded to JasperReports Server as a
basis for Ad Hoc views.

• Domains, virtual views of a data source that present the data in business terms,
allow for localization, and provide data-level security.

• OLAP Connections, multi-dimensional views of data that allow users to analyze a
large number of aggregate data levels.

You can also open and edit an existing Ad Hoc view to create a new Ad Hoc view. After
editing the Ad Hoc view, if you close the Ad Hoc view without saving the changes, you are
prompted to save or cancel the changes.
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Topics
Generally, an administrator or Jaspersoft Studio user creates a Topic as a JRXML file. The
JRXML topic is then associated with a data source in the server. A Topic can also be
created from a Domain in the server. Both types of topics appear in the Select Data wizard
when you create an Ad Hoc view.

Using a Topic as your source generates an empty view, which allows you to begin adding
data to your view right away, without choosing, pre-filtering, or changing display names of
the data (all of which are required steps when creating a Domain-based view).

The views in the /Ad Hoc Components/Topics folder populate the Topics tab that appears
when users click Create > Ad Hoc View.

To begin designing a Topic-based view

Procedure
1. Launch the Ad Hoc Editor by clicking Create > Ad Hoc View.

2. In the Select Data wizard, click and navigate to Ad Hoc Components > Topics.

3. Expand the Topics folder and select a topic.

4. Select the type of view that you intend to create: table, chart, or crosstab. For an
overview of view types, see Ad Hoc View Types.

You can now begin working on your view in the Ad Hoc Editor.

Domains
Administrators create Domains that typically filter the data, create input controls, and
manage the list of available fields and measures. A Domain specifies tables in the database,
join clauses, calculated fields, display names, and default properties, all of which define
items and sets of items for creating Ad Hoc views.

Unlike Topics, which must be stored in a specific folder in the repository, Domains are
detected regardless of their location in the repository. The /Domains folder is included for
your convenience, but the Domains tab in the Source dialog displays all the Domains to
which you have access in the repository.

To begin designing a Domain-based view
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Procedure
1. Launch the Ad Hoc Editor by clicking Create > Ad Hoc View.

2. In the Select Data wizard, click and navigate to Domains.

3. Expand the Domains folder and select a domain.

4. Click Choose Data..., and click the options on the left of the window to perform the
following tasks:

l Click Fields to select fields of data to use in the view.

l Click Pre-filters to create filters to limit the data available in the Ad Hoc Editor.

l Click Display to change the fields’ display names.

l Click Save as Topic to save the customized topic for later use.

5. Select the type of view that you want to create: table, chart, or crosstab. For an
overview of view types, see Ad Hoc View Types.

You can now begin working on your view in the Ad Hoc Editor.

OLAP Connections
Administrators create OLAP client connections that expose transactional data and define
how the data can be seen as a multidimensional cube. An OLAP connection can expose
multiple cubes in a single OLAP connection.

With OLAP connections, you can create chart and crosstab views only.

To begin designing an OLAP connection-based view

Procedure
1. Launch the Ad Hoc Editor by clicking Create > Ad Hoc View.

2. In the Select Data wizard, click and navigate to Analysis Components > Analysis
Connections and select a sample project and a connection.

You can now begin working on your view in the Ad Hoc Editor.

For more information about OLAP-based view functionality, refer to the following sections:
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• Working with OLAP Connection-based Crosstabs

• Working with Topics

Ad Hoc View Types
The Ad Hoc Editor allows you to select from three view types:

l Tables, which are used to view values in the database and to summarize the values
in columns.

l Charts, which compare one or more measures across multiple sets of related fields.

l Crosstabs, which aggregate data across multiple dimensions.

This section provides an overview of each view type. The design and content tasks for
working with each type of view are discussed in more detail in the following sections:

l For more information on table views, see Working with Tables.

l For more information on chart views, see Working with Charts.

l For more information on crosstab views, see Working with Standard Crosstabs.

Tables
The architecture of a table view consists of columns, rows, and groups.

Columns in a table correspond to the columns in the data source. They are included by
adding fields or measures to the table in the Ad Hoc view.

Rows correspond to rows in the database. The information in each row depends on what
columns are included in the table.

Using groups, rows can be grouped by identical values in any field with intermediate
summaries for each grouped value. For example, a table view of product orders might
contain columns to show the dates and amounts of each order, and its rows might be
grouped by city and product.
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Date Placed Date Filled Payment Received

City A

Product 01

Date Date Amount

Date Date Amount

Product 01
totals:

Count Sum

Product 02

Date Date Amount

Date Date Amount

Product 02
totals:

Count Sum

Product 03

Date Date Amount

Date Date Amount

Product 03
totals:

Count Sum

City A totals: Count Sum

City B

Product 01

Date Date Amount

Date Date Amount

Date Date Amount
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Date Placed Date Filled Payment Received

... ... ...

For more information on working with tables, see Working with Tables.

Charts
Charts summarize the data graphically. Types of charts include bar chart, line chart, and
pie chart, among others. With the exception of time series and scatter charts, each type of
chart compares summarized values for a group. For example, the Chart tab might show the
data in a bar chart that compared the sum of Payments Received for each of the products
in each of the cities.

Total Payments Received

City A City B City C

Time series and scatter charts use time intervals to group data.
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For more information on working with charts, see Working with Charts.

Crosstabs
Crosstabs are more compact representations than tables. They show only aggregate values,
rather than individual database values. Columns and rows specify the dimensions for
grouping. Cells contain the summarized measurements. For instance, the example above
could be displayed in a crosstab with columns grouped by sales manager and year.

Tom Harriet Manager
Totals

2012 2013 Year Totals 2012 2013 Year Totals

City A Product 01 Payment
Received

Payment
Received

Payment
Received

Payment
Received

Payment
Received

Payment
Received

Payment
Received

Product 02 Payment
Received

Payment
Received

Payment
Received

Payment
Received

Payment
Received

Payment
Received

Payment
Received

Product 03 Payment
Received

Payment
Received

Payment
Received

Payment
Received

Payment
Received

Payment
Received

Payment
Received

Product
Totals

Payment
Received

Payment
Received

Payment
Received

Payment
Received

Payment
Received

Payment
Received

Payment
Received

City B Product 01 Payment
Received

Payment
Received

Payment
Received

Payment
Received

Payment
Received

Payment
Received

Payment
Received

... ... ... ... ... ... ... ...

City Totals Payment
Received

Payment
Received

Payment
Received

Payment
Received

Payment
Received

Payment
Received

Payment
Received

For more information on working with crosstabs, see Working with Standard Crosstabs.

OLAP connection-based crosstabs behave differently than those created from Topics or
Domains. See Working with Topics.

The Data Source Selection Panel
The Data Source Selection panel contains a list of available fields in the chosen Topic or
Domain. If you are using a Domain, fields may appear in nested sets. Use the arrow beside
the set name to expand or collapse a set of fields.

Available fields may be divided into two sections in the panel, Fields and Measures. You
can use the search field in each section to locate a specific field or measure.
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To hide this panel, click < in the top-left corner. This is helpful when arranging content in a
large Ad Hoc view. Click the same icon on the minimized panel to expand it.

For more information on working with fields, see Using Fields in Tables , Using Fields and
Measures in Charts, and Using Fields in Crosstabs.

The Ad Hoc View Panel
The Ad Hoc View panel provides tools that allow you to control what data is included in a
view, and how it is organized.

Along the top of the panel, there is a tool bar and a dropdown menu.

The dropdown menu contains options for displaying a subset of the available data (Sample
Data), all available data (Full Data), or none of the available data (No Data) in the view.
Using the sample data can make the design process quicker by loading less data. Use the
subset for initial design; use the full set for refining layout elements such as column width.

By default, the editor displays only a smaller, sample set of the data in the view. Use the
dropdown menu to select Full Data to view the full set of data.

Depending on its configuration, JasperReports Server may load a Topic, Domain, or OLAP
connection’s entire result set into memory when you edit the view, or run a report from it. If the data
policies and other options that control JasperReports Server’s memory are disabled, ensure that
each Topic, Domain, or OLAP connection returns a manageable amount of data, given the
environment’s load capacity. Alternately, you can change the server’s configuration

The tool bar at the top of the panel provides access to many functions of the Ad Hoc
Editor. The toolbar is described in .

Icon Name Description

Save Place the cursor over this icon to open a menu of save options.

Export Place the cursor over this icon to open a menu of export options.
You can export the Ad Hoc View in the following formats:

l PDF Document (.pdf)

Ad Hoc Editor Tool Bar Icons
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Icon Name Description

l Comma Separated Values (.csv)

l Microsoft Word (.docx)

l Rich Text Format (.rtf)

l OpenDocument Text (.odt)

l OpenDocument Spreadsheet (.ods)

l Microsoft Excel - Paginated (.xlsx)

l Microsoft Excel (.xlsx)

l Microsoft PowerPoint (.pptx)

Get Embed
Code

Click to display the Ad Hoc View Embed Code dialog. See Getting
the Embed Code for Visualize.js for more information.

Undo Click this icon to undo the most recent action.

Redo Click this icon to redo the most recently undone action.

Undo All Click this icon to revert the view to its state when you last saved.

Switch Group Click this icon to change the way groups are displayed. For more
information, refer to Creating a View from a Domain.

Sort When working with tables, click this icon to view the current sorting
and to select fields for sorting data. For more information, refer to
Sorting Tables.

Input Controls Click this icon to see the input controls applied to this view. For
more information, refer to Using Input Controls.

Page Options Place the cursor over this icon to open a menu of page-level
options. You can change whether to display the Layout Band.

View SQL/MDX
Query

For more information on viewing SQL queries, see Viewing the SQL
Query.



JasperReports® Server User Guide

169 | Working with the Ad Hoc Editor

Icon Name Description

For more information on viewing MDX queries, see Viewing the MDX
Query.

Select
Visualization
Type

Click this icon to select the type of table, chart, or crosstab you
want to use in your Ad Hoc view. For information on all the types of
visualizations available, see The Visualization Selector for more
information.

Close Ad Hoc
View

Click to close the Ad Hoc View and return to the previous screen.

The Layout Band
Directly beneath the tool bar is the Layout Band. Here there are two fields. These fields
have different labels and functions, depending on the type of view you are creating:

• For tables, these fields are Columns and Groups.

• For charts, these fields are Columns and Rows.

• For crosstabs, these fields are Columns and Rows.

You can drag and drop fields and measures into these boxes to populate your view.

Viewing the SQL Query
You may want to look at the SQL query for your view, to verify what data users are hitting.
If you have the proper permissions, you can do this in the Ad Hoc Editor with the View
Query button.

The query is read-only, but can be copied onto a clipboard or other document for review.

To view the SQL query

l In the tool bar, click .
The View Query window opens, displaying the SQL query.
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The Visualization Selector
The Visualization Selector lets you switch between Ad Hoc view types, allowing you to
choose the best way to represent your information in the Ad Hoc view, including:

• Table, which displays values corresponding to the rows and columns in the data
source.

• Crosstab, which compares one or more values across multiple sets of related fields.

• Column, which compares values displayed as columns.

• Bar, which compares values displayed as bars.

• Line, which compares values displayed as points connected by lines.

• Area, which compares values displayed as shaded areas.

• Spider, which compares three or more values on a series of spokes. Spider charts
can use columns, lines, or areas to display values.

• Dual- and Multi-Axis, which display values using two or more measures.

• Time Series, which compares time intervals displayed as points connected by lines.
The Time Series chart type is only available for non-OLAP charts.

• Scatter, which compares values as individual points arrayed across both axes of a
chart.

• Bubble, which compares three measures displayed as circles of varying sizes arrayed
across both axes of a chart.

• Pie, which compares values displayed as slices of a circular graph.

• Range, which displays values such as heat and tree maps. Only the Heat Map chart is
available for OLAP data sources.

• Gauge, which displays values as a radial or arc gauge, based on a defined minimum
and maximum measure setting.

JasperReports Server has limited support for scatter charts created in some older versions. You
can use the Ad Hoc views for those scatter charts to generate new reports, but you cannot edit
them

To select a new visualization type
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Procedure
1. In the Ad Hoc Editor tool bar, click the icon to display the Select Visualization

Type window.

Figure 80: Select Visualization Type Window

2. Click the type of visualization that you want to apply to your report. The selected
visualization type is outlined in blue. The Visualization Selector displays a description
of the selected visualization and the number of fields and measures that it uses.

3. Click Apply and Close to use the visualization type.

The following table describes the available visualization types, and the rules (if any)
affecting their use:

Icon Description

Data Grid Data grids display values from the data source in
columns and rows as either individual or aggregate
values.

HTML5 Visualization Types
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Icon Description

Crosstab - Compares one or more measures across
multiple sets of related fields.

Table - Displays values corresponding to the columns and
rows in the data source.

Column and Bar Column charts compare values displayed as columns
and bars.

Column - Multiple measures of a group are depicted as
individual columns.

Stacked Column - Multiple measures of a group are
depicted as portions of a single column whose size reflects
the aggregate value of the group.

Percent Column - Multiple measures of a group are
depicted as portions of a single column of fixed size.

Spider Column - Multiple measures of a group are
depicted as portions of individual "columns" along a
spoked chart.

Bar - Multiple measures of a group are depicted as
individual bars.

Stacked Bar - Multiple measures of a group are depicted
as portions of a single bar whose size reflects the
aggregate value of the group.
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Icon Description

Percent Bar - Multiple measures of a group are depicted
as portions of a single bar of fixed size.

Line and Area Line charts compare values displayed as points
connected by lines.

Line - Displays data points connected with straight lines.

Spline - Displays data points connected with a fitted curve.

Spider Line - Displays data points connected with straight
lines on a spoked chart.

Area - Displays data points connected with a straight line
and a color below the line. Groups are displayed as
transparent overlays.

Stacked Area - Displays data points connected with a
straight line and a solid color below the line. Groups are
displayed as solid areas arranged vertically, one on top of
another.

Percent Area - Displays data points connected with a
straight line and a solid color below the line. Groups are
displayed as portions of an area of fixed size, and arranged
vertically one on top of another.

Area Spline - Displays data points connected with a fitted
curve and a color below the line. Groups are displayed as
transparent overlays.
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Icon Description

Spider Area - Displays data points connected with straight
lines and a solid color between the line and the center of a
spoked chart. Groups are displayed as transparent
overlays.

Dual and Multi-Axis Dual and multi-axis charts compare two or more
measures, using multiple charting types or multiple
axes.

Column Line - Displays leftmost measures as columns, last
measure as a line.

• Requires two or more measures.

• Measures must be placed in the Columns location.

• Fields and dimensions can be placed only in the
Rows location.

Stacked Column Line - Displays leftmost measures as
stacked bars, last measure as a line.

• Requires three or more measures.

• Measures must be placed in the Columns location.

• Fields and dimensions can be placed only in the
Rows location.

Column Spline - Displays leftmost measures as columns,
last measure as a spline.

• Requires two or more measures.

• Measures must be placed in the Columns location.

• Fields and dimensions can be placed only in the
Rows location.

Stacked Column Spline - Displays leftmost measures as
stacked columns, last measure as a line.

• Requires three or more measures.
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Icon Description

• Measures must be placed in the Columns location.

• Fields and dimensions can be placed only in the
Rows location.

Multi-Axis Line - Displays each measure as a separate axis
line.

• Requires two or more measures.

• Measures must be placed in the Columns location.

• Fields and dimensions can be placed only in the
Rows location.

Multi-Axis Spline - Displays each measure as a separate
axis spline.

• Requires two or more measures.

• Measures must be placed in the Columns location.

• Fields and dimensions can be placed only in the
Rows location.

Multi-Axis Column - Displays each measure as a separate
axis column.

• Requires two or more measures.

• Measures must be placed in the Columns location.

• Fields and dimensions can be placed only in the
Rows location.

Time Series Time Series charts illustrate data points at successive
time intervals.

Line - Displays date and time data points connected with
straight lines.

• Requires a single date/time field in the Rows
location.
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Icon Description

• The field must be set to the "day" group function.

Spline - Displays date and time data points connected
with a fitted curve.

• Requires a single date/time field in the Rows
location.

• The field must be set to the "day" group function.

Area - Displays date and time data points connected with
a straight line and a color below the line. Groups are
displayed as transparent overlays.

• Requires a single date/time field in the Rows
location.

• The field must be set to the "day" group function.

Area Spline - Displays date and time data points
connected with a fitted curve and a color below the line.
Groups are displayed as transparent overlays.

• Requires a single date/time field in the Rows
location.

• The field must be set to the "day" group function.

Scatter Shows the correlation between two or three measures.

Scatter - Displays first measure as the x-axis, the second
measure as the y-axis. Other fields and dimensions in the
column group become data points.

• Requires exactly two measures.

• Measures must be placed in the Columns location.

Bubble - Displays the first measure as the x-axis, the
second measure as the y-axis, and the third measure
determines the size of the disk.

• Requires exactly three measures in the Columns
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Icon Description

location.

• The measures cannot be placed between other
fields.

Pie Pie charts display values as slices of a circular graph.

Pie - Multiple measures of a group are displayed as sectors
of a circle.

Dual Pie - Multiple measures of a group are displayed as
sectors of concentric circles.

• Requires at least one measure and one field.

• Fields must be placed in the Rows location. Only
one field can be placed in the Rows location if it
contains a measure.

• Two fields can be placed in the Rows location if it
contains no measures.

• Multiple measures are allowed in the Rows location,
but only one measure is allowed in the Columns
location.

Semi-Pie - Multiple measures of a group are displayed as
sectors of a half-circle.

Range Range charts display values as heat maps.

Heat Map - Individual values are represented as colors.

Non-OLAP:

• One field, followed by one Measure, required in the
Columns location.

• One field is required in the row location.
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Icon Description

OLAP:

• One Dimension level, followed by one Measure,
required in the Columns location.

• One Dimension level is required in the Rows
location.

Time Series Heat Map - Individual values across
dates/times represented as colors.

• One Measure required in the Columns location.

• One Date/Time field is required in the Rows
location.

• Only available for non-OLAP data sources.

Dual Measure Tree Map - Displays data as color-coded
rectangles. The size of each rectangle is proportional to
the first measure and the color represents the second
measure.

• Two Measures are required in the Columns location.

• One field is required in the Rows location.

• Only available for non-OLAP data sources.

Tree Map - Displays data as rectangles. The size of each
rectangle is proportional to the measure of the data that it
represents. The tree map displays nested rectangles when
you have more than one field. The parent rectangle
represents the leftmost measure while the nested
rectangles represent the current level of aggregation. Click
a parent rectangle to drill down to the nest rectangles.

• One Measure required in the Columns location.

• One or more fields required in the Rows location.

• Only available for non-OLAP data sources.
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Icon Description

Parent Tree Map - Displays data as nested rectangles. The
size of each rectangle is proportional to the measure of the
data that it represents. The nested rectangles represent
the current level of aggregation while the larger rectangle
represents the parent level in the hierarchy. Click a parent
rectangle to drill down to the nest rectangles.

• One Measure required in the Columns location.

• Two or more Fields required in the Rows location.

• Only available for non-OLAP data sources.

Gauges Gauges display values as a portion of a radial or arc
gauge.

Gauge - Displays a single data value as a portion of a
circle. The length of the circle is the data's numeric value
proportional to the maximum size defined for the measure.

• One or more Measures required in the Columns
location.

• One or more Fields required in the Columns
location.

• Define the minimum and maximum sizes, color
stops, and layout on the Appearance tab.

Multi-level Gauge - Displays one or more data values as
concentric circles. Each circle represents a measure and
the length of the circle is the data's numeric value
proportional to the maximum size defined for the
measures.

• Two or more Measures required in the Columns
location.

• One or more Fields required in the Columns
location.

• Define the minimum and maximum sizes, color
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Icon Description

stops, and layout on the Appearance tab.

Arc Gauge - Displays a single data value as a portion of a
semi-circular arc. The length of the arc is the data's value
proportional to the maximum size defined for the measure.

• One or more Measures required in the Columns
location.

• One or more Fields required in the Rows location.

• Define the minimum and maximum sizes, color
stops, and layout on the Appearance tab.

The Filters Panel
The Filters panel displays any filters defined for the view. You can set the filter values and
see the resulting change in the Ad Hoc View panel. To minimize the Filters panel, click the
> button in the top left corner of the panel. Click the < button on the minimized panel to
expand it again.

For more information on working with filters, see Using Filters and Input Controls.

Saving an Ad Hoc View, Previewing and Creating a
Report
After you create a compelling table, chart, or crosstab, you can save the view in the
repository for future use.

To save an Ad Hoc view

Procedure

1. Hover your mouse over .

2. Select Save Ad Hoc View or Save Ad Hoc View As.
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3. Name the view as needed, and click Save. The view is saved in the repository.

You can also save an Ad Hoc view as a report. Typically, a report is created when you want
to:

• See data in the interactive Report Viewer.

• Perform additional formatting of the table data.

• Embed the data content in a dashboard.

Create a report from the view by selecting Save Ad Hoc View and Create Report; you can
also create and run a report directly from the repository. For more information, see
Running or Creating a Simple Report. When you run the report, it is displayed as a
JasperReport.

To preview an Ad Hoc view

• Click the Editing button and select Viewing.

To switch to the design mode from the preview (display mode)

• Click the Viewing button and select Editing.

Dependent Reports
When you create a report from an Ad Hoc view, the report is considered “dependent” on
that view.

When you save an Ad Hoc view, some, but not all, of its changes appear in its dependent
reports. For example, if you open an Ad Hoc view with a table and adjust the data level for
its columns, the column changes show up in previous reports created from that view.

In cases where changes to an Ad Hoc view could cause errors in dependent reports, you
should save the updated view with a different file name and create a new report.

Updating Ad Hoc Reports
The Ad Hoc Designer Save Ad Hoc View and Create Report option in the tool bar creates an
Ad Hoc report unit. In the report unit, the main JRXML is a reference to a JRXML template
and contains an Ad Hoc component in it. Therefore there is no longer a copy of that style
template.
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The new Ad Hoc reports reference an external report template (JRXML) means that changes
in the reusable template get reflected to all Ad Hoc report units.

Also, unlike older Ad Hoc reports, the styles are not copied into every report unit and they
are referenced externally using a style template file (JRTX). It means that changing the
styling of all Ad Hoc reports is as easy as modifying the reference style template.

Ad Hoc report units are just simple report units that use the Ad Hoc view as data source
and reference one of the new Ad Hoc report templates under /public/templates as a main
JRXML.

Figure 81: Ad Hoc View as Data Source

The default template can be changed if needed by modifying the defaultTemplateUri
property of the reportGeneratorDefaultConf bean in the applicationContext-adhoc.xml
Spring configuration file.

Impact of JIVE Changes
The report having JIVE changes saved in the Report Viewer remain unchanged after the Ad
Hoc view changes. The report behaves like an old Ad Hoc report that means it does not
even break because of incompatible changes made in the view. For example, you sort the
column of a table and save the dependent report and then you add a column to Ad Hoc
View in the Ad Hoc Designer.

This result into an Ad Hoc report with a sorted column and a column added to the Ad Hoc
view is not reflected to the same Ad Hoc report.

You can also revert the JIVE saved report to the dynamic state offered by the Ad Hoc
component. To do so, edit the report unit and remove the internal resource called
adhoc.jrxml, which contains the JIVE saved state.

Also, the JIVE save operation makes a copy of the main JRXML into the report unit. You can
replace this JIVE made copy with an external JRXML reference that points to the original Ad
Hoc report template from the /public/templates folder.



JasperReports® Server User Guide

183 | Working with the Ad Hoc Editor

Getting the Embed Code for Visualize.js
Visualize.js is the JavaScript library available with JasperReports Server to embed
dashboards and reports in custom web apps. If you create an app with Visualize.js, this
feature gives you the JavaScript code needed to embed the current dashboard in your app.
You can then write additional code to interact with the dashboard programmatically, for
example to update a filter depending on other actions in your app. For more information,
see the JasperReports Server Visualize.js Guide.

You can get the embed code for an Ad Hoc view from the Ad Hoc editor in design mode.
When in display mode, click the Viewing button and select Editing to switch to the design
mode.

To get an Ad Hoc view embed code

Procedure
1. On the Ad Hoc viewer toolbar, click to open the Ad Hoc View Embed Code dialog.

Figure 82: Ad Hoc View Embed Code Dialog

The dialog shows the Visualize.js code and a preview of the dashboard as it is saved.

2. Click the Copy Code button to copy the embed code to the clipboard.

3. Click the Open in JSFiddle button to load the embed code into JSFiddle, an online
JavaScript viewer, and interactive editor.

4. Click the Close button to return to the Ad Hoc view.
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Working with Tables
The following sections explain how to populate, edit, and format your table-type view.

Figure 83: Ad Hoc Editor’s Table View

Using Fields in Tables
Insert data into your table by adding fields. All available fields are listed in the Data Source
Selection panel, on the left side of the Ad Hoc Editor.

The available fields are divided into two sections in the panel:

• Fields, which can be added to the table as columns or groups.

• Measures, which are specialized fields that contain data values.

To add fields and measures as columns to a table

1. In the Data Source Selection panel, click to select the field or measure you want to
add to the table. Use Ctrl-click to select multiple items.

2. Drag the selected item into the Columns box in the Layout Band.
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The field is added to the view as a column in the table.

To remove a field or measure from a table

• In the Layout Band, click the x next to the field or measure’s name.

Groups
Groups allow you to create detailed data rows. For example, if you have a table that lists
the suppliers for a national restaurant chain, you can group the suppliers by the State field.
The suppliers’ names are then rearranged so that all suppliers located in Maine, for
instance, are located under a “Maine” header row; suppliers in Maryland are together
under a “Maryland” header row, and so on.

You can use multiple fields to make more specific nested groups. By adding a group based
on the “City” field to the table described above, the restaurant suppliers are arranged by
City within the State groups. Under the “Maine” header row, new header rows for Augusta,
Bangor, and Portland are added, and the names of the Maine-based suppliers appear
under their respective cities. Under the “Maryland” header row, header rows for Annapolis,
Baltimore, and Silver Spring are added, and the names of Maryland-based suppliers appear
under those headers, and so on.

Only fields can be applied to a table as a group; measures cannot.

Data is grouped in the table according to the order that they were defined. You can change
the order by dragging the groups into position if needed.

To create a group

Procedure
1. In the Data Source Selection panel, click to select the field you want to add to the

table as a group.

2. Drag the field to the Groups box in the Layout Band.
The Ad Hoc view refreshes and displays the data grouped under a new header row.

You can also add a group to the table by right-clicking a field and selecting Add as Group.

To remove a group
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• In the Layout Band, click the x next to the field’s name in the Groups box.

To move the grouping order up or down in a table

• In the Layout Band, drag the name of the group you want to move into its new
position.

Summaries
You can display summary data for any column in your table. Summary data may be in the
form of various functions, such as:

• Sum

• Count

• Distinct Count

• Average

For example, in a table with a list of stores, grouped by City and Country, you can display
the number of stores in each City, and in each Country, using this function.

By default, the summary function for each field is defined by the data source, OLAP, or
domain definition.

To add a summary to a specific column

• In the table, right-click the column you want to calculate a summary for, and select
Add Summary.

The summary information is added to the group header, or is added to the bottom
of a column if no groups are included in the table.

To remove a summary from a specific column

• In the table, right-click the column with the summary you want to remove, and
select Remove Summary.

The summary information is removed from the table.

To add or remove summaries from all columns
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In the Format Visualization panel, in the Appearance settings, click the Data Detail
dropdown menu and select the following:

l To add summaries to all columns: Details and Totals

l To remove summaries from all columns: Details

Column and Header Labels
You can edit a column or header label directly in the Ad Hoc Editor.

To edit a column or header label

Procedure
1. On the Ad Hoc view panel, right-click the column or group header you want to

rename.

2. Select Edit Label from the context menu. The Edit Label window opens.

3. In the text entry box, delete the existing name and enter the new name.

4. Click Submit.

If space is at a premium, you can remove labels from the view. When you delete a label, it
still appears when you look at the view in the Ad Hoc Editor, but does not appear when
you run the report.

To delete a column or header label

Procedure
1. On the Ad Hoc view, right-click the column or header label you want to remove.

2. Select Delete Label from the context menu.

To re-apply a label

Procedure
1. Right-click the column or header label that you want to replace.

2. Select Add Label from the context menu. The Edit Label window opens.
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3. Enter the label name, if needed.

4. Click Submit.

Managing Column Size and Spacing
You can change the size of, and spaces between, columns to manage the appearance of
your table or use space more efficiently.

To resize a column

Procedure
1. In the Ad Hoc View panel, click to select the column you want to resize.

2. Move the cursor to the right edge of the column.

3. When the cursor changes to the resize icon ( ), click and drag the column edge
right or left until the column is the needed size.

Spacers can be added to a table to arrange columns farther apart, or add margins to a
table.

To change the spacing between columns

Procedure
1. In the Data Source Selection panel, in the Measures section, click Spacer.

2. Drag the spacer into the Columns box in the Layout Band between the names of the
two columns that you want to move apart.
A spacer column, labeled , appears in the table.

3. Repeat this action to add space as needed between columns.

4. To remove a spacer, right-click the spacer column and select Remove from Table.

To use spacers to create table margins

Procedure
1. In the Data Source Selection panel, click to select Spacer.
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2. Drag the spacer into the Columns box in the Layout Band.

3. Repeat until the margins are as wide as needed.

4. Repeat the steps above, adding the spacer to the right edge of the table.

Using "FallbackColumnWidth" Property
The following property, fallbackColumnWidth, exists in `applicationContext-adhoc.xml` to
the bean `tableDefaults`. This is a fallback value in case of an attempt to set the column
width to zero. The default value is `-1`, which disables the fallback. When/if the column
width is 0, the fallbackColumnWidth value can be changed to get it enabled and set
column width to the desired value.

Reordering Columns
You can move columns to the right or left to reorder the data in your table.

To reorder a column

1. In the Ad Hoc View panel, right-click the column you want to move.

2. Select Move Right or Move Left from the context menu.

Sorting Tables
In the Ad Hoc Editor, you can sort the rows of a table by any field, using a number of
different methods.

To sort a table

Procedure

1. Click . The Sort window appears. If the table is already sorted, the window
shows the fields used.

2. To add a field to sort on, double-click the field in Available Fields. The Available
Fields panel now lists only fields not currently in Sort On.
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3. Select one or more fields to sort by. You can also use Ctrl-click to select multiple
fields.

4. Click .

5. To arrange the sorting precedence of the fields, select each field in the Sort window

and click Move to top, Move up, Move down, or Move to bottom: , , ,

and .

6. To remove a field, select it and click .

7. Click OK. The table updates to display the rows sorted by the selected fields.
You can also sort a table using the following methods:

l Right-click a field in the Fields section of the Data Source Selection panel, and
select Use for Sorting from the context menu. In this case, the table is sorted by
a field that is not in the table; you may want to note the sorting fields in the
title.

l Right-click a column header on the Canvas of the Ad Hoc View panel, and select
Use for Sorting from the context menu.

If a column is already being used and you want to stop using it or change the sorting, then right-
click the column and select Change Sorting from the context menu.

Adding a Title
1. Above the table, click the text Click to add a title.

2. Enter the new table title in the text entry box.

Alternatively, in the Format Visualization panel, in the Title setting, in the Title
field, enter the table title.

Changing the Data Format
You can change the formatting for columns containing numeric data, such as dates and
monetary amounts. The format is applied to all rows as well as the group- and view-level
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summaries. By default, non-integer fields use the -1,234.56 data format; integers use -1234.

To change the data format for a column

1. In the Ad Hoc view, right-click the column header.

2. Select Change Data Format from the context menu.

3. Select the format that you want to use. These options vary depending on the type of
numeric data contained in the column.
The data in the column now appears in the new format.

Changing the Data Source
You may need to select a new data source for your table. This is a simple task, but you
should keep in mind that all view data and formatting are lost when you select a new
Topic, Domain, or OLAP connection. Any changes to the view are also lost if you navigate
to another page using the browser navigation buttons, the main menu, or the Search field.
To preserve changes, accept the current Topic or click Cancel.

To change the table’s data source

Procedure
1. At the top of the Data Source Selection panel, click and select Change Source.

2. Select a different Topic, Domain, or OLAP connection.

3. Click Table to apply the new data source.

4. Click Cancel to return to the editor without changing the Topic.

Controlling the Data Set
You can control the data displayed in the table using the Appearance settings in the
Format Visualization panel.

Your options are:

l Data Detail:
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o Details, which displays table detail only. For instance, in a table listing sales in
dollars for all stores in a region for a given month, the amount sold by each
store that month is displayed.

o Totals, which displays the table totals only. In the table described above, the
total amount of all sales at all regional stores that month is displayed.

o Details and Totals, which display both the individual store sales numbers, as
well as the total sales numbers at the bottom of the store sales column.

l Show Duplicate Rows, which displays only the distinct values in your table if you
choose to hide the duplicate rows. By default, the Show Duplicate Rows setting is on.
See Showing Distinct Values for more information.
Select the option that you want to apply to your table.

Showing Distinct Values
Tables sometimes contain duplicate values in multiple rows, making it difficult to find
relevant data. You can choose to show only distinct values in your tables by choosing to
hide duplicate rows, making the table shorter and easier to read.

To show only the distinct values in a table, in the Format Visualization panel, in the
Appearance settings, click the Show Duplicate Rows switch to turn the setting off.

When you choose to hide duplicate rows, all columns are sorted in ascending order based
on their distinct values by default, but columns explicitly sorted in ascending or descending
order by the user will have higher priority. Sorting by hidden fields have no effect.

Working with Charts
Ad Hoc charts are a flexible, interactive way to explore your data graphically. You can
choose different levels of aggregation for rows and columns, change a field from a column
to a row, pivot the entire chart, hide chart values, and zoom in to see chart details.
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Figure 84: Ad Hoc Editor’s Chart View

The following sections explain how to populate, edit, and format an Ad Hoc chart. Many
tasks related to working with charts are identical (or very similar) to those for tables and
crosstabs. For any tasks not discussed in this section, see the information in Working with
Tables.

Using Fields and Measures in Charts
You must add at least one measure to view a chart. Before any measures are added to the
chart, the Ad Hoc Editor displays a placeholder with the legend displaying a single entry:
Add a measure to continue. As you add measures, the editor displays the grand total of
each measure in the chart.

The initial display reflects only the measures you add. It does not change when you add
fields or dimensions. For example, for each measure you add to a bar chart, you see a bar
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with the total value of the measure, regardless of how many fields you add. This means
you can add, remove, and arrange measures and fields without waiting for the display to
update. Once you have the fields and measures you want, you can use the sliders on the
right to select the level of detail you want. See Effect of the Slider on a Chart for more
information.

All available fields are listed in the Data Selection panel, as either standard fields or
measures.

• Standard fields can be added to a column or a row.

• Measures contain summarized values. They are typically numeric fields that
determine the length of bars, size of pie slices, location of points (in line charts), and
height of areas. They can be added to rows or columns, but must all be in the same
target — that is, you can add one or more measures to the chart as columns, or add
one or more measures to the chart as rows, but you cannot have one measure as a
column and another as a row in the same chart.

When creating a chart, keep in mind that row and column groups are arranged in
hierarchies, with the highest member of the hierarchy on the left. For an Ad Hoc view
based on an OLAP data source, you can change the order of distinct dimensions by
dragging, but you cannot change the order of levels within a dimension. For an Ad Hoc
view based on a non-OLAP data source, you can drag the field headings to rearrange the
hierarchy; the highest level in a group should appear to the left; the lowest level in a group
should appear to the right. For example, it doesn’t make sense to group first by postal
code then by country, because each postal code belongs to only one country.

To add a field or measure to a row or column:

Procedure
1. In the Data Selection panel, select the field you want to add to the chart as a group.

Use Ctrl-click to select multiple items.

2. Drag the selected item into the Columns or Rows box in the Layout Band.

Setting Levels
When you add a field or dimension to a column or row, a multi-level slider located at the
top of the Filters pane allows you to set the level of aggregation to use for viewing the
data. The number of fields or dimensions in the row or column determines the number of
levels on the slider. Measures are not reflected in the slider.
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You cannot adjust levels on time series charts.

The following figure shows the effect of the slider on a chart with one level of aggregation
for both rows and columns.

Columns Columns

Rows

Rows

Figure 85: Effect of the Slider on a Chart

To recreate this view

Procedure
1. Select Create > Ad Hoc View.

2. In the Select Data wizard, select foodmart data for crosstab and click OK.

3. Click to open the Visualization Selector.

4. Click and then Apply and Close.
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5. Drag the following from the Fields panel to the Layout Band:

l Store Sales from Measures to Columns. The view changes to show a column
with the total. No slider is added for measures.

l Product Family from Fields to Columns. The Data Level area is shown in the
Filters panel, with a Columns slider added.

l Date from Fields to Rows. A Rows slider is added to the Data Level area in the
Filters panel.

6. Use the sliders to see how the view changes.
The sliders help you explore your data visually in a number of ways:

l The slider reflects the hierarchy of the row or column groups, as determined by
the order in which fields are arranged in the Layout Band.

l Hovering over a setting on the slider shows the name of the field or dimension
corresponding to that setting.

l When you pivot a chart, slider settings are preserved and applied to the new
target. For example, if you have the Row slider set to Month, the Column slider
is set to Month when you pivot. See Pivoting a Chart for more information.

l When you remove the currently selected level from a row or column, the slider
is reset to the total; when you remove a field that is not selected, the level
remains the same. When you add a field or dimension to a row or column, the
number of levels of the slider changes to reflect your addition. When you
change the order of the fields in a row or column, the level on the slider
changes to reflect the new level of the field corresponding to the selection.

Changing Date Grouping
If your chart includes data based on a date field, you can change the level of aggregation
for the time data. To select the unit of time to chart:

l Right-click on the date field in the Layout Band and select Change Grouping. Then
select the time period you want from the cascading sub-menu:

o Year

o Quarter (examples: Q1, Q2, etc.)
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Quarter groups the data by quarter through the whole selected period. For example, if the
period has 2 years selected, then you will see 4 quarters (Q1, Q2, Q3, Q4) and data for
each year will be grouped under these 4 quarters regardless of the year it belongs to.
When Quarter is the only categorizer used, the sorting order will always start from the first
quarter. Also, if there is no data for a specific quarter then this quarter will still be visible
with no data.

l Quarter and Year (examples: Q1 2020, Q2 2020, etc.)

As of version 9.0, Quarter is renamed to Quarter and Year. Quarter and Year groups the
data by quarter and year. For example, if the period has 2 years selected, then you will see
potentially 8 quarters (for example, Q1 2020, Q2 2020, Q3 2020, Q4 2020, Q1 2021, Q2
2021, Q3 2021, Q4 2021), and data for each year will be grouped under its own quarter
which will take into account the year as well. Also, if there is no data for a specific
quarter, then this quarter will not be visible.

This date is required in order to create PeriodToPeriod (PTP) and YearToDate
(YTD) charts.

l Month (examples: January, February, etc.)

l Month and Year (examples, January 2020, February 2020, etc.)

As of version 9.0, Month is renamed to Month and Year. This date is required in order to
create PeriodToPeriod (PTP) and YearToDate (YTD) charts.

l Day

l Hour

l Minute

l Second

l Hour By Day

l Minute By Day

l Second By Day

l Millisecond By Day

l Day of Week

The view updates to reflect the new date grouping.

Time Series charts can use only day, or smaller, intervals.
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Changing the Summary Function of a Measure
You can get a new view of your data by changing the summary function of a measure, for
example, from sum to average. To select a new summary function for a measure:

l Right-click on the measure in the Layout Band and select Change Summary Function.
Then select the function you want from the cascading submenu. The view updates to
reflect the new summary function.

Pivoting a Chart
You can pivot a chart in two ways:

l Pivot the entire chart by clicking . The row and column groups switch places;
slider levels are maintained. The following figure shows the effect of pivoting a basic
column chart.

Figure 86: Effect of Pivoting a Chart

l Pivot a single group:

o To pivot a single row group, right-click it and select Switch To Column Group.
You can also move any field or dimension by dragging. You cannot drag a
measure to a different group.

o To pivot a single column group, right-click it and select Switch To Row Group.
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You can also move any field or dimension by dragging. You cannot drag a
measure to a different group.

Formatting Charts
You can control some aspects of how data points, field names, and labels are displayed on
your chart, including:

• Whether data points are displayed.

• Showing a measure name on charts including only a single measure.

• Restricting the number of labels displayed.

• Rotating the direction of label text.

• Selecting the colors used by the chart.

• Defining how gauges are displayed.

JasperReports Server also allows you to edit many of the chart's properties for cases when
you want more control over the appearance of a chart.

Displaying Data Points
You can choose whether to display data points in your line, time series, or area chart. Data
points can help users visualize chart data more accurately.

To show the data points on a chart, in the Format Visualization panel, in the Appearance
settings, click the Show data points switch to turn the setting on.

By default, the Show data points setting is on.

To remove data points from the chart, click the Show data points switch to turn the
setting off.
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Figure 87: Format Visualization Panel

Displaying the Measure Name/Label on the Value Axis
You can choose to display the measure name/label on the value axis. To show the measure
name/label on the value axis, in the Format Visualization panel, in the Labels settings,
click the Show label on value axis switch to turn the setting on.
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Note:
By default, the Show label on value axis setting is on.

To remove the measure name/label from the value axis, click the Show label on value
axis switch to turn the setting off.

Restricting Label Display
By default, every field included in your chart has a label displayed along either axis.
Measures show up as numeric values, often along the Y axis, and fields being measured
shows up as text along the X axis. On some charts - especially those with many fields
included - these labels may overlap, crowd together, or become difficult to read. You can
alleviate this problem by "stepping", or reducing, the number of labels displayed on your
chart.

To reduce the number of labels on your chart, in the Format Visualization panel, in the
Axis settings:

l For X Axis: Under X Axis, in the Interval between labels input, specify how often you
want the axis label to appear.

l For Y Axis: Under Y Axis, in the Interval between labels input, specify how often you
want the axis label to appear.

For instance:

o To display every second label, enter 2.

o To display every third label, enter 3, and so on.

To display every label, enter 1 in the Interval between labels inputs.

Rotating Label Text
By default, the labels on your chart are displayed horizontally. Multiple labels, or very long
ones, can be difficult to read. You can change the direction of these labels, on both the X
and Y axes, to improve chart readability.

To rotate label text, in the Format Visualization panel, in the Axes settings:

l For X Axis: Under the X Axis, in the Rotation of labels input, specify the degree of
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rotation to apply to labels.

l For Y Axis: Under the Y Axis, in the Rotation of labels input, specify the degree of
rotation to apply to labels.

For instance:

o To rotate the labels clockwise 90 degrees, enter 90.

o To rotate the labels counter-clockwise 90 degrees, enter -90.

o To rotate the labels clockwise 45 degrees, enter 45, and so on.

o To return the labels to their original, horizontal position, enter 0 in the
Rotation of labels inputs.

Changing the Chart's Colors
You can choose the colors of your chart by defining a series of colors for it to use. You can
also choose the background's colors.

To choose the chart's colors

Procedure
1. In the Format Visualization panel, go to the Appearance settings.
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Figure 88: Appearance Settings

2. Under Series Colors, click + Add color to add the first color.

The color picker button appears. The button displays a color and a corresponding
Hex value.

3. Click the button to open the color picker window.

4. Select the color that you want to use.

5. Click outside the color picker window to close it.

6. Click + Add color to add additional colors.

Note:
The order of the colors added to the chart is the order they appear in the
series.
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Figure 89: Appearance Settings with Multiple Colors in Series

7. You can change the colors of the chart background and plot using the color picker
buttons under Background Colors.

JasperReports Server reloads the chart with the new colors.

Changing the Display Settings for Gauges
Gauges are circular and semi-arc charts. The length of the circle or semi-arc is based on a
single data value in proportion to the minimum and maximum measurement amounts that
you define.

Gauges have their own display settings under the Appearance settings, where you can
select how they appear in the Ad Hoc view. You can specify the layout of the gauges on the
canvas, the color stops, and the minimum and maximum values for the gauge's measure.
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The settings under the Appearance settings apply to all gauges in the Ad Hoc view.

To edit a gauge's display settings

Procedure
1. In the Format Visualization panel, go to the Appearance settings.

Figure 90: Appearance Settings

2. From the Layout dropdown menu, select the layout for displaying the gauges. By
default, the layout is Best Fit, which displays all the gauges on the canvas in one or
more rows. The gauges can also be displayed in a single vertical column or a single
horizontal row.

3. Enter the minimum and maximum values for the gauge's measure. For gauge and arc
gauge charts, each measure added to the Ad Hoc view is displayed as its own gauge
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and the gauge's circle or arc represents how a single data value in the data source
compares to the maximum measure. For multi-level gauge charts, each measure is
displayed as concentric circles in the gauge. By default, the minimum is 0 and the
maximum is 100. The measures selected for the Ad Hoc view also determine whether
to display the data as percentages or as numeric values.

4. Enter the number of decimal places to show as part of the value displayed in the
gauge. The maximum number of decimal places you can specify is 8.

5. Enter a suffix string if you want to label the value displayed in the gauge.

6. Enter a value for each color stop for the gauge. Color stops define a gradient
progression for the gauge's colors in the Ad Hoc view. The default color stop values
are 0.2, 0.5, 0.7, and 1.

Note:
You can have a maximum of four color stops in your gauge. Each color
selected is the specific color displayed at the corresponding stopping
point. The colors displayed in the gauges are based on where the gauge's
value falls on the defined gradient.

7. Click the color picker button for each stop to open the color picker window and
select the color.

JasperReports Server reloads the Ad Hoc view's gauges with the new display settings.

Creating and Changing the Display Settings for Pies
Pies are charts displayed in a circle. The circle is divided into slices to display numerical
proportion. The length of a slice is proportional to the quantity that it represents.

You can create a pie using the Fields and Measures. You can select how they appear in the
Ad Hoc view. You can specify columns and rows, use the Drill Down option, Data Level
slider and Format Visualization panel to create a pie chart. The New Ad hoc View page
lets you create and change the display settings of the pie chart.

To create a pie

Procedure
1. On the New Ad hoc View page, select Pie from the Select Visualization Type pop-
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up.

Figure 91: Select Pie

2. View the following sections on the page:

l Fields and Measures

l Chart canvas

l Filters

l Format Visualization

3. Drag and drop the Fields and Measures in the Rows and Columns fields. The pie
according to the selected Columns and Rows is displayed.

The Title of the chart (if provided) is displayed at the top of the canvas.

Note:
The Title can be provided either from the Format Visualization panel or
by clicking Click to add a title on the canvas.
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The name of the pie is displayed at the top-left corner of the pie. The name consists
of the names of Measures from Columns. The name may also consist of fields, if
added to Columns (also depends on Columns Data Slider). The legend is displayed
at the bottom of the canvas.

Note:
The Legend is based on Rows only.

Figure 92: Select Columns and Rows

Note:
The number of pies depends on the number of Measures in Columns. If there
are two Measures in Columns, then two pies are displayed.

It also depends on the Fields added to the Columns. There may be one
Measure but adding Fields and setting the Data Level slider can increase the
number of pies.

4. In the Filters section, drag the Row slider to control the values from the selected
fields from Rows.
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Figure 93: Row Data Level Slider

Note:
If there is more than one field selected in Columns, a Column slider is also
displayed. Select the field, across all fields, which must be used to generate pies.

5. Hover the mouse over the pie and view the tool-tip.

Figure 94: Tool-tip

6. In the Format Visualization panel, provide the information, and enable or disable
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the toggles in the Title and Labels sections.

Figure 95: Format Visualization

7. In the Legend section, use the Position dropdown menu and select the position of
the legend display. By default, the position is Bottom, which displays the legend
below the pie. The legend can also be displayed at the top, left, and right. You may
also choose not to display the legend.

8. Go to Appearance settings. Click the color picker to select Background Colors and
Series Colors. JasperReports Server reloads the Ad Hoc view's pie with the new
display settings.
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Figure 96: Appearance Settings

Changing the Chart's Appearance Using Advanced
Formatting
The Advanced settings in the Format Visualization panel gives you more control over the
appearance of an Ad Hoc chart by allowing you to edit certain chart properties. For
example, you can specify a list of colors for the chart, change the position of the legend,
choose whether to display data values in the chart, and much more. You can find a full list
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of supported commands by clicking the More Information link on the Advanced tab or
browsing to the Advanced Chart Formatting page on the Jaspersoft Community Site.

To edit the chart's properties

1. In the Format Visualization panel, go to the Advanced settings.

2. Click Add property.

3. In the Name field, enter the chart property you want to format and then enter the
values for the property. For instance:

l To format the chart's colors, enter colors for the property and a comma-
separated list of colors in brackets for the values, such as ["red", "blue",
"green", "magenta", "purple", "black", "yellow"].

l To change the vertical alignment of the legend, enter legend.verticalAlign for
the property and "top" or "bottom" or "center" for the value.

l To display data values on the chart, enter
plotOptions.series.dataLabels.enabled for the property and true for the value.
Click the More Information link to see a list of the properties you can edit.

Note:
The Ad Hoc Designer does not validate the property name or values. The
chart ignores any invalid property that you enter.

4. Click to save the property formatting.

The chart is updated with the new formatting.

5. To remove the formatting, click next to the property you want to remove.

Interacting with Charts
Once you have chosen rows and columns and selected the type of chart that you want, you
can further explore your data using interactive features such as brushing an area of the
chart to zoom in or clicking a legend to hide the members of a group.

http://community.jaspersoft.com/wiki/advanced-chart-formatting
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Zooming
Zooming lets you view a specific area of a chart more closely. Zooming is helpful when
labels at the bottom of a chart are difficult to read. This is because only the labels
corresponding to the selected area are displayed.

Zoom is a viewing feature of the Ad Hoc Editor. When you save an Ad Hoc view, or create a report
from an Ad Hoc view, zoom is automatically reset to show the whole chart.

To zoom in on an area of a chart

• Click and drag or brush the area you want to zoom in on. As you are dragging or
brushing a pale blue area indicates your selection. When you release the mouse
button, the view zooms in on the area you selected.

To view the whole chart again

• Click Reset zoom at the upper right of the canvas.

The following images show a bar chart before and after zooming:

Figure 97: Selecting a Zoom Area
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Figure 98: Area After Zooming

Hiding Group Members
Use the legends below the chart to hide or show group members.

• To hide a group member, click the member name in the legend below the chart. The
member is removed from the chart and the legend is grayed out.

• To unhide a group member that has been hidden, click the grayed-out legend for
the member.

Figure 99: Hiding a Group Member

Hidden members are a view feature of the Ad Hoc Editor. When you save an Ad Hoc view, or
create a report from an Ad Hoc view, the chart is automatically reset to show all members.
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Using Drill Down
Use drill down to move from a higher level of data to a granular level. Click a data point in
a chart that contains hierarchical data to view detailed data. You can view the data at
different levels of detail using drill down. The hierarchy for drill down is based on the order
of elements in Rows and/or Columns.

To use drill down, in the Drill Down section, enable the toggle. When enabled the level of
the visualization changes to the first data point in the drill down axis and the slider of the
axis is disabled.

Figure 100: Enable Drill Down

Drill down is an interactive viewer feature and the current path of drill down is not saved in
the Ad Hoc View resource. Whenever an Ad Hoc View is open in the viewer or designer, the
visualization starts from the first level of data point in the drill down axis.

Currently, only the fields in the Row axis are supported for drill down. If there are fields in
the Column axis too, they do not participate in the drill down.

Charts that do not support drill down include:

• Time Series (all four charts in the group)

• Dual Level Pie

• Gauge (all three charts in the group as all fields are in the column axis)

• Range (all five charts in the group)

• Tree Map and Parent Tree Map (has built-in drill down)
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For Tree Map and Parent Tree Map, the Back button is replaced with breadcrumbs. This helps
you to navigate from one data point to another easily.

When drill down is enabled, the legend of the chart displays only the values of the current
level of the drill down hierarchy.

Any changes to adhoc resets drill down to its initial state.

Working with Standard Crosstabs
This section describes crosstabs based on Topics and Domains. For information about crosstabs
based on OLAP connections, refer to Working with OLAP Connection-based Crosstabs and
Working with Topics.

Crosstabs have different data, layout, and format options than tables or charts.

Figure 101: Ad Hoc Editor’s Standard Crosstab View

If you selected Crosstab when you created a view, as described in Ad Hoc View Types, the
following sections explain tasks specific to your crosstab development.
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Using Fields in Crosstabs
Fields can be added to crosstabs as row groups or column groups. Measures can be added
to crosstab rows or columns as well, but all measures must be included as either a row or
a column. This means that you can add one or more measures as columns, or add one or
more measures as rows, but you cannot have one measure as a column and another as a
row in the same crosstab.

Crosstab Rows and Columns
When creating a crosstab view, keep in mind that row and column groups are arranged in
hierarchies. Drag the group headings to rearrange the hierarchy; you can also right-click a
heading and select a Move option from the context menu or press the cursor keys.
Rearranging the groups may change the preview data in the editor.

To add a field or measure to a crosstab group

Procedure
1. In the Data Source Selection panel, click to select the fields you want to add to the

crosstab as a group. Use Ctrl-click to select multiple items.

2. Drag your selection into the Columns or Rows box in the Layout Band.

Crosstab Measures
Measure labels are displayed in the crosstab based on their status as a row or column:

l Measures included as rows appear in the crosstab below the Measures heading.

l Measures included as columns appear in the crosstab to the right of the Measures
heading.

You can right-click a measure in the crosstab to open a context menu that provides these
options:

l Change Summary Calculation
l Change Time Balance Calculation
l Change Data Format
l Remove From Crosstab
l Create Filter
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l Move Up or Move Down or Move Left or Move Right

Measures are arranged in cells. You can add any number of measures. All the measures
appear together in every cell. To rearrange the measures, drag them in the measure label
area.

Pivoting
You can pivot a crosstab in two ways:

• Pivot the entire crosstab by clicking . The row and column groups for switching
places. For more information, see Creating a View from a Domain.

• Pivot a single group:

• To pivot a single row group, right-click it and select Switch To Column Group.

• To pivot a single column group, right-click it and select Switch To Row Group.

Pivoting removes any custom sorting applied to headings in your crosstab. It does not affect
column or row sorts.

Slicing
The slice feature lets you keep or exclude group members in a crosstab. To slice, right-click
a group member and select:

l Keep Only to remove all groups except the selected one from the crosstab.

l Exclude to remove this group from the crosstab.

Use Ctrl-click and Shift-click to select multiple groups to keep or exclude.

You can select multiple row groups or multiple column groups; you cannot slice by both row groups
and column groups at once. Compare slice to drill-through, drill to details, and filtering.

For more information about filtering, see Using Filters and Input Controls.

Summarizing
All row and column groups are summarized automatically:
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• To turn off a group summary, right-click any heading in the group and select Delete
Row Summary or Delete Column Summary from the context menu. To reapply the
summary, right-click the heading and select Add Row Summary or Add Column
Summary.

The Delete Summary option is available only for the outermost group on either axis (that is, either
the outermost row group or the outermost column group)

• To select the summary function and data format for a measure, right-click the
measure label and select from the context menu. Note that you cannot change the
summary function on custom fields that calculate percents (Percent of Total,
Percent of Column Group Parent, and Percent of Row Group Parent).

• The summary functions for numeric fields are Sum, Average, Maximum, Minimum,
Distinct Count, and Count All. Distinct Count is the number of different items in the
row or column. Count All is the total number of items. For instance, if there are 3
widgets of type A and 3 widgets of type B, Distinct Count is 2 and Count All is 6.

Collapsing and Expanding Members
By default, the editor displays each row and column group of a crosstab in a collapsed
state. This means you can see the totals for the group, but not the measures for its
individual members. To see measures for a group’s members, right-click the group label
and select Expand Members.

When a group’s members are expanded, select Collapse Members from the same menu to
hide the measures. Collapsing an outer group also collapses its inner groups. The Expand
Members and Collapse Members options are available only for outermost groups, or for
inner groups nested in an expanded outer group.

When you collapse a group, its summary is automatically displayed. This prevents invalid
crosstab layouts in which there is nothing to display for some totals if the summary has
been deleted previously.

Merging and Unmerging Crosstab Cells
By default, the editor merges cells containing the same data into a larger, single cell to
make the crosstab data easier to read.



JasperReports® Server User Guide

220 | Working with the Ad Hoc Editor

To display all of the individual cells in the crosstab instead of merged cells, in the Format
Visualization panel, in the Appearance settings, click the Merge cells switch to turn the
setting off.

To merge the crosstab cells, click the Merge cells switch to turn the setting on.

Sorting
By default, the rows and columns of crosstabs are sorted in alphabetical order of the group
names.

To sort your crosstab

l Right-click the heading that you want to use for sorting and select one of these
options:

o Sort Ascending

o Sort Descending

o Don't Sort
The crosstab is updated to reflect your sorting option. A blue dot appears in
the context menu next to the currently applied sort option.

When the crosstab includes more than one row group or more than one column group, the
inner groups are also sorted according to your selection. Only one measure can be used for
sorting at any one time. Changing the sort order for another measure resets all others to
the default.

To filter top or bottom N values

You can filter the numeric data shown in a crosstab to show only the rows with the top or
bottom N values, where N is a number that you specify. For example, you can filter a
crosstab to display only the top 10 values in a column.

Procedure
1. Right-click the heading that you want to use for filtering and select one of these

options:

l Filter Top N Values

l Filter Bottom N Values
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l Don't Filter Values

2. Enter the number of values that you want to show in the crosstab.

3. Select whether to show an aggregate of the unranked values in the crosstab.

4. Select whether to apply the filter across all row groups.

5. Click OK.

The crosstab is updated to reflect your filter option. The icon appears in the
heading when filtering a column for the top N values, while the icon appears
when filtering for the bottom N values. A blue dot appears in the context menu next
to the currently applied filter option. Only one measure can be used for filtering at
any one time. Changing the filtering or sort order for another measure resets the
filtered column.

Changing How Totals Are Calculated Using Time Balance
By default, crosstabs show the Totals of numeric values as the sum of the values in a
column. For example, if the crosstab view displays product sales grouped by month, the
crosstab displays the total sum sold during those months as the Totals value.

You can change the data that the crosstab displays as the Totals value for time using the
Time Balance options. These options allow you to change the Totals to display the first and
last numeric values for the period. For example, if you want to see the number of products
left in your inventory at the end of a certain time period, use the Time Balance Last option
and the Totals fields displays the last numeric value entered for the time period. If you
want to see the number of products in your inventory at the beginning of the time period,
use the Time Balance First option.

Changing the time balance calculation requires the crosstab to use the Date field. You cannot drill
through the data when using a Time Balance option other than the default or when using Day of
Week for the grouping.

To change the total calculation using the time balance

Procedure
1. In the Ad Hoc view, right-click the column or row header.

2. Select Change Time Balance from the context menu.
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3. Select the option that you want to use. You can select one of the following:

l Time Balance Default. This option displays the sum of all the numeric data for a
period of time as the Total value.

l Time Balance First. This option displays the first numeric value for a period of
time as the Total value. For example, if the period of time is a month, the
crosstab displays the first numeric value entered for the month.

l Time Balance Last. The option displays the last numeric value for a period of
time as the Total value. For example, if the period of time is a month, the
crosstab displays the last numeric value entered for the month.

The crosstab is updated to show the new Total values.

Changing the Data Format
You can change the formatting for rows and columns containing numeric data, such as
dates and monetary amounts. By default, non-integer fields use the -1,234.56 data format;
integers use -1234.

To change the data format for a column

1. In the Ad Hoc view, right-click the column or row header.

2. Select Change Data Format from the context menu.

3. Select the format that you want to use. These options vary depending on the type of
numeric data contained in the column.
The data in the column or row now appears in the new format.

Resizing and Layout
Many of the layout and formatting options that are set manually in tables are set
automatically in crosstabs. In particular, row and column sizes are fixed and no spacer is
available.
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Drilling Through Data
Drill-through functionality is available for crosstab data. A drill-through table displays the
supporting details for the selected roll-up value.

To view the drill-through table for a value in your crosstab

l Click hyperlinked data to display additional columns from that specific fact data.

By default, the drill-through table opens in its own window or tab, depending on your
browser settings.

Working with OLAP Connection-based
Crosstabs
An OLAP connection is a definition for retrieving OLAP data for use in Ad Hoc views and
reports. An OLAP connection is either a direct Java connection (Mondrian connection) or an
XML-based API connection (XML/A connection). You must create OLAP client connections in
order to use this functionality, which may be restricted by your license. For more
information on creating OLAP client connections, as well as other administrative tasks
regarding OLAP, refer to the Jaspersoft OLAP User Guide.

The Ad Hoc Editor displays a more focused tool bar when your Ad Hoc view is based on an
OLAP connection. It contains a subset of the options available in the standard tool bar,
including Display Mode, Redo, Undo All, Switch Group, Display Options, and View MDX
Query. For a description of these options, see Ad Hoc Editor Tool Bar Icons.
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Figure 102: Ad Hoc Editor’s OLAP Connection-based Crosstab View

Dimensions and Measures
When you create a view based on an OLAP connection, the cube metadata defined in the
connection’s OLAP schema is automatically applied to your data: the dimensions and
measures in the cube are shown in the Data Source Selection panel.

Dimensions and measures describe your data in terms of these organizing principles and
facts:

• Dimension: A categorization of the data in a cube. For example, a cube that stores
data about sales figures might include dimensions such as time, product, region,
and customer’s industry. A dimension is a hierarchical series of relationships in
which each level has a parent and may also have children. Note that a level is a
particular location within the dimension, whereas a member is a specific data
element at a particular level. For example, if the dimension is Geography, then one
of its levels might be Country; at the Country level, USA might be a member.

Some dimensions include a special level at the top of the hierarchy that includes
every level in the dimension. This All member is used to display the summarized
data across the dimension. The All member of dimensions is a common feature in
many OLAP solutions.

• Measure: A field that displays the facts that constitute the quantitative data in a
cube. For example, a cube that stores data about sales figures might include
measures such as unit sales, store sales revenue, and store sales cost.
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The items in the Dimensions section of the Data Source Selection panel may appear in a
multi-level tree structure. You can add the entire dimension tree, or any sub-trees, to your
crosstab by dragging the top-level name into the Layout Band. Individual items can be
added to the crosstab in the same manner.

Items in the Measures section are organized into a single-level list. Any calculated
measures are indicated by a calculation icon .

When working with OLAP connections, the Layout Band at the top of the Ad Hoc View
panel allows you to drag and drop dimensions and measures into the crosstab. As you add
columns and rows, the crosstab automatically builds on the panel. In the Columns and
Rows fields, each item in your crosstab is represented as a token; drag tokens left and right
to change their position on an axis or drag them between the fields to pivot them.

The cube metadata applied to your view provides structure to your crosstab: you can add a
dimension with any number of levels, but it must follow the hierarchy defined in the cube.
For example, if a dimension’s levels are Country, State, and City, you can place any one of
them in the crosstab, but if you add two or more, their order (defined in the OLAP schema)
is enforced. For example:

Possible Impossible

Country, State, City State, Country, City

Country, City City, Country

State, City City, State

Country, State State, Country

In addition, you can’t mix members from different dimensions. For example, consider a
crosstab that includes both a Geography dimension (Country, State, and City) and a Time
dimension (Year, Quarter, and Month): you can’t insert the Year level between the Country
and State levels. The levels of each dimension are always kept together.

All measures in the crosstab must be either rows or columns. You can’t have measures on
both axes at the same time. To move measures between dimensions, right-click and select
Switch To Column Group or Switch To Row Group. All the measures move to the other axis.
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Drilling Through Data
Drill-through functionality is available for crosstab data. A drill-through table displays the
supporting details for the selected roll-up value.

To view the drill-through table for a value in your crosstab

Procedure
1. Click hyperlinked data to display additional columns related to that information.

2. Use the page controls to navigate the table.

The drill-through table opens in its own window or tab, depending on your browser
settings.

Sorting
Like standard crosstabs, the rows and columns of an OLAP crosstab are sorted in
alphabetical order of the group names.

To change the sorting of your OLAP crosstab

• Right-click the heading you want to use for sorting and select one of these options:
• Sort Ascending
• Sort Descending
• Don't Sort

The crosstab is updated to reflect your sorting option. A blue dot appears in the
context menu next to the currently applied sort option.

When the crosstab includes more than one row group or more than one column group, the
inner groups are also sorted according to your selection. Only one measure can be used for
sorting at any one time; changing the sort order for another measure resets all others to
the default.

Viewing the MDX Query
You may want to view the MDX query created for the OLAP connection used with your
crosstab, to verify what data users are hitting. If this option is enabled, you can do this in
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the Ad Hoc Editor with the View Query button.

The query is read-only, but can be copied to a document for review.

To view the MDX query

l In the tool bar, click . The View Query window opens, displaying the query.

Working with Microsoft SSAS
The Ad Hoc Editor allows you to view data from Microsoft SQL Server Analytical Services
(SSAS) to populate views and reports with multi-dimensional OLAP data. XML/A
connections that point to your SSAS data are listed with the other OLAP connections when
you create an Ad Hoc view, as in the following chart example.
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Figure 103: Search Results Listing

For details, refer to the Jaspersoft OLAP User Guide.

Calculated Fields and Measures
You can create new fields or measures in an Ad Hoc view by applying formulas to a view’s
existing fields and measures. For example, consider a view that includes both a Cost and a
Revenue field. You could calculate the profit for each record by creating a custom field that
subtracts the Cost field from the Revenue field. For example, you can divide the Profit



JasperReports® Server User Guide

229 | Working with the Ad Hoc Editor

custom field in the previous example by the Revenue field to express each record’s margin
as a percent.

If you have installed the samples, the Ad Hoc view 10. Calculated Fields and Measures
includes examples of calculated fields (shown by the icon ) or calculated measures
(shown by the icon ). You can explore their formulas by right-clicking the field or
measure name and selecting Edit. You can also create tables, charts, or crosstabs to see
how these calculations work in views.

Overview of the Calculated Fields Dialog
The Calculated Field or Calculated Measures dialog creates a calculated field or measure
and set its summary function. This section describes the functionality available in this
dialog.

To open the calculated fields dialog for Ad Hoc views

Procedure
1. Create or open an Ad Hoc view.

2. Open the calculated fields dialog using one of these methods:

l Click at the top right of either the Fields section or the Measures section of the
Data Source Selection panel and select Create Calculated Field... from the
context menu.

l Right-click on an existing calculated field (shown by the icon ) or calculated
measure (shown by the icon ) and select Edit.

The dialog displays a text field for the name and two tabs, Formula Builder and
Summary.

The following are reserved words and cannot be used as field names: AND, And, and, IN, In, in,
NOT, Not, not, OR, Or, or. Names containing these strings, such as "Not Available", can be used.

The Formula Builder Tab
The Formula Builder tab is where you create the formula for your calculated field or
measure. This tab includes the following:
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l Formula entry box - Shows the current formula for calculating your field or measure.
You can edit the formula by typing directly in the panel. You can also add Fields,
Measures, and Functions by double-clicking them. Click the buttons below the
Formula field to add operators. Formulas must use the following syntax: 

a. Labels for fields and measures must be in double quotes ("): "Customer ID",
"Date ordered".

b. Text must be in single quotes ('): '--'.

c. Levels must be in single quotes ('): 'ColumnGroup', 'Total'. See Levels in
Aggregate Functions for more information about levels.
For more information on syntax, see Calculated Field Syntax.

l Operator buttons - Click these buttons to insert the operator in the Formula entry
box. For more information on operators, see Operators in Ad Hoc Views

l Fields and Measures - Lists all the fields and measures currently in your Ad Hoc view,
including any calculated fields or measures you have already created.

Note:
Hovering over a field or measure displays additional information in a tool
tip. This information includes the data type of the field or measure, its
description if any is given in the Domain, and its default summary function
if applicable. Use this information to choose the appropriate field or
measure, and to use it correctly in the formula.

l The tooltip content includes:

o Field Path (for example: Sales > Stores > Regions > City) for Domain-based Ad
Hoc

o Original name (from the domains)

o Formula (for previously created calculated fields only)

o Field type (Field, Measure, Calculated Field, Calculated Measure)

l Functions - Lists all the available functions that you can use in your formula. For
more information, see Calculated Field Reference.

l Function Description panel - Gives a brief description of the function selected in the
Functions list, if any. The sample inputs are intended to be as descriptive as possible.
See Calculated Field Reference for the precise syntax that each function requires.
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l Show arguments in formula checkbox - When this checkbox is selected, double-
clicking a function name in the Functions list adds the full description to the Formula
entry box. When the checkbox is not selected, double-clicking a function name adds
only the function. For example, double-clicking Round adds Round
("NumberFieldName", Integer) when the checkbox is selected, and adds Round()
when the checkbox is not selected. If you select this checkbox, you can double-click a
string, such as NumberFieldName, and then replace it by double-clicking a name in
the Fields and Measures list.

l Validate button - Checks the formula for syntax errors, such as missing parentheses
or quotes. Your calculated field or measure must be valid before you can create it.
Syntax validation does not guarantee that your formula gives the results you want.

The Summary Tab
Summaries show a result applied to all data values. For example, for a numeric field such
as Cost, the summary value might be the sum of all the costs; for a text field such as
Customer Name, the summary value might be the count of all customers. The Summary
tab sets the default summary function for your calculated field or measure.

l Calculation list - Displays allowed summary functions for your calculated field or
measure. The available options depend on the data type of the calculation. See
Summary Calculations for more information. Depending on your selection, you may
see additional options:

o Custom selection - Displays the same options available in the Formula Builder
tab, including the Formula entry box, operator buttons, Fields and Measures
list, Functions list, and Validate button. You can use these options to build a
formula for your custom summary. However, for summaries, you are limited to
aggregate functions, that is, functions that operate on all the values in your
field. For example, Sum and Mode are valid summary functions, because they
use all available field values to get a result. Round is not a valid summary
function, because it operates on a single value at a time. See Summary
Calculations for more information.

o Weighted Average - Displays a Weighted On dropdown list, which allows you to
choose another field or measure to use as the weight for the average.
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Creating a Calculated Field

To create a calculated field

Procedure
1. First, create the Ad Hoc view to use. To do this, select Create > Ad Hoc View from the

menu. The Select Data wizard appears.

2. Click and navigate to Domains.

3. Select Supermart Domain. Click Choose Data. The Data Chooser window appears.

4. In the Data Chooser window, double-click Sales to select it and click OK. A new Ad
Hoc view opens.

5. In the Ad Hoc view, click at the top right of the Fields section and select Create
Calculated Field... from the context menu. The New Calculated Field dialog box
appears, displaying the Formula Builder.
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Figure 104: Formula Builder Tab in New Calculated Measure Dialog Box

6. Enter Volume Tier for the Field Name.

Creating the formula

This section shows how to create a simple text formula that says Low when the Unit
Sales amount is under 100 and High otherwise.

Formulas must use the following syntax:

a. Labels for fields and measures must be in double quotes ("): "Customer ID",
"Date ordered".

b. Text must be in single quotes ('): '--'.

c. Levels must be in single quotes ('): 'ColumnGroup', 'Total'.

7. Make sure Show arguments in formula is selected.

8. Now create the formula. Double-click IF() in the Functions list.
Because Show arguments in formula is selected, IF("BooleanFieldName", TrueCalc,
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FalseCalc) is entered in the Formula Builder.

9. Double-click BooleanFieldName to select it, then double-click Unit Sales 2013 in the
Fields and Measures list.
The Formula Builder displays IF("Unit Sales 2013", TrueCalc, FalseCalc).

10. Edit the expression in the Formula Builder to read as follows: IF("Unit Sales 2013" IN
(0:100), 'Low', 'High').

11. Click Validate to verify that the formula does not have any syntax errors.

Creating a summary calculation

The Ad Hoc Editor creates a default summary calculation based on the type of formula you
have entered. This section shows how to select a different summary function.

12. Click the Summary Calculation tab.

Figure 105: Summary Tab in New Calculated Measure Dialog Box

13. Select Mode from the Calculation menu.

14. Click Create Field.
The calculated field appears in bold text at the bottom of the list of available fields. A
special icon indicates it is a calculated field .

If you have installed the samples, the Ad Hoc view 10. Calculated Fields and Measures
includes examples of calculated fields and measures (indicated by ). You can explore
their formulas by right-clicking the field or measure name and selecting Edit. You can also
create tables, charts, or crosstabs to see how these calculations work in views.
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Planning and Testing Calculated Fields and
Measures
When you are creating calculated fields and measures, you may need to follow an iterative
process: first create your new fields and measures, then view the results, and finally adjust
as needed. The following practices can help:

l Reduce the size of your data set — To speed field creation and testing, reduce the
size of your working data set in the following ways:

o Select Sample Data from the drop-down menu in the Ad Hoc tool bar.

o Create one or more filters. This is especially useful for tables, which display all
data by default.

o Limit the number of fields and measures you add to your test reports to restrict
the number of summary levels to one or two.

l Create one or more formulas, as described in Creating a Calculated Field.

l After you have created your fields and measures, add them to a table or crosstab in
your view and verify that they behave as you expect. You may need to edit your fields
to get the desired behavior. See Creating a Calculated Field for more information.

In addition, keep the following in mind when creating calculated fields:

l When you create a calculated field, it appears at the bottom of the list.

l Calculated fields that use aggregate functions cannot be added to groups and should
not be used as filters.

l By default, the Ad Hoc Editor supports only two decimal places. If the calculated
fields return data that are significant to the third decimal place, you can add new
masking options by editing configuration files. For more information, refer to the
JasperReports Server Administrator Guide.

l You can’t delete a calculated field that is in use; these fields have their name in
italics.

o If the calculated field is used in the Ad Hoc view panel, remove the calculated
field from the Ad Hoc View panel and then delete it from the Data Source
Selection panel.

o If the calculated field is the basis of another field, you can’t delete it until you
delete the one that builds on it.
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o If the calculated field uses an item that was removed from the data source, the
Ad Hoc Editor displays an error message. You will need to either edit or delete
the calculated field.

Calculated Field Reference
This section lists all functions that can be used to create calculated fields and measures in
Ad Hoc views. For details of the supported syntax, see Calculated Field Syntax.

These functions are available for calculated fields and measures in Ad Hoc views only. See
JasperReports Server Data Management Using Domains for supported operators and functions in
Domains.

The examples in this section indicate correct syntax, but are not necessarily associated
with an Ad Hoc view. If you have installed the Jaspersoft samples, the Ad Hoc view 10.
Calculated Fields and Measures include examples of calculated fields (shown by the icon )
or calculated measures (shown by the icon ). You can explore their formulas by right-
clicking on the field or measure name and selecting Edit. You can also create tables,
charts, or crosstabs to see how these calculations work in views.

Absolute(NumericExpression)
Returns the absolute value of a number or field, that is, the non-negative value of the
number.

Examples:

Absolute("Transaction Amount") — Shows the magnitude of each transaction, regardless
of whether the transaction is positive or negative.

"Commission Rate" * Absolute("Transaction Amount") — Computes a positive
commission on all transactions, regardless of whether the transaction is positive or
negative.

Attribute('StringExpression1', ['StringExpression2' ])
Given the name of an attribute as the first argument and an optional category as the
second argument, returns the attribute's current value as a String. If a category is specified
(USER, TENANT, or SERVER), returns a categorical attribute, otherwise returns a hierarchical
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attribute. This value can be cast to a different datatype using one of the casting functions
available in Ad Hoc: Boolean(), Date(), Decimal(), Integer(), Time(), or Timestamp(). It
is your responsibility to ensure the attribute's format and values work correctly with your
Ad Hoc view. See the JasperReports Server Administrator Guide for more information about
creating and using attributes.

Example:

Attribute('my_attribute')

Average(NumericExpression[,'Level'])
Returns the average value of a measure or numeric field, based on an optional level. Null
values are not included. See Levels in Aggregate Functions for more information.

Example:

Average("Salary", 'RowGroup')

Boolean ('StringExpression')

Casting function that takes a String expression and converts it to a Boolean data type. The
String can be any expression that returns a supported string, including a field value or an
attribute retrieved with the Attribute() function. The Boolean() function requires one of
the following Strings: true, false, True, False, TRUE, or FALSE. Other Strings will return an
error.

Examples:

Boolean('true')

Boolean(Attribute('my_boolean_attribute'))

Case(Expression, ValueExpression1, ReturnExpression1,
ValueExpression2, ReturnExpression2[,..., ValueExpressionN,
ReturnExpressionN][,DefaultReturnExpression])

Takes 2N+1 or 2N+2 arguments: an expression followed by one or more value
expression/return expression pairs, with an optional final return expression. Compares the
expression in the first argument to each value expression in order of appearance. Returns
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the value of the expression immediately following the first value expression that matches.
If no expression matches, returns the final DefaultReturnExpression if present, null
otherwise.

The types of all the return expressions must be compatible. For example, you cannot mix
numeric and text return value types.

Example:

Case("Shipped by", 1, 'FedEx', 2, 'UPS', 3, 'USPS', 'Unknown')

CaseRange (NumericExpressionInput, NumericExpression1,
ReturnExpression1, NumericExpression2, ReturnExpression2[,...,
NumericExpressionN, ReturnExpressionN][,DefaultReturnExpression])

Takes 2N+1 or 2N+2 arguments: an expression followed by one or more numeric
expression/return expression pairs, with an optional final return expression. Finds the first
numeric expression that is greater than the input expression and returns the value of the
corresponding return expression. If no expression is greater, returns the final
DefaultReturnExpression if present, null otherwise.

The types of all the return expressions must be compatible. For example, you cannot mix
numeric and text return value types.

Examples:

Case("Temperature", 60, 'too cold', 80, 'just right', 'too hot')

CaseRange(CountAll("Shipping charge") % CountAll("Shipping charge", 'Total'),
2.0, 'Less than 2%', 5.0, '2% - 5%', 'More than 5%')

CaseWhen(BooleanExpression1, ReturnExpression1,
BooleanExpression2, ReturnExpression2[,..., BooleanExpressionN,
ReturnExpressionN][, DefaultReturnExpression])

Takes 2N or 2N+1 arguments: one or more pairs of Boolean expressions followed by return
expressions, with an optional final return expression. Returns the expression immediately
following the first true Boolean expression. If no expression is true, returns the final
DefaultReturnExpression if present, null otherwise. This is the most flexible construct.
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The types of all the return expressions must be compatible. For example, you cannot mix
numeric and text return value types.

Examples:

CaseWhen("Shipped by" == 1, 'FedEx', "Shipped by" == 2, 'UPS', "Shipped by"==
3, 'USPS', 'Unknown')

Case("Temperature" <= 60, 'too cold', "Temperature" > 80, 'too hot', 'just
right')

Concatenate(TextExpression1[ ,TextExpression2,...,TextExpressionN])

Combines multiple text strings and/or fields into a single text field. Text strings are
enclosed in single quotes; labels for fields or measures in Ad Hoc are enclosed in straight
quotes.

Examples:

Concatenate("Last Name", ' , ', "First Name")

Concatenate("Product Category", ' -- ', "Product Name")

Contains(TextExpression1 ,TextExpression2])

A boolean that returns true if the first string contains the second, false otherwise.

Example:

Contains("Product Name", 'Soda')

CountAll(Expression[,'Level')]
Returns the count of non-null items in a field or measure. Note that CountAll always
returns a non-negative integer. Level can be one of the following: Current (default),
ColumnGroup, ColumnTotal, RowGroup, RowTotal, Total. See Levels in Aggregate Functions
for more information.

Example:

CountAll("Transaction Amount", 'RowGroup') — Counts the total number of non-null
transactions in the specified group.
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CountDistinct(Expression[,'Level'])
Returns the distinct count of non-null items in the input. Always returns a non-negative
integer. Level can be one of the following: Current (default), ColumnGroup, ColumnTotal,
RowGroup, RowTotal, Total. See Levels in Aggregate Functions for more information.

Example:

CountDistinct("Customer Name", 'Total') — Counts the number of distinct customers.

Date('StringExpression')

Casting function that takes a String expression and converts it to a Date data type. The
String can be any expression that returns a supported string, including a field value or an
attribute retrieved with the Attribute() function. The Date() function requires a String
value formatted as 'yyyy-MM-dd'. Other Strings will return an error.

Examples:

Date('2015-07-17')

Date(Attribute('my__date_attribute'))

Decimal('StringExpression')

Casting function that takes a String expression and converts it to a Decimal data type. The
String can be any expression that returns a supported string, including a field value or an
attribute retrieved with the Attribute() function. The Decimal() function requires a String
value in decimal format, for example, '123.45'. Other Strings will return an error.

Example:

Decimal('1234.567')

DayName (DateExpression)

Given a date field, returns a text field with the name of the day of the week.

Examples:

DayName("Open Date") - Displays the day of the week on which a store was opened.
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Mode(DayName("Open Date"), 'Total') - The day of the week on which the most stores
were opened.

DayNumber (DateExpression)

A numeric field that returns the day of the month from a date field.

Example:

DayNumber("Open Date") - Displays the day of the month on which a store was opened.

ElapsedDays (DateExpression1, DateExpression2)

Calculates the number of days elapsed between two date fields that contain time values.

Example:

ElapsedDays ("Date shipped","Date required")

ElapsedHours (DateTimeExpression1, DateTimeExpression2)

Calculates the number of hours elapsed between two date fields that contain time values.

Example:

ElapsedHours ("Date shipped","Date required")

ElapsedMinutes (DateTimeExpression1,DateTimeExpression2)

Calculates the number of minutes elapsed between two date fields that contain time
values.

Example:

ElapsedMinutes ("Date shipped","Date required")

ElapsedMonths (DateTimeExpression1,DateTimeExpression2)

Calculates the number of months elapsed between two date fields that contain time
values.
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Example:

ElapsedMonths ("Date shipped","Date required")

ElapsedQuarters (DateExpression1, DateExpression2)

Calculates the number of quarters elapsed between two date fields.

Example:

ElapsedQuarters ("Date shipped","Date required")

ElapsedSeconds (DateTimeExpression1,DateTimeExpression2)

Calculates the number of seconds elapsed between two date fields that contain time
values.

Example:

ElapsedSeconds ("Date shipped","Date required")

ElapsedSemis (DateExpression1,DateExpression2)

Calculates the number of semi-years elapsed between two date fields.

Example:

ElapsedSemis ("Date shipped","Date required")

ElapsedWeeks (DateExpression1,DateExpression2)

Calculates the number of weeks elapsed between two date fields that contain time values.

Example:

ElapsedWeeks ("Date shipped","Date required")

This replaces the two-date custom field operation Date Difference > Weeks available in Ad Hoc
views created in Server 5.5 or earlier.
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ElapsedYears (DateExpression1,DateExpression2)

Calculates the number of years between two date fields.

Example:

ElapsedYears ("Date shipped","Date required")

EndsWith(TextExpression1, TextExpression2]

Boolean that returns true if the first text input ends with the string specified in the second
input; false otherwise.

Example:

EndsWith("Product Name", 's')

IF (BooleanExpression, ExpressionWhenTrue[, ExpressionWhenFalse])

Given a Boolean field or calculation as the first argument, returns the second argument if
true, optionally returns the third argument if false. Returns null if the first argument is null.

ExpressionWhenFalse must be of the same type as ExpressionWhenTrue. For example, if
ExpressionWhenTrue is a date, ExpressionWhenFalse must be a date in the same format. If
ExpressionWhenFalse is not set, then a false result returns a null value.

You can create a BooleanExpression using the comparison operators(“==”, “!=”, “>”, “>=”, “<”,
“<=”); any functions that return Boolean values (StartsWith, EndsWith, IsNull, Contains) and
logical operators (and, or, not).

When dates are used in comparisons or the IF function, they must be the same type, (date only,
date/time, or time only). Make sure to use the correct modifier (d, ts, t) when using date constants
in comparisons.

Example:

IF(Contains("Product Name", 'Soda'), 'Yes', 'No') - Uses the Contains function to
see whether the product name contains the string "Soda". If it does, sets the field value to
Yes.
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Integer('StringExpression')

Casting function that takes a String expression and converts it to an Integer data type. The
String can be any expression that returns a supported string, including a field value or an
attribute retrieved with the Attribute() function. The Integer() function requires a String
value that can be read as an integer, such as '123'. Other Strings will return an error.

Examples:

Integer('123')

Integer(Attribute('my_integer_attribute'))

IsNull(Expression)

Boolean that returns true if the field value is null; false otherwise.

Example:

IsNull("First Name")

Length(TextExpression)

Given a text string, returns its length. Null values return null.

Example:

Length("First Name")

Max (NumericExpression|DateExpression[,'Level'])
Returns the maximum value reached by the specified field or calculation. Level can be one
of the following: Current (default), ColumnGroup, ColumnTotal, RowGroup, RowTotal, Total.
See Levels in Aggregate Functions for more information.

Example:

Max("Salary")
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Median (NumericExpression|DateExpression[,'Level'])
For an odd number of values, returns the middle value after all values are listed in order.
For an even number of values, returns the average of the middle two values. For example,
if a field has only five instances, with values {1,1,3,10,20}, the median is 3. Level can be
one of the following: Current (default), ColumnGroup, ColumnTotal, RowGroup, RowTotal,
Total. See Levels in Aggregate Functions for more information.

Example:

Median("Salary")

Mid (TextExpression,Integer1,Integer2)

Given a text string, returns the substring starting at Integer1 with length Integer2.

Example:

Mid("Phone", 1, 3) - Given an American phone number starting with a 3-digit area code,
extracts the area code.

Min (NumericExpression|DateExpression[,'Level'])
Returns the minimum value reached by the specified field or calculation based on an
optional level. Level can be one of the following: Current (default), ColumnGroup,
ColumnTotal, RowGroup, RowTotal, Total. See Levels in Aggregate Functions for more
information.

Example:

Min("Salary")

Mode (Expression[,'Level'])
Returns the most frequent value reached by the specified input, based on an optional level.
For example, if a field has only five instances with values {1,2,2,4,5}, the mode is 2. Level
can be one of the following: Current (default), ColumnGroup, ColumnTotal, RowGroup,
RowTotal, Total. See Levels in Aggregate Functions for more information.

Example:
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Mode (DayName ("Order Date",RowGroup)) - For each row group, returns the day of the
week on which the most orders were placed.

MonthName (DateExpression)

Returns a text field with the name of the month.

Example:

MonthName ("Order Date" )

MonthNumber (DateExpression)

Returns the number of the month, with January = 1 and December = 12. Null values return
null.

Example:

MonthNumber ("Order Date")

Now (StringExpression)

Returns the current value Date-Time with time zone. The time zone is picked from the
logged in user's time zone.

Offset Date and Time for Now Functions

Offset for Today() uses only the date. Offset works the same as Today() function - filter
ranges created with using Today() or Now() will remember Date-Time and time zone
during creation, and if another user with another time zone uses this range, then Date-
Time will be offset according to the Time Zone time difference.

When using the Elapsedhours calculation, the function Now(), which would return Date-Time,
needs to be used. The Today() function stays as is.

Example:

Offset for Today("")
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PercentOf (NumericExpression[,'Level'])
Returns the value as a percent of the total for the specified level. Null values are ignored.
Note that possible values for Level are ColumnGroup, ColumnTotal, RowGroup, RowTotal,
Total (default). See Levels in Aggregate Functions for more information.

PercentOf (NumericExpression, Total) replaces the custom field calculation Percent of Total
Group available in Ad Hoc views created in Server 5.5 or earlier.

Calculated fields using the PercentOf function should not be used as filters. If PercentOf is used as
a filter, then the total percent may not be 100.

Example:

PercentOf("")

PeriodOverPeriod (POP) (NumericExpression,

'AggregateFunctionName')

The ratio between last (previous) period and current period is described as:

AggregateFunction(CurrentValue) / AggregateFunction(PreviousValue) - 1
calculation for the specified field where AggregateFunction can be 'Sum', 'Average',
'CountAll', 'CountDistinct', 'Max', 'Median', 'Min', 'Mode', 'Range', 'StdDevP' (Standard
Deviation P) or 'StdDevS' (Standard Deviation S). CurrentValue and PreviousValue are row
values grouped by date field, where Previous is taken based on selected date categorizer:
year, month, quarter etc.

The PeriodOverPeriod function accepts NumericExpression and AggregateFunctionName as
string, and then performs calculations based on aggregate functions results.

Example:

PeriodOverPeriod("NumericExpression",'AggregateFunctionName')

You can only apply POP calculations on the measure field grouped by a date/timestamp field with
year/quarter by year/month by year categorizer. Also, these calculations only work for crosstabs
and charts. They do not work with tables. Specifically for charts, it is recommended to add the
date/timestamp field to both columns (with Year grouping) and rows (Quarter or Month grouping).
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PeriodToPeriod (PTP (NumericExpression,

'AggregateFunctionName')

The difference between last (previous) period and the current period can be described as:

AggregateFunction(CurrentValue) - AggregateFunction(PreviousValue) calculation
for the specified field where AggregateFunction can be 'Sum', 'Average', 'CountAll',
'CountDistinct', 'Max', 'Median', 'Min', 'Mode', 'Range', 'StdDevP' (Standard Deviation P) or
'StdDevS' (Standard Deviation S). CurrentValue and PreviousValue are row values grouped
by date field, where Previous is taken based on selected date categorizer: year, month,
quarter etc.

The PeriodToPeriod function accepts NumericExpression and AggregateFunctionName as
String, and then performs calculations based on aggregate functions results.

Example:

PeriodToPeriod("NumericExpression",'AggregateFunctionName')

You can only apply PTP calculations on the measure field grouped by a date/timestamp field with
year/quarter by year/month by year categorizer. Also, these calculations only work for crosstabs
and charts. They do not work with tables. Specifically for charts, it is recommended to add the
date/timestamp field to both columns (with Year grouping) and rows (Quarter or Month grouping).

Range (NumericExpression[,'Level'])
The difference between the largest and smallest values of the given input.

Example:

Range("Salary",'ColumnGroup')

Rank (NumericExpression)

Returns the position of each value relative to the other values after all the values are listed
in order. For example, the top ten in sales are the top ten in rank. Null values are ignored.

Example:

Rank("Store Sales")
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Round (NumericExpression[,Integer])

Rounds a number to a specified number of digits. Default is zero (0) digits. Decimal values
greater than 0.5 are rounded to the next largest whole number, and values less than 0.5
are rounded down.

Example:

Round("Sales")

StartsWith(TextExpression1, TextExpression2]

Boolean that returns true if the first text input starts with the string specified in the second
input; false otherwise.

Example:

StartsWith("Product Name", 'Q')

StdevP (NumericExpression[,'Level'])
Standard deviation is based on the entire population, taken over the values at the specified
(optional) level. Null values are excluded. Level can be one of the following: Current
(default), ColumnGroup, ColumnTotal, RowGroup, RowTotal, Total. See Levels in Aggregate
Functions for more information.

Example:

StdevP("Sales",'RowTotal')

StdevS (NumericExpression[,'Level'])
Standard deviation based on a sample, taken over the values at the specified level. Null
values are excluded. Level can be one of the following: Current (default), ColumnGroup,
ColumnTotal, RowGroup, RowTotal, Total. See Levels in Aggregate Functions for more
information.

Example:

StdevS("Sales",'RowTotal')
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Sum (NumericExpression[,'Level'])
The sum of all values in the range. Null values are excluded. Level can be one of the
following: Current (default), ColumnGroup, ColumnTotal, RowGroup, RowTotal, Total. See
Levels in Aggregate Functions for more information.

Example:

Sum("Sales",'RowGroup')

Time('StringExpression')

Casting function that takes a String expression in the format 'HH:mm:ss.SSS' and converts
it to a Time data type. The String can be any expression that returns a valid String,
including a field value or an attribute retrieved with the Attribute() function.

Examples:

Time('17:12:33:147')

Time(Attribute('my_time_attribute'))

Timestamp('StringExpression')

Casting function that takes a String expression in the format 'yyyy-MM-dd HH:mm:ss.SSS'
and converts it to a Timestamp data type. The String can be any expression that returns a
valid String, including a field value or an attribute retrieved with the Attribute() function.

Examples:

Timestamp('2015-07-17 17:12:33:147')

Timestamp(Attribute('my_timestamp_attribute'))

Today (Integer)

Calculates the date that is the specified number of days from the current system date.

Examples:

Today (0) - The current system date.

Today(1) - The day after the current system date.
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Today(-1) - The day before the current system date.

WeightedAverage (NumericExpression1,NumericExpression2,'Level')

Returns the weighted average for the first input weighted with respect to the second input,
calculated at an optional level. Null values are excluded. Level can be one of the following:
Current (default), ColumnGroup, ColumnTotal, RowGroup, RowTotal, Total. See Levels in
Aggregate Functions for more information.

Examples:

WeightedAverage ("Price","Units", 'Current') - The extended price based on the
number of units.

WeightedAverage ("Price","Units", 'RowGroup') - The sum of the extended price for all
units in the row group.

Year (DateExpression)

Given a date field, returns the year.

Example:

Year("Order Date" )

YearToDate (YTD) (NumericExpression, 'AggregateFunctionName')

Given a date field, returns an accumulated aggregated value from a specific start of the
fiscal year to the current date. The YearToDate function accepts NumericExpression and
AggregateFunctionName as string, and then performs calculations based on aggregate
functions results.

Available options for AggregateFunctionName: 'Sum', 'Average', 'CountAll', 'CountDistinct',
'Max', 'Median', 'Min', 'Mode', 'Range', 'StdDevP', and 'StdDevS'

You can start the year from a specific month, for example, if your fiscal year starts in July, you can
set this to July 1 instead of January 1. Then the first quarter of the year will be July 1 to September
30.



JasperReports® Server User Guide

252 | Working with the Ad Hoc Editor

Example:

YearToDate("NumericExpression",'AggregateFunctionName')

You can only apply YTD calculations on the measure field grouped by a date/timestamp field with
year/quarter by year/month by year categorizer. Also, these calculations only work for crosstabs
and charts. They do not work with tables. Specifically for charts, it is recommended to add the
date/timestamp field to both columns (with Year grouping) and rows (Quarter or Month grouping).

Calculated Field Syntax
This section describes the syntax required when creating calculated fields in Ad Hoc views.
See Calculated Field Reference for more information.

Use the following syntax for inputs:

• To reference a text string, use single quotes (') - 'Text String'.

• To reference a field label, use double quotes (") - "Ad Hoc Label".

• To reference date constants, indicate the date type as part of the syntax, as listed
below:

• To reference a date without time data (for example: yyyy-dd-mm), use d followed
by single quotes (') - d'2014-06-10'.

• To reference a date with day and time data (for example: yyyy-dd-mm hh:mm:ss)
use ts followed by single quotes (') - ts'2014-06-10 01:30:00'. If you use ts and
enter the date information only, the time is automatically set to 00:00:00.

• To reference a date with time data only (hh:mm:ss), use t followed by single
quotes (') - t'01:30:00'.

• To reference a date field label, use double quotes (") - "Ad Hoc Date Field Label".

The following are reserved words and cannot be used as field names: AND, And, and, IN, In, in,
NOT, Not, not, OR, Or, or. Names containing these strings, such as "Not Available", can be used.

When dates are used in comparisons or the IF function, they must be the same type, (date only,
date/time, or time only). Make sure to use the correct modifier (d, ts, t) when using date constants
in comparisons.

In the function descriptions for calculated fields in Calculated Field Reference, the
argument name describes the type of input the function accepts. For more information
about input types, see JasperReports Server Data Management Using Domains:
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• BooleanExpression - Any expression that takes on Boolean values, including the
label of a Boolean field or measure, a Boolean calculation, or a Boolean value.

You can create a BooleanExpression using the following: comparison operators (==, !=, >, >=, <,
<=, in); functions that return Boolean values (StartsWith, EndsWith, IsNull, Contains) and logical
functions (AND, OR, NOT).

• DateExpression - Any type of date or timestamp values, including the label of a date
field or measure, or a calculation that returns dates.

• DateTimeExpression - Date expressions that contain time values, including the label
of a date field or measure, or a calculation that returns dates. These values are also
known as timestamp values.

• Expression - Any valid date, date-time, numeric, or string expression.

• NumericExpression - Numeric values, including the label of a numeric field or
measure, or a calculation that returns numbers.

• TextExpression - Text values, including the label of a text field or measure, or a text
string.

• Level - For aggregate functions, specifies the set of values used to compute the
calculation. Possible values include Current (not available for PercentOf),
ColumnGroup, ColumnTotal, RowGroup, RowTotal, Total. See Levels in Aggregate
Functions for more information.

Operators in Ad Hoc Views
Ad Hoc views support the following operators in calculated fields. Operators are evaluated
in the order they are shown in the table:

Operator Syntax Description

multiply, divide i * j / k Arithmetic operators for numeric types only.

percent i % j Calculates i as a percent of j; numeric types
only.

add, subtract i + j - k Arithmetic operators for numeric types only.
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Operator Syntax Description

equal i == j Comparison operators for string, numeric, and
date types.

not equal i != j

less than i < j Comparison operators for numeric and date
types only.

less than or
equal

i <= j

greater than i > j

greater than or
equal

i >= j

IN set i IN
('apples','oranges')

Sets can be of any type.

IN range i IN (j:k) Ranges must be numeric or date types.

NOT NOT( i ) Boolean operators. Parentheses are required
for NOT.

AND i AND j AND k

OR i OR j OR k

parentheses () Used for grouping.

When dates are used in comparisons or IF functions, they must be the same type, (date only,
date/time, or time only). Make sure to use the correct modifier (d, ts, t) when using date constants
in comparisons.

The following reserved words cannot be used as field names: AND, And, and, IN, In, in, NOT, Not,
not, OR, Or, or. Names containing these strings, such as "Not Available", can be used.

Aggregate Functions
Aggregate functions in calculated fields perform calculations based on groups of rows,
rather than on single rows. For example, it doesn't make sense to use Sum or Average on a
single value; instead, you want to take the sum or average over a row or column group or
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over the total set. In many cases, aggregate functions in the Ad Hoc Editor are analogous
to SQL functions that can be used with the GROUP BY clause in a SELECT statement.

The aggregate functions are as follows:

Average Median Range WeightedAverage

CountAll Min StdDevP

CountDistinct Mode StdDevS

Max PercentOf Sum

Because aggregate functions already operate on groups, their use is restricted in the
following ways:

• You can use aggregate functions only in calculated measures; aggregates should not
be used to create non-measure fields.

• You cannot add an aggregate function to a group.

• You should not use an aggregate function as a filter.

• Only Aggregate Formula, Custom, or None are supported as summary calculations
for aggregate functions. Custom appears in the Change Summary right-click menu
only if you have defined a custom function in the Create Calculated Field dialog box.

• A calculated field will always be calculated in memory, if you have an aggregate
expression, and the calculated field itself also has an aggregate expression. It's no
longer necessary to set the inMemory setting to true.

Levels in Aggregate Functions
Many aggregate functions accept an optional level to specify the grouping of the aggregate.
A level used in an aggregate, must be enclosed in straight quotes ('), for example,
'RowGroup'.

The available levels are as follows:

• Current (default) — use the current value when at a looking at detail rows in a table
view.

• RowGroup — use the parent values from a row location.

• RowTotal — use the grand total value from a row location.

• ColumnGroup — use the parent values from a column location.
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• ColumnTotal — use the grand total value from a column location.

• Total — use the grand total value from a cross tab and the RowTotal from a Table.

The following example shows how RowGroup works with the PercentOf() function.

Setting up the Ad Hoc view

The examples in this section uses the Ad Hoc view created in Creating a Calculated Field.
The initial view for these examples can be set up as follows:

Procedure
1. Select Crosstab from the Visualization Selector.

2. Add Store Sales 2019 and Low Fat to the Columns entry bar.

3. Add Country and Store Type to the Rows Entry Bar.

4. To make the example clearer, the data has been restricted. To do this, create three
filters:

a. Expand Regions in the Fields Picker, right-click on Country, and select Create
Filter. In the Filters pane, set the filter to is one of then select Canada and USA.

b. Create a filter for Store Sales 2013. In the Filters pane, set the filter to is greater
than, and enter 19.70.

c. Right-click on Store Type and select Create Filter. In the Filters pane, set the
filter to is one of then select Deluxe Supermarket, Gourmet Supermarket, and
Mid-Size Grocery.
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Figure 106: Base Example for Levels

RowGroup example

To create the layout for this example:

Procedure
1. Click at the top right of the Measures section of the Data Source Selection panel and

select Create Calculated Measure... from the context menu.

2. In the Create Calculated Measure dialog box, enter Percent of Row Group for the
name, and enter PercentOf("Store Sales 2019",'RowGroup') in the Formula entry box.
Then click Create Measure.

3. Drag the measure you just created to the Columns bar, between Store Sales 2019 and
Low Fat.

The crosstab appears as shown in the following figure.
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Figure 107: Example for RowGroup

Look at the Low Fat values for "false" in the Canada group. The only non-null value under
Store Sales 2019 is in the first row, for Deluxe Supermarket. This value, 102.17, is 100% of
the row group total of 102.17 on the third line of the crosstab. This percentage is shown in
the "false" subcolumn of the Percent of Row Group column.

Compare this to the "true" entry under Store Sales for the same (first) row. There, the
value is 19.90, and the row group total is 39.65. The corresponding percentage shown in
the "true" sub-column of Percent of Row Group is 50.19%.

Summary Calculations
Summary calculations are aggregate functions used for sub-totals and totals. Summary
calculations can be set in the Domain Designer or in the Ad Hoc view.

• In Ad Hoc table views, each field can display a single summary calculation. The
summary calculation is automatically applied to all groups in the table. Summaries
appear at the bottom of each group, as well as at the bottom of the view. When a
new group is added, it includes a summary for each column.

• In crosstabs, each measure displays a summarized value. Summaries determine the
values of the Totals at the intersection of each row and column.

• In charts, the type of chart determines whether measures are summarized. If
summaries are used, they determine the size or location of the graphical elements
that represent your data.

For dual pie charts, the summary function for the field needs to be Sum or CountAll. Dual pie
charts with other summary functions may give unexpected results.
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In general, you can change the summary calculation of any measure. By default,
JasperReports Server summarizes fields of each datatype as shown in the following table.

Datatype Default Summary
Calculation

Description

Numeric Sum Displays the sum of all values in the set.

Date CountAll Displays the total number of values in the set.

String CountAll Displays the number of values in the set.

Boolean CountAll Displays the number of values in the set.

Aggregate Aggregate Formula For a calculated field that uses an aggregate
function, uses the same aggregate formula as the
summary.

Combined None For a calculated field that combines an aggregate
function with a non-aggregate function, the
summary calculation is null.

Default Summary Functions in Calculated Fields

Select from the following options to set a measure’s summary function in any type of view.

Function Meaning Available for….

Aggregate Formula For a calculation that uses an aggregate
function, uses the same aggregate
formula as the summary.

Aggregate

Average Displays the average of all values in the
set.

Numeric

CountAll Displays the number of rows in the set. Boolean, Date, Numeric, and
String

CountDistinct Displays the number of unique values in
the set.

Boolean, Date, Numeric, and
String
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Function Meaning Available for….

Custom Allows you to enter an aggregate
calculation for the summary. Only
available for calculated fields and
measures in the Ad Hoc Editor; not
available for Domains.

Aggregate, Date, Numeric

Maximum Displays the highest value in the set. Date, Numeric

Median Displays the median value of the set. Date, Numeric

Minimum Displays the lowest value in the set. Date, Numeric

Mode Displays the value that occurs most
frequently in the set.

Boolean, Date, Numeric, and
String

None The aggregate function is null; no
summary function is displayed.

Aggregate, Boolean, Date,
Numeric, and String

Range Displays the difference between the
minimum and maximum values of the
set.

Numeric

RangeDays Displays the difference in days between
the minimum and maximum values of
the set.

Date

RangeHours Displays the difference in hours
between the minimum and maximum
values of the set.

DateTime

RangeMinutes Displays the difference in minutes
between the minimum and maximum
values of the set.

DateTime

RangeMonths Displays the difference in months
between the minimum and maximum
values of the set.

Date
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Function Meaning Available for….

RangeQuarters Displays the difference in quarters
between the minimum and maximum
values of the set.

Date

RangeSemis Displays the difference in semi-annual
periods between the minimum and
maximum values of the set.

Date

RangeWeeks Displays the difference in weeks
between the minimum and maximum
values of the set.

Date

RangeYears Displays the difference in years between
the minimum and maximum values of
the set.

Date

Standard Deviation
P

Displays the standard deviation for the
population of the set.

Numeric

Standard Deviation
S

Displays the standard deviation on a
sample for the set.

Numeric

Sum Displays the grand total for the set. Numeric

WeightedAverage Displays the weighted average for the
set, based on a second numeric field or
expression. Only available for calculated
fields and measures in the Ad Hoc
Editor; not available for Domains.

Numeric

Note the following about summaries:

• If you select a summary calculation other than the default, that calculation is shown
in parentheses after the field name in the fields picker.

• In Ad Hoc views, you see special behavior when you create a calculated field or
measure with the following type of summary calculation:
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• If you create a Custom summary calculation for a field or measure, Custom is
available on the Change Summary Calculation menu for that field. It is not
available otherwise.

• If you create a WeightedAverage summary calculation for a field or measure,
WeightedAverage is available on the Change Summary Calculation menu for that
field. It is not available otherwise.

• You can remove summaries by setting the summary function to None.

• Only AggregateFormula, Custom, or None are supported as summary calculations for
aggregate functions. Custom only appears in the Change Summary right-click menu
if you have defined a custom function in the Create Calculated Field dialog box.

Using Filters and Input Controls
JRXML Topics, Domains, and OLAP connections use different mechanisms for screening the
data they return:

• JRXML Topics can contain Parametrized queries. The parameters can be mapped to
input controls that allow users to select the data they want to include.

• Domains (and Domain Topics) can be filtered by selecting fields in the Domain and
specifying comparison values. The filters can be configured for users to select the
data to include.

• Within the Domain design, filters based on conditions can also be defined; these
filters are not displayed in the Report Viewer when the report runs.

• OLAP connections rely on XML schemas to filter the data in an underlying
transactional database. Input controls are never generated directly from the OLAP
schema.

You can define filters in the Ad Hoc Editor regardless of whether you are working with data
from a Domain, Topic, or OLAP connection. Such filters can be helpful in improving the
view's initial performance by reducing the amount of data the view returns by default. For
more information, see Input Controls and Filters Availability. To prevent users from seeing
the full dataset, you can also use input controls in a JRXML Topic or filters defined in the
Domain design, which can be hidden from end users.

If you want to return different data to different users of the same view, define data-level
security based on a user roles and profile attributes. This is available for reports based on a
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Domain, Domain Topic, or OLAP client connection. For more information, refer to the
Jaspersoft OLAP User Guide.

Input controls and filters interact seamlessly. For example, you can create filters in an Ad
Hoc view that gets data from a JRXML Topic that includes input controls.

The server refreshes the editor against both the filters and the input controls. Because
some combinations of input controls and filters don’t return data, this can result in an
empty view.

If the result set is empty, check for an incompatible combination of filters and input controls, such as
a standard filter (set to Mexico against a Country field) and a Keep Only filter (set to Canada
against a Country field), or an incorrectly-defined advanced filter expression (data must meet all
criteria in multiple filters, rather than meeting criteria in a subset of those filters). See Custom
Filtering for information on advanced filter expressions.

In rare cases, filters can conflict with view parameters, and you’ll need to rename the field
causing the conflict by editing the JRXML file. Refer to the Jaspersoft Studio User Guide for
more information about editing JRXML files.

For more information about:

• JRXML Topics and input controls, see Adding Input Controls.

• Domain Topic filters, see Creating Topics from Domains.

• Localizing input control prompts and lists of values, see Localizing Reports.

Using Filters
Filters can be defined at three levels:

• In the Domain Designer.

• When creating a view from a Domain (with the Data Chooser).

• In the Ad Hoc Editor (even when the view is based on a JRXML Topic or OLAP
connection).

In this section, we discuss how to define filters in the Ad Hoc Editor. For information on
defining filters in the Domain Designer, see JasperReports Server Data Management Using
Domains. For information on defining filters in the Data Chooser, see The Pre-filters Page.

In addition, you can control how and what filters are applied to a field or fields by using
custom expressions. For more information, see Custom Filtering.
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To create a filter in the Ad Hoc Editor

Procedure
1. Right-click a field in the Data Source Selection panel and select Create Filter. A new

filter appears in the Filters panel. If the Filters panel was hidden, it appears when you
create a new filter.

If the results are empty and you do not understand why, check for an incompatible combination of

filters and input controls. Click to compare the input controls with the filters in the Filters panel.

2. Use the fields in the filter to change its value. Depending on the datatype of the field
you selected, the filter maybe multi-select, single-select, or text input.

3. Click and select Minimize All Filters or Maximize All Filters to toggle expansion of the
items in the filter.

4. Click and select Remove All Filters to remove the filters.

5. Click to hide the filter’s details. Click to display them again.

6. Click the Select All checkbox (if it appears in the Filters panel) to select all values
currently available in the dataset. The Select All checkbox does not appear in the
Filters panel for numbers and dates.

Note that the Select All checkbox does not guarantee that all values are selected
every time the report runs. Instead, the checkbox is a shortcut to help you quickly
select all the values currently available in the dataset. To ensure that all values
appear in the view whenever it is edited or a report is run, remove the filter entirely.
On the panel, you can also create a filter from the right-click context menu of a
column in a table. On the Chart tab, you must right-click the field in the Data Source
Selection panel.

When you change a filter, the server uses the filter's new value to determine what data to
display. If you change only the operator in a filter, you must deselect the value in that
filter, then reselect it to apply the updated filter.

For filters with multiple values, you do not need to reselect all values. After changing the
operator, use Ctrl-click to deselect just one of the values, then Ctrl-click to reselect that
value.
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Relative Dates
You can filter information in your view based on a date range relative to the current system
date. You can accomplish this using date-based filters, and entering a text expression
describing the relative date or date span you want to display, using the format
<Keyword>+/-<Number> where:

• Keyword: Indicates the time span that you want to use. Options include: DAY, WEEK,
MONTH, QUARTER, SEMI, and YEAR. An option used by itself (without +/-<Number>)
gives the current value for that option.

• + or - : Indicates whether the time span occurs before or after the chosen date.

• Number: Indicates the number of the above-mentioned time spans you want to
include in the filter.

For example, if you want to look at all Sales for the prior week, your expression would be:
WEEK-1.

To create a relative date filter

Procedure
1. Following the instructions in Using Filters, create a filter based on a date field. The

filter appears in the Filters panel.

2. In the filter’s first text entry box, enter an expression describing the relative date or
date span you want to display.

3. In the filter’s second text entry box, enter the date you want to base your filter on.

For instance, if you want to display all the sales numbers for one month before the
current date, enter MONTH-1 in the first text entry box, and enter today's date in the
second box.

When you right-click a group member in a crosstab and select Keep Only or Exclude, you create
complex filters. When you create a filter against an inner group, the filter that appears may be
created as a complex filter. You cannot edit a complex filter, but you can remove it. Complex filters
also appear in the Ad Hoc Editor if a Data Chooser filter was created and locked.

Custom Filtering
When you create multiple filters they are, by default, connected with an implicit AND
operator. That is, the data displayed in your table, chart, or crosstab is what remains after
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all your filters are applied.

However, with the custom filter functionality, you can exercise greater control over the
displayed data by applying a custom expression that includes more complex, nested AND,
OR, and NOT operators, as well as by applying multiple filters to a single field.

Custom filters are not available for Ad Hoc views created from OLAP connections.

Custom filters are useful in a number of situations, including:

l When using the AND operator is not sufficient. Consider an international company
that wants to view data for stores located on the Pacific Rim; they may create a
custom expression with the following criteria:

o Country is USA

AND

o State is California OR Washington OR Oregon OR Hawaii OR Alaska.

OR

o Country is Japan OR Indonesia

Using the AND operator for all of these criteria returns an empty view, as no
store is located in all of those areas.

l When you need to eliminate some results in a field. For example, if your food and
beverage distribution company wants to view sales for all drinks except for high-price
items, you might include the following criteria in a custom expression:

o Product Group is Beverages

NOT

o Price is greater than 39.99

This filter displays all items in the Beverage Product Group, but filters out those
with prices over $39.99

These are only two scenarios where custom filters can hone your results and make your
view more precise. There are, of course, many other situations where they can be applied.

In this section, we take you through these tasks:

l Creating a custom expression

l Editing a custom expression
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l Removing a custom expression

l Applying multiple filters to a single field

Custom filters are applied to views, but filter details do not appear on previews or on the report
generated from that view.

To create and apply a custom filter

Procedure
1. Create two or more filters for your data, as described in Using Filters. These can be

standard field-based filters, or Keep Only and Exclude filters.
Note that as you create the filters for use in a custom expression, you may find that
the data in your view disappears, since most (if not all) of the data will not meet all
of the filter criteria. When you create your custom expression and change some of
the ANDs to ORs and NOTs, the data reappears in the panel.

2. At the bottom of the Filters panel, expand the Custom Filter Expression section.

3. In the text entry box, enter a filter expression using the letter designations, and
including the following operators:

l AND narrows your results and includes only fields that meet the criteria of both
filters before and after the operator.

l OR broadens your results and includes fields that meet the criteria of either
filter before or after the operator.

l NOT excludes results that match the criteria.

l Parentheses combine multiple filters into a single item in the expression.

Filter letter designations are case-sensitive, and must be UPPERCASE.

4. Click Apply. Your view is updated to reflect the newly applied filter criteria.

After creating a custom filter, you may want to add another filter to the expression or
remove one already included in the expression.

If the simple filter you want to delete is part of a custom filter, you must first remove it from the
custom filter expression. Otherwise deleting the filter deletes the custom filter expression.

To add a new filter to an existing custom expression
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Procedure
1. If necessary, create the new filter in the Filter panel.

2. In the Custom Filter Expression section, click inside the text entry box to edit the
expression.

3. Add the new filter to the expression.

4. Click Apply to apply the new filter criteria.

To remove a filter from a custom expression

Procedure
1. Expand the Custom Filter Expression section.

2. In the text entry box, remove the unwanted filter from the expression and adjust the
expression as needed.

3. Click Apply to apply the new filter criteria.

When working with custom expressions, you may decide to delete an expression and create
a new one.

To remove a custom expression from a view

Procedure
1. Expand the Custom Filter Expression section.

2. Clear the expression from the text entry box.

3. Click Apply. The expression is removed, leaving the remaining filters intact.

When you refine your custom expression, you may also want to delete unused filters from
the Filters panel.

• If the filter you want to remove is not part of the custom filter, hover your mouse
over in the filter’s title bar and select Remove Filter.

• If you want to remove all existing filters, including the custom expression, hover
your mouse over in the upper right corner of the Filters panhandle and select
Remove All Filters.
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You can apply multiple simple filters to a single field, if needed further to refine your
custom filter results. For example, a user may want to view the data in the Shipping Cost
field, but only when it meets certain criteria combinations:

• When shipping costs to French cities with postal codes that begin with the number 5
are under five Euros.

• When shipping costs to German cities with postal codes that begin with the number
1 are under five Euros.

You can recreate the scenario below using the demo for an ad hoc topic.

In the following example a user has a table including the following columns:

• Country

• Postal Code

• Shipping Charge

To analyze the specific shipping costs described above, the user creates the following
(simple) filters - including two filters each for the Country and Postal code fields:

• A. Country equals France.

• B. Postal code starts with 5.

• C. Country equals Germany.

• D. Postal code starts with 1.

• E. Shipping Charge is less than 5.

Then, to display only the information she needs, she creates the following custom
expression:

• ((A and B) or (C and D)) and E

This translates to:

• ((FRANCE and POSTAL CODES THAT START WITH 5) or (GERMANY and POSTAL
CODES THAT START WITH 1)) and SHIPPING CHARGES LESS THAN 5 EUROS.
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Using Input Controls
In the Ad Hoc Editor, you can display the input controls defined in the Topic as visible to
users. You can accept the controls’ default values or enter other values. The Ad Hoc Editor

indicates that the view has input controls by displaying an input control icon as active
on the tool bar. Click this icon to select new values or to save values as the new defaults
for this view.

There are two types of input controls: Single-select and multi-select. The input control type
is determined by the operator that you use. In turn, the available operators are determined
by the field type (date, text, numeric, or boolean) you use as a filter.

Single select controls present a calendar or dropdown list of values, from which you can
choose a single value. To create this type of input control select one of the following
operators:

• equals

• is not equal to

• is greater than

• is less than

• is greater or equal to

• is less or equal to

• contains

• does not contain

• starts with

• does not start with

• ends with

• does not end with

• is before

• is after

• is on or before

• is on or after
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Multi-select controls display a calendar or dropdown list of values, from which you can
choose multiple values. You can click to select individual values or shift-click to select
multiple sequential values. You can also search for values, select all available values,
deselect all available values, or invert the selection. A Selected tab shows only items
that are selected and allows you to delete them. To create this type of input control select
one of the following operators:

• is one of

• is not one of

• is between

• is not between

To add an input control to the view using a filter

Procedure
1. Create a new filter or use an existing one in the Filters panel.

2. In the Filters panel, click the operator dropdown menu in the filter's title bar.

3. Select an operator from the dropdown. The operator you select determines whether
the input control is single-select or multi-select.

4. Click Apply. The filter appears as an input control when the view is used to run the
report.

5. Place your cursor over and select Save Ad Hoc View as.

6. Name the view, select a location, and click Save.

7. On the tool bar, click .

Only the input controls defined in the topic appear here. Again, if no input controls
were defined in the topic, the button appears inactive. You can create a report and
open it in the Report Viewer to see a filter listed as an input control.

To edit the values for a view’s input controls

Procedure
1. On the tool bar, click . A window listing the input controls defined in the Topic
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appears.

The Parametrized Report Topic already includes three input controls created when the
report was uploaded: Country, RequestDate, and OrderId.

2. Select new values. For example, select USA from the Country dropdown.

3. To change default values of input controls, select the checkbox, Set these values as
defaults when saving your view. The selected values become the default values when
you save the view.

4. Click OK. The Ad Hoc view shows USA data.

Input Controls and Filters Availability
Input controls and filters can appear in the Editor and when a report runs:

l Input controls can be set to be visible or invisible when you edit a view:

o Input controls set to Always prompt are displayed in the editor and always
appear before the report is run.

o Input controls that are not set to Always prompt are always hidden in the
editor and hidden when the report is run.

l Filters defined in the Domain design are always hidden in the editor and when the
report is run.

l Filters created in the Data Chooser can be locked or unlocked:

o Filters that are unlocked display filter information in the editor and are
available from the Options button when the report is run.

o Filters that are locked display input controls in the editor when you see the
view in display mode but are not available from the Options button when the
report is run. Users can remove the filter while in the editor, allowing them to
see all the data unfiltered when the report is run.

o You cannot change whether the filter is displayed after the report is created.

l Filters defined in the editor are always available in the Filters panel of the editor and
from the Options button when the report is run.

When setting up input controls for a huge view that takes a long time to run, consider
setting the view to Always prompt. Before a report is run, the Report Viewer prompts you
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to provide the input options, preventing the report from running with the default input
options.

Filters that are unlocked are available. When input controls or filters do not appear in the
Report Viewer, click the Options button to view them. You can learn more about how filters
and input controls interact in the editor by walking through the data exploration tutorial
with the Filters panel open.

To set an input control to always prompt

Procedure
1. Locate a Topic, such as the Parametrized Report Topic, in the repository and click

Edit.

2. On the Controls & Resources page of the JasperReport wizard, under Input Control
Options, select Always prompt:

To determine whether an input control is visible

Procedure
1. Locate a Topic, such as the Parametrized Report Topic, in the repository and click

Edit.

2. On the Controls & Resources page, click the name of an input control, such as
Country.

3. On the Locate Input Control page, click Next.

At the bottom of the Create Input Control page, if the Visible checkbox is selected,
the input control appears on the report when it runs. For more information, see
Adding Input Controls.

If you do not provide a default value for the input control, users are prompted to select a value
when they create a view based on the Topic.

To lock a filter

Procedure
1. Click Create > Ad Hoc View.
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2. In the Select Data wizard, click and browse to Domains to create a new view
based on a Domain.

3. Click Choose Data.

4. In Fields, move tables and fields from Source to Selected Fields.

5. Click Pre-filters.

6. Double-click a field in the Fields panel.

7. In the Filters panel, define a filter as described in The Pre-filters Page.

8. Check the Locked checkbox, and click OK.

9. Click Table to open the Ad Hoc Editor.

In the Filters panel, the name of the filter and a note about the lock appears under
the heading Locked.

Creating a View from a Domain
Like Topics and OLAP connections, administrators and data analysts create Domains for
reuse to simplify access to data during view design. Domains give view makers more
flexibility than Topics in choosing fields from the database and allow filtering of the data
before it is included in a view and the subsequent report.

A view based on a Domain can prompt the user for input that determines what data is
presented. For example, if a Domain includes all sales data for a company, the view can
present detailed information grouped by postal code and prompt the user to select the
geographic area, such as a US state. The view displays only the pertinent information.

For a more complete description of how to create Domains, see JasperReports Server Data
Management Using Domains.

To begin create a basic view from a Domain

Procedure
1. On the Home page, click Create > Ad Hoc View. The Select Data wizard opens.

2. Click and navigate to Domains. A description of the selected Domain appears at
the bottom of the Domains tab.
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Figure 108: Simple Domain Selected in the Select Data Dialog

3. Select the domain you want to use.

4. Click Choose Data. the Data Chooser opens to the Fields page.
You are now ready to configure your data using the Data Chooser Wizard.

Referential Integrity
When you create an Ad Hoc view from a Domain, the two elements are connected - the
data in the view is dependent on the Domain. This relationship affects users working with
the Domain and the dependent view in a number of ways:
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• When an item or items from the Domain are used in the dependent Ad Hoc view,
removing the items from the Domain will result in a Missing Data error message
when opening the Ad Hoc view in the editor. The user is prompted to remove the
items from the Ad Hoc view. The removed items no longer appear in the Data
Source Selection panel when the editor opens.

• Items not used in dependent views can be removed from the Domain by the
Domain's administrator; those items no longer appear in the view's Available Fields
list.

Using the Data Chooser Wizard
To design a Domain Topic or a view based on a domain, use the Data Chooser wizard. To
open the Data Chooser wizard:

Procedure
1. Click Create > Ad Hoc View.

2. Click and browse to a Domain, then click Choose Data to access the following
pages of the Data Chooser:

l The Select Fields Page– Choose the fields to make available in the Ad Hoc
Editor.

l The Pre-filters Page– Define a filter on any field, with the option of prompting
for user input, or to compare fields.

l The Display Page– Change the order and names of fields that appear in the Ad
Hoc Editor.

l The Save as Topic Page– Save the settings as a Domain Topic.

Start by selecting some fields on the Select Fields page, but the other three pages are
optional and can be completed in any order. Click Table, Chart, or Crosstab at any time to
begin designing a view based on the chosen data.

The Select Fields Page
Use this page to choose fields and sets of fields to use in the view or make available in the
Domain Topic:
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Figure 109: The Fields Page of the Data Chooser

• The Source panel displays the sets of fields in the Domain. Use and to collapse
or expand each set.

• The Selected Fields panel shows the items that you selected. You can move a field or
set back and forth between the panels by dragging, double-clicking, or selecting the

item and clicking an arrow button, such as .

• When you select any field from a set in the Source panel, the set name appears with
the field in the Selected Fields panel. If you do not want sets, then use the settings
on the Display page.

• Some Domains define sets that are not joined, also called data islands. When you
select a field from such a set, the behavior on the Select Fields page depends on
how the joins were created in the Domain:

• If the Domain uses basic joins, the unjoined sets are not available. The Domain
Designer only creates basic joins.

• If the Domain uses advanced joins, all joins are available regardless of the join
set of the fields you add. In this case, you must manually make sure that you do
not add fields that are in different data islands to a single Ad Hoc view.
Otherwise you receive errors when attempting to work with the view.
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The Pre-filters Page
You can pre-filter the data in the Data Chooser before launching the Ad Hoc Editor or
creating a Domain Topic. Pre-filtering data limits the data choices available in a Domain
Topic or the fields that ultimately appear in the Ad Hoc view. You can also define a filter on
a field that does not appear in the final report. The filter is still applied and only data that
satisfies all defined filters appear in the final report. For example, you can filter data to
select a single country, in which case it does not make sense for the Country field to
appear as a row, column, or group. You can also design reports that prompt users to input
data to use as a filter.

The Pre-filters page provides powerful functionality for designing views within the server.

Figure 110: Condition Editor in the Filters Panel on the Pre-filters Page

To define a filter

Procedure
1. In the Data Chooser, click Pre-filters.

2. Expand the options in the Fields panel.

3. Double-click to select a field in the Fields panel. Choices appear for filtering the
selected field:

4. Choose a comparison operator.
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Text fields have both substring comparison operators such as “starts with” or
“contains” and whole string matching such as “equals” or “is one of ”. When
you select a whole string matching operator, a list appears to show all existing
values for the chosen field retrieved in real time from the database.

In the Filters panel, a dropdown appears to contain the account names from
which you can select multiple values.

5. Click each value for comparison in Available Values to move it to Selected Values.
The account names appear in Selected Values.

If there are more than 50 Available Values, click to search for the value. The
maximum number of items that can be displayed in Available Values is configurable.
For details, see the JasperReports Server Administrator Guide.

6. To limit the view design to the four account names in Selected Values, check the
Locked checkbox.

By default, the Locked checkbox is unchecked, making the filter available to end
users running the report.

In the Report Viewer, users can click the Options button to enter a comparison value
for this condition. When the user clicks Apply or OK, the report preview refreshes
with data that match the condition. The condition is available as a prompt even if the
filtered field does not appear in the report. For example, the final report might
present data for a single country, but the country is chosen by the user. Once
defined, filter prompts can be modified in the Ad Hoc Editor, as explained in Using
Input Controls.

Note that when the Locked checkbox is checked, the filter is not available to end
users running the report. The condition can be removed from the view, if needed, but
not edited.

7. Click OK to create the filter.
The Filters panel shows the filters that you have defined.

8. In the Filters panel, click Change to modify the condition. Click OK to save the
changes. After selecting a row, you can also click Remove to delete it from the list.

Data rows must match all conditions. In other words, the overall filter applied to the data is the
logical AND of all conditions you have defined.



JasperReports® Server User Guide

280 | Working with the Ad Hoc Editor

The Display Page
Use the Display page to change the default label and order of the fields as they should
appear in the list of fields in the Ad Hoc Editor. You can always change the field labels and
order in the Ad Hoc Editor, but setting them here makes them available in a Domain Topic.
The page includes these options:

• To change the order of fields, click once anywhere in a field’s row and use the Move
to top, Move up, Move down, or Move to bottom buttons:

, , , and

Fields may be moved only within their set, but sets as a whole may also be moved.

• By default, the field name becomes the display label for the row, column, or
measure that you create from it. To change the default display label of a field or set,
double-click anywhere in the row and type the new label in the text box.

• Sets and the fields they contain appear in the list of fields in the Ad Hoc Editor. Sets
are not used in views, but can be used to add all their fields at once, expediting view
creation.

• If you do not want to use sets in the Ad Hoc Editor, select Flat List at the top of the
Data Source Selection panel. You can now relabel the fields and reorder them.

The Save as Topic Page
Here you can enter a name and a description to save the Data Chooser settings as a
Domain Topic. Thereafter, you can create different views from the Domain Topic, using its
fields, filters, and display label settings. You can also edit the Domain Topic to change the
settings.

If an administrator has enabled the Data Staging feature, you can turn data staging on for
your domain topic. With data staging, the entire dataset for a Domain Topic is indefinitely
cached in the server's Ad Hoc cache. Ad Hoc views and reports from that Domain Topic run
faster because they fetch data from the local cache, not by querying the production
database. To keep data fresh, you can specify a refresh interval, and the server will
periodically access the database in the background to reload the entire dataset.

• By default, Domain Topics are saved in the standard Topics folder. This corresponds
to the Ad Hoc Components > Topics location in the repository; JRXML Topics and
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Domain Topics in this folder appear on the Topics tab when you start a view. Do not
modify this folder name.

• The description text appears with the Domain Topic in the repository and at the
bottom of the Topics tab on the Ad Hoc Source dialog. Enter an informative
description that helps users understand the nature and purpose of this Domain
Topic.

Working with Topics
When a user clicks Create > Ad Hoc View on the Home page, the Select Data wizard offers a
path to the list of Topics populated from the Ad Hoc Components/Topics folder in the
repository. There are two types of Topics:

• JRXML-based Topics–Created by administrators using Jaspersoft Studio and
uploaded as JRXML files to the proper location in the repository. Topics are typically
of this type.

• Domain Topics–Created from a Domain by administrators using JasperReports
Server.

Either type of Topic is an empty view associated with a data source in the server, and is
then built on in the Ad Hoc Editor.

Uploading a Topic Through the Web UI
JRXML-based topics are the most common type of topic. You can upload previously created
JRXML topics via the repository.

To upload a JRXML-based Topic

Procedure
1. Log in to the server as an administrator and select View > Repository.

While any user with sufficient repository permissions can upload a Topic to the server, this
example requires an administrator login to access the JServer Jdbc data source.

2. Locate the folder where Topics are stored. The location of the Topics folder depends
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on your system configuration. By default, Topics are in the Ad Hoc Components >
Topics folder.

3. Right-click the Topics folder name and select Add Resource  > JasperReports® from
the context menu. The Set Up the Report page of the Jasper Report wizard appears.

Add Resource appears on the context menu only if your login account has write privilege to the
folder.

4. In the Set Up the Report page, give the Topic a name, a Resource ID, and an optional
description, then click Next.

l The Name field is the visible name of the file in the repository, such as Example
Topic.

l The Resource ID field is the internal ID of the object, such as Example_Topic.
The server does not accept spaces in an internal ID.

l The Description field, such as Topic uploaded for User Guide example, helps
users understand the purpose of the file.

5. In the Locate the JRXML File section, select Upload a Local File, and click Browse to
locate the file and upload the Topic from the file system. In this example, the file is
<js-install>/samples/adhoc/topics/adhoc_sample.jrxml.

To locate adhoc_sample.jrxml, you need access to the server host file system.

6. Click Data Source.

Because this is a simple Topic without parameters, there are no controls and resources
associated with it. If the Topic has a Parametrized query, you can create input controls for it.
See Selecting a Data Source for Running the Complex Report. Such input controls can appear
in the Ad Hoc Editor and when the report is run.

7. Click Select data source from repository and Browse to locate the data source named
Data Sources/JServer Jdbc data source.

8. Select Data Source, then click Select.Topics must be associated with the data source
that they were designed for.

9. Click Submit at the bottom of the screen.

Topics usually do not need a query or customization, but you can define them.
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When you select Create > Ad Hoc View and click in the Select Data wizard, you can
browse to Ad Hoc Components > Topics. If you select the Example Topic, you can create a
report using the columns available in the data source selected in step 7.

The JRXML file that the Topic is based on must contain a query and a field list.

Any report layout in the Topic’s JRXML file is ignored by the Ad Hoc Editor. We recommend that a
Topic’s JRXML file not include anything other that the query and field list.

When you create a JRXML file for use as a Topic, you can specify the name to display for
each field that the Topic returns. To do so, define a field property named adhoc.display for
each field declared in the JRXML. The adhoc.display field property must have the following
syntax:

<property name=”adhoc.display” value=”Any Name”/>

If the Topic includes fields with unusual datatypes, those fields do not appear in the Ad Hoc Editor
because it is not equipped to manage them properly. For example, if the Topic is defined against a
MongoDB instance that returns data of type array, this field is not available in the Ad Hoc Editor.
For more information on datatype support in the Ad Hoc editor, see the JasperReports Server
Administrator Guide.

For example, this JRXML code declares a StoreState field that is displayed in reports as
Store State:

<field name=”StoreState” class=”java.lang.String”>
<property name=”adhoc.display” value=”Store State”/>
</field>

Topics also support the $R expressions for field names; for more information, see
Localizing Reports.

For fields in a non-domain topic the following properties may be of interest:

l dimensionOrMeasure: Marks a field as a field or a measure.

l defaultAgg: Which aggregation should be used for this measure (avg, etc.).

l semantic.item.desc: A description for the field.

l defaultMask: Set a measure as a $, date etc.

For more information on working with JRXML topics, see the Jaspersoft Studio User Guide.
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Creating Topics from Domains
In some circumstances it is important to create a Topic based on the Domain and data
settings you chose, but it's not always necessary. The main consideration is how reports
based on the Domain-based view are used. The following table explains the choices.

If you want to … Then do this Explanation

Create a single-use report
from the Domain with
your settings.

Click Table, Chart, or
Crosstab after defining
your settings in the Data
Chooser, then format the
view and create your
report.

Your field selections appear in the Ad
Hoc Editor and you can create views
from them, but the settings
themselves are not saved.

Run a report repeatedly
as is or with prompting
for new input, or make
very similar reports in the
Ad Hoc Editor.

Click Table, Chart, or
Crosstab after defining
your settings in the Data
Chooser, then format and
save the view in the Ad
Hoc Editor.

After you save a view, users can
create reports to be run from it
repeatedly and be prompted for input
each time if you defined unlocked
filters.

Reuse your field, filter,
and display settings on
this Domain to create
new views with different
formatting.

After saving your settings
as a Domain Topic in the
Data Chooser, start a new
view and choose your
Domain Topic from the
Domains tab.

Domain Topics are saved in JRXML
format in the repository. They appear
on the Topics tab when you start a
view.

Be able to modify one or
more of the settings you
made in the Data Chooser
wizard.

After saving your settings
as a Domain Topic in the
Data Chooser, find your
Domain Topic in the
repository and open it in
the Domain Designer.

Domain Topics can be edited as
described in Editing a Domain Topic.
After you save your changes, you can
create views based on the modified
Domain Topic.

Create views from the
same repository data
source but with different
Domain settings, such as

Edit the Domain and save
it with a new name. Then
start a new view and
choose your data from

Domains provide advanced
functionality such as table joins and
derived fields based directly on a
data source. Domains usually require
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If you want to … Then do this Explanation

derived fields and
different joins to make
new fields available in a
report.

the new Domain. administrator permissions to create
and modify.

Warning:
Ad Hoc views based on Domain topics may return duplicate data if Data Staging
is enabled.

Access Permissions in Domain Topics
If other users create reports from your Domain Topic-based view, and the Domain is
configured for security, it's important to consider everyone’s access permissions. You might
not have access to all of the fields in the Domain nor to all the data in those fields. There
may be fields that can be seen only by other users, and in the fields that you can see, some
data may be hidden from you. When you save the Domain as a Topic, only the fields that
you selected appear in the Domain Topic. When you create a view from the Topic, only the
data that you can access in those fields appears. When others create views from the Topic,
they see only fields that they have permission to access. These rules also apply to the
reports generated from these views.

For example, in a Domain, user Tomas can access fields B-C and data rows 1-3; Anita can
access fields C-E and data rows 2-5. Tomas uses the Data Chooser and saves a Domain
Topic based on the Domain. When Tomas and Anita create reports from the same view,
they see different combinations of fields and the data in them.

Fields Data

Tomas's report from his Domain Topic B C 1 2 3

Anita’s report from the same Domain Topic C 2 3 4 5

Even though Anita has permission to see more fields, they're not available to her because
Tomas did not have access to them when he created the Domain Topic. However, Anita
does have permission to see more data than Tomas, so when she creates a view, or opens
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or runs the report based on that view, she can see more rows than Tomas can when he
views the report. See the JasperReports Server Security Guide for a technical explanation
of data security for Domains.

Saving Domain Settings as a Domain Topic

To save settings in the Data Chooser wizard as a Domain Topic

Procedure
1. While making selections in the Data Chooser, navigate to the Save Topic page.

2. Enter a Topic name and description.
Do not change the location folder. Using the default /adhoc/topics folder makes the
saved Domain Topic available in the Ad Hoc Components > Topics folder when you
select Create > Ad Hoc View.

3. If your data selections, filter definitions, and display settings are complete, click
Table, Chart, or Crosstab.

If settings are incomplete, navigate to the other pages to finish, then click Table, Chart, or Crosstab

The new Topic appears in the Ad Hoc Components > Topics folder.

Because a Domain Topic is a type of report, it appears when the Search page is
filtered to show reports:

Editing a Domain Topic
You can modify a Domain Topic you created using the Data Chooser.

To edit the settings in a Domain Topic

Procedure
1. Select View > Repository and search (or browse) for the Domain Topic you want to

modify. Domain Topics are usually kept in the Ad Hoc Components > Topics folder.

2. Right-click the Domain Topic and select Open in Designer from the context menu.
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The Domain Topic opens in the Data Chooser wizard.

3. Follow the guidelines in Using the Data Chooser Wizard to edit the Domain Topic as
needed.

4. To save changes to the selected Domain Topic, click Table, Chart, or Crosstab on any
page.

Warning:
Use caution when editing Domain Topics that may have been used to
create other views. Users relying on the Domain Topic might receive
unexpected data or errors. It's safer to save changes as a new Domain
Topic.

To save changes as a new Domain Topic, navigate to the Save as Topic page and enter
identifying information for the new Topic, then click Table, Chart, or Crosstab.
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User Favorites
JasperReports Server user Favorites enables you to add the repository resources to your
Favorites. By adding repository objects to Favorites, you can access frequently used files
quickly in your Favorites. Using user Favorites, you can add, remove and access the
repository objects in the Favorites list, including reports, dashboards, Ad Hoc views,
domains, and data sources.

This chapter includes the following sections:

• Adding Resources to Favorites

• Removing Resources from Favorites

• Accessing Favorites

Adding Resources to Favorites
User Favorites lets you add the repository objects using a star icon or option in the context
menu. You can add the multiple objects of different types to your Favorites list in the
following ways:

File Listing Page
You can add the items to Favorite in the Library page, Repository page, and Search Results
page. In the Library page, you can add only Ad Hoc views, reports, and dashboards to the
Favorites list, while in the Repository page and Search Results page, you can add reports,
dashboards, Ad Hoc views, domains, data sources, and other files also to the Favorites list.

The following example shows you to add items in the Library page.

To add an item to Favorites using the star icon

Procedure
1. Click Library and hover over the library list.
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2. Select any item from Ad Hoc views, dashboards, and reports and click the star icon to
the left of the item name. The item will be added to Favorites.

3. Repeat the step 1 and step 2 to add more items to your Favorites list.

Figure 111: Item Added to Favorites

Similarly, you can add the other files to the Favorites in Repository page and Search
Results page.

To add an item to Favorites using the context menu

Procedure
1. Click Library and hover over the library list.

2. Select a report you want to add to Favorites.

3. Right-click the report and select Add to Favorites from the context menu.

4. To select multiple items, use the shift or control key with arrow keys, and then right-
click the selected items and select Add to Favorites from the context menu. The
multiple items will be added to Favorites at once.
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Figure 112: Adding Report to Favorites

Each object type has different options in its associated context menu. See the table below
for the Add to Favorites option for each object type.

Object Type Library Repository Browse Repository Search

Ad Hoc Views
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Reports

Dashboards

Data Sources

Domains
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Datatype

Input Control

Content Resource

List of Values

OLAP Client
Connection

Mondrian XML/A
Source

Query

JasperReport
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OLAP View

File:

Access Grant
Schema

Content Resource

CSS

Font

Image

JAR

JRXML

OLAP Schema

Resource Bundle

Style Template

XML
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Removing Resources from Favorites
Like you have added the resources to Favorites, you can also remove multiple resources of
different types from the Favorites list. Resources can be removed from Favorites list in file
listing page.

File Listing Page
From the Library page, Repository page, and Search Results page, you can remove any file
from Favorites list either by deselecting the star icon or selecting Remove from Favorites
option from the context menu.

For example:

• To remove a report listed in Favorites from the Library page, locate the report and
deselect the star icon to the left of the report name. You can also remove multiple
files by deselecting the star icon.
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Figure 113: Removing Report from Favorites using Star Icon

Similarly, you can remove other files listed in Favorites from the Repository page and
Search Results page.

• To remove a report from the Favorites list in the Library page, locate the report,
right-click it and select Remove from Favorites option from the context menu. You
can also remove multiple items from Favorites at once. To select the starred items,
use shift or control key with arrow keys, and then right-click the selected items and
select Remove from Favorites from the context menu.
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Figure 114: Removing Report from Favorites using Context Menu

Similarly, you can use Remove from Favorites option from the context menu in Repository
page and Search Results page.

Accessing Favorites
Once you have added the items to Favorites, you can access those items quickly in your
Favorites list. The Favorites list can be accessed in the following ways:

• Home page - On the Home page, a Favorites list appears above the Recent Items list.
The Favorites list displays the top five runnable items, sorted alphabetically, such as
reports, Ad Hoc views, OLAP views, and dashboards. You can access these items by
clicking them, if you want to see the list of all items added to Favorites, click See all
Favorites. This takes you to the Search Results page with the Favorites filter.
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Figure 115: Favorites option on Home Page

• View Menu - In the View menu, the Favorites option is available. When you select the
Favorites option, the Search Results page appears with the Favorites filter selected
in the left panel.

Figure 116: Selecting Favorites from View Menu

• Search Results Page - On the Search Results page, in the Filters panel, the Favorite
Status section allows you to filter the list and show a list of items that are added to
Favorites. When you click the Favorites filter, the Favorites list displays all the items
added to Favorites.



JasperReports® Server User Guide

298 | User Favorites

Figure 117: Favorites Filter on Search Results Page

• Repository Page - You can access the reports, dashboards, and other files with the
solid blue star icon on the Repository page.

Figure 118: Accessing Favorites List on Repository Page

• Library - On the Library page, you can see the list of all files, but the files with a solid
star icon to the left of the file name are added to Favorites. You can also apply the
filter to see a Favorites list. To filter the list, turn on the Show favorites only toggle, a
Favorites list appears on the Library page.
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Figure 119: All Files when Show favorites only toggle is not selected

Figure 120: Favorites List when Show favorites only toggle is selected
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Adding Reports Directly to the Repository
This section describes functionality that can be restricted by the software license for JasperReports
Server. If you do not see some of the options described in this section, your license may prohibit
you from using them. To find out what you are licensed to use, or to upgrade your license, contact
Jaspersoft.

Using the Ad Hoc Editor, you can create reports within JasperReports Server from pre-
defined Topics and Domains. You can also create reports outside of JasperReports Server
and add them to the repository. To add a report to the repository, you need a valid JRXML
file. To create and validate this file, you can use Jaspersoft Studio. Jaspersoft recommends
Jaspersoft Studio for most users because its graphical user interface simplifies the job. If
you have a thorough understanding of the file structure, you can use a text editor to create
the file containing JRXML code.

You can add a report to the server’s repository in two ways:

• From within the server

Add the JRXML file and any other resources that the report needs as a report unit. A
wizard guides you through each step.

• From Jaspersoft Studio

Design the report in Jaspersoft Studio, and use a connection to JasperReports
Server to add the JRXML and resources to the JasperReports Server repository. See
the Jaspersoft Studio User Guide for information.

To add the sample report units to the server, you need access to the sample data in the
server installation directory on the file system (<js-install>/samples). Contact your
administrator for help with locating these files.

In most cases, it is preferable to upload the JRXML file from Jaspersoft Studio. Uploading through
JasperReports Server is included for completeness.

This chapter includes examples of adding a report to the repository using the server’s
wizard and the plug-in. The chapter contains the following sections:

• Overview of a Report Unit

• Adding a Report Unit to the Server

• Modifying the Query When Uploading a Report
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• Adding a Complex Report Unit to the Server

• Adding Cascading Input Controls to a Report

• Editing JRXML Report Units

• Localizing Reports

Overview of a Report Unit
In the server, a report unit is the collection of elements used for retrieving data and
formatting output. The Anatomy of a Report Unit shows these elements:

• The data source and the query that retrieves data for the report.

• The main JRXML that determines the layout and is the core of the report unit.

• The main JRXML defines other elements in one of the following ways:

• Creating definitions internally

• Referring to existing elements in the repository using the repo: syntax

• The input controls and other resources.

For more information about the report unit, refer to the JasperReports Server Ultimate
Guide.
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Figure 121: Anatomy of a Report Unit

Adding a Report Unit to the Server
This section presents an example of uploading a JRXML with resources to the server. This
report has two images that need to be added.

Selecting the Main JRXML File
If you want to validate the JRXML before uploading it, use Jaspersoft Studio. The server
does not validate the JRXML when you upload it.
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This procedure shows you how to set up a name for the report in the repository and select
the main JRXML file that references all other elements.

To upload the main JRXML for this example

Procedure
1. Log in to the server as an administrator and select View > Repository.

If you log in as a user, you can upload a report unit to the server, but this example requires an
administrator login to access the image resources.

2. Locate the folder where you want to add the report. For example, go to Public >
Samples > Reports.

3. Right-click the Reports folder and select Add Resource > JasperReportfrom the
context menu. The Set Up the Report page of the JasperReport wizard appears.

Add Resource appears on the context menu only if you have write permission to the folder.

4. In Naming, enter the name and description of the new report and accept the
generated Resource ID:

l Name - Display the name of the report: New Simple Report

l Resource ID - Permanent designation of the report object in the repository:
New_Simple_Report

l Description - Optional description displayed in the repository: This is a
simple example.

5. Select Upload a Local File and Browse to <js-
install>/samples/reports/AllAccounts.jrxml. 

This example shows how to upload a JRXML file from the samples folder in the installation
directory. You can also Select a JRXML from the Repository or Use a blank JRXML. On
selecting the Use a blank JRXML option, a report unit with blank JRXML is saved after
clicking Submit. This blank JRXML is then opened in an embedded JasperReports Web
Studio, which gives you the ability to create pixel perfect reports from JasperReports
Server.

In Required Set Up Values, you can see the Set Up the Report page.
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Figure 122: Required Set Up Values

6. Click Controls & Resources.

The Controls & Resources page appears. If the server detects that the report needs
additional resources, then you are prompted to locate those resources.
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Figure 123: Suggested Resources in the Resources List

A JRXML file does not embed resources, such as images. When the server uploads the
JRXML, it tries to detect any missing resources. For example, the Suggested
Resources in the Resources List shows that two image files are missing:

l LogoLink

l AllAccounts_Res2

Uploading Suggested File Resources
If needed files are missing, as shown in Suggested Resources in the Resources List, you
need to take one of the following actions:

• Upload resources that the report needs

• Select a resource from the repository

If the Controls & Resources page doesn’t suggest resources, perhaps the report doesn’t reference
any. However, the server can’t always detect all the referenced resources, as discussed in
Uploading Undetected File Resources.

To upload a resource from the file system
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Procedure
1. On the Controls & Resources page, click Add Now in the row of the missing resource,

for example, LogoLink. The Locate File Resource page appears.

2. Choose Upload a Local File then click Choose File.

3. Browse to <js-install>/samples/images. The LogoLink file is not available, but you can
use an alternate image, such as <js-install>/samples/images/jasperreports.png.

4. Click Open to return to the Locate File Resource dialog.

5. Click Next. The Add a Report Resource page appears.

Figure 124: Properties of a Resource

The properties include the LogoLink name, resource ID, and description.

6. Click Next to accept the default naming of the file resource.

The Controls & Resources page appears again, showing that the LogoLink resource
was added.

To add a resource from the repository

Procedure
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1. To add the second resource, click Add Now in the row for AllAccounts_Res2.

2. Choose Select a resource from the Repository and Browse to an image file, for
example, Public > Samples > Images > Jaspersoft_logo.png.

Any image file works.

3. Click Select.
The path to the image appears in the wizard.

4. Click Next. The Add a Report Resource page displays the properties of the image as
set in the uploaded JRXML file.

The properties include the LogoLink name, resource ID, and description. These properties
don’t redefine the properties of the Jaspersoft_logo.png file in the repository.

5. Click Next to accept the default naming of the file resource.
The Controls & Resources page reappears, showing the addition of both resources
referenced in the main JRXML.

6. Click Data Source and define a data source as described in the next section.

Defining the Data Source
Data sources are not defined directly in the report JRXML file. It must be specified when
you upload a file to JasperReports Server. On the data source page of the Add
JasperReport wizard, you can select a data source in the repository or create a new data
source.

If you want to create a data source, the application server must be able to find the driver
for the database you want to use. For example, in a default installation of JasperReports
Server, Tomcat looks for data source drivers in <js-install>/apache-tomcat/lib. Put a copy of
the driver in this location.

To define a data source for the simple report example

Procedure
1. In the JasperReports wizard, click Data Source. The Link a Data Source to the Report

page presents these choices:
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l Do not link a data source - Select or define the data source later. You see an
error if you run the report in this state.

l Click here to create a new data source - Define a new data source available
only to your report.

l Select data source from repository - Select an existing data source from the
repository.

2. Choose Select data source from the Repository and Browse to Public > Samples >
Data sources > JServer JNDI Data Source.

3. Click Select. The Link a Data Source to the Report page reappears with the path to
the data source.

Figure 125: Data Source Page

4. Click Submit to add the new report unit to the repository.

Saving the New Report Unit
To submit a new report unit to the repository, click Submit on any page of the
JasperReport wizard, from the Set Up page to the Customization page. You do not have to
set options, which are not needed, such as Customization. When you click Submit, the
server attempts to upload the JRXML report and its resources. If the upload is successful, a
message appears at the top of the repository page, indicating that the report was saved.
The report appears in the repository with the description that you entered on the Set Up
page. To run the report and view the output, click its name, New Simple Report.
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Figure 126: New Report Added to the Repository

In the report viewer, click to go to the end of the report, where the logo images that you
added appear. The following figure shows the output.

Figure 127: Output of the New Simple Report

Modifying the Query When Uploading a Report
The query in the report unit determines the data that the server retrieves from a data
source. You can create multiple reports that look the same but contain different data by
defining different queries for the same JRXML file each time you upload it. You can choose
to use a stored query in the repository or define a new one. This example uses a query that
returns accounts from a single country.

You can only override the main query for a report (specifically, the query defined directly
within the JRXML root element <jasperReport>). If the report has elements that use a sub-
dataset (including all table elements and all elements that use a different dataset), then
the queries for these elements is not be affected.

First you need to upload the report and select a data source, as in the previous example.
Then you can create a query that replaces the original query in the report.
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To locate the sample report for this example

Procedure
1. Log in to the server as an administrator and select View > Repository.

2. Locate the folder where you want to add the report. For example, go to Public >
Samples > Reports.

3. Right-click the Reports folder and select Add Resource > JasperReport from the
context menu. The Set Up the Report page of the JasperReport wizard appears.

Add Resource appears on the context menu only if you have write permission to the folder.

4. In Naming, enter the name and description of the new report and accept the
generated Resource ID:

l Name - Display the name of the report: Sample Query Report.

l Resource ID - Permanent designation of the report object in the repository:
Sample_Query_Report.

l Description - Optional description displayed in the repository: Example of
changing a query in a report.

5. Select Upload a Local File and Browse to <js-
install>/samples/reports/SimpleReport.jrxml.

6. Click Open to upload the file.

To select a data source for the report

Procedure
1. In the Add JasperReport wizard, click Data Source. The Link a Data Source to the

Report page appears.

2. Choose Select data source from the Repository and Browse to Public > Samples >
Data sources > JServer JNDI Data Source.

3. Click Select. The path to the data source appears on the page.

To define a custom query for the simple report example
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Procedure
1. In the Add JasperReport wizard, click Query. The Locate Query page presents the

following choices:

l Do not link a Query - Select this option to use the existing query already
defined within the main JRXML.

l Click here to create a new Query - Guides you through defining a new query for
this report only.

l Select a Query from the Repository - Select this option to use a saved query
from the repository.

The SimpleReport.jrxml file already contains a query. Choosing the second or third option
overrides the existing query by defining a new one.

Figure 128: Query Page

2. Select Click here to create a new Query. The link becomes active.

3. Click the link, Click here to create a new Query. The Add Query wizard appears and
displays the Name the Query page.

4. Enter the name, resource ID, and description of the query. The query in this example
retrieves only Mexican accounts. Enter the following values:

l Name - MexicoAccounts

l Resource ID - MexicoAccounts

l Description - Query for example in User Guide

This query and its properties are visible only within the report unit.
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Figure 129: Name the Query Page

5. Click Next. The Link a Data Source to the Query page appears. Here you have the
option to select a data source to use only with this query. This can be different from
the data source you selected for uploading the report. You can choose an existing
data source from the repository, define a new one, or select not to link a data source.

6. Select Do not link a data source to use the same data source you already selected.

7. Click Next. The Define the Query page appears.

8. Select SQL in the Query Language dropdown and enter the following query string to
retrieve only Mexican accounts:

SELECT * FROM accounts WHERE billing_address_country = 'Mexico' ORDER
BY billing_address_city

Figure 130: Definition of a Query
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9. Click Save to save the query. The Customization page appears. No customization is
required for the example.

10. Click Submit to submit the new report unit to the repository.

To run the report

Locate the report in the repository and click to run it. Only accounts in Mexico are shown in
the report.

Figure 131: Output of the Report

Adding a Complex Report Unit to the Server
This section includes an example of how to add a report unit with all these resources:

• SalesByMonth.jrxml - The main JRXML file.

• SalesByMonthDetail.jrxml - The subreport.

• sales.properties - An English resource bundle file.

• scriptlet.jar - A scriptlet class JAR file.

• JR Logo - An image in the repository.

• JServer JNDI data source - A data source file in the repository.

These resources are part of the sample data installed with the server. To complete this
example and run the report without server errors, you need access to these resources.

The example also guides you through defining every type of input control:
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• Text

• Checkbox

• Dropdown

• Date

• Query

If you are not interested in creating all types of input controls, but want to work through
part of the example, then delete parameters for the input controls that you do not want to
create before you run the report.

The complex report that you create in this example is almost exactly like the SalesByMonth
report in the Reports folder of the repository.

To upload the main JRXML and suggested resource files for the complex
report unit

Procedure
1. Log into JasperReports Server as administrator and select View > Repository.

If you log in as a user, you can upload a report unit to the server, but this example requires an
administrator login to access the image resources.

2. Navigate to the folder containing your report. For example, navigate to
Organization > Reports.

3. Right-click the Reports folder and select Add Resource > JasperReports® from the
context menu. The Set Up the Report page appears.

Add Resource appears on the menu only if you have write privilege to the folder.

4. Enter these properties:

l Name - New Complex Report

l Resource ID - New_Complex_Report

l Description - This is a complex report

5. Select Upload a Local Fileand Browse to <js-
install>/samples/reports/SalesByMonth.jrxml.
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6. Click Controls & Resources.
The Controls & Resources page in Suggested Resources for the Complex Report
suggests resources to be uploaded for the report:

l A sub-report (the SalesByMonthDetail.jrxml file)

l A logo image

Figure 132: Suggested Resources for the Complex Report

7. On the Controls & Resources page, upload the sub-report:

a. Click Add Nowin the SalesByMonthDetail row. The Locate File Resource page
appears.

b. Select Upload a Local File.

c. Click Browse and locate the file <js-
install>/samples/reports/SalesByMonthDetail.jrxml. Select
SalesByMonthDetail.jrxml.
The path to SalesByMonthDetail.jrxml appears in the Upload a Local File field.

d. On the Locate File Resource page, click Next.

e. On the Add a Report Resource page, click Next to accept the default report
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resource name and resource ID.

8. On the Controls & Resources page, upload the logo image resource:

a. Click Add Now in the Logo row. The Locate File Resource page appears.

b. On the Locate File Resource page, click Select a resource from the Repository.

c. Click Browseto locate the file /Images/JR Logo and select JR Logo.

d. Click Next. The Add a Report Resource page appears.

e. On the Add a Report Resource page, click Next to accept the default name,
resource ID, and description.

Uploading Undetected File Resources
The JasperReport wizard cannot detect every type of resource referenced in the main
JRXML. You need to add the undetected resources before the server can upload the report.
For the following example, we provide the names of these resources. To discover
undetected resources, open the JRXML in Jaspersoft Studio and examine its parameters
and properties. For more information about the JasperReports Server Plug-in, see the
Jaspersoft Studio User Guide.

These are the undetected resources in the SalesByMonth.jrxml:

• A scriptlet JAR - The scriptlet writes the message, “I’m a scriptlet in a jar”, to the last
page of the report output.

• An English language resource bundle.

• The optional Romanian language resource bundle.

If you are interested in working with a multi-lingual report, add the Romanian
resource bundle. The Romanian resource bundle is part of the sample data installed
with the server.

On the Controls & Resources page, upload the undetected resources to the server using the
same name Jaspersoft Studio uses for the resource ID.

To upload the undetected file resources for the complex report example

Procedure
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1. Add and upload the scriptlet JAR file:

a. On the Controls & Resources page, click Add Resource.

b. On the Locate File Resource page, select Upload a Local File, and Browse to the
<js-install>/samples/jars/scriptlet.jar file. Select scriptlet.jar.
The path to the file appears in the Upload a Local file field.

c. Click Next.
The Add a Report Resource page appears. Figure 133 shows the file name
scriptlet.jar, indicating that the server successfully loaded and automatically
detected the JAR.

d. Enter the following information:

l Name – Scriptlet

l Resource ID – Scriptlet. The Resource ID is referenced in the main JRXML
file, so do not change it.

l Description – Scriptlet JAR for complex report

The followingFigure 133shows these values entered on the Add a Report
Resource page.

Figure 133: Scriptlet JAR Resource Properties

2. Click Next.
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3. Add and upload the English resource bundle:

a. On the Controls & Resources page, click Add Resource. The Locate File
Resource page appears.

b. Select Upload a Local File, Browse to <js-install>/samples/resource_
bundles/sales.properties, and select it. The path to the resource bundle
appears in the Upload a Local file field.

c. In Locate File Resource, click Next. The Add a Report Resource page indicates
that the file was successfully loaded and automatically detected as a resource
bundle.

d. Enter the following information:

l Name – sales.properties

l Resource ID – sales.properties

l Description – Default English resource bundle

4. Click Next.

5. Add and upload the Romanian Resource bundle:

a. On the Controls & Resources page, click Add Resource.

b. Select Upload a Local File, Browse to the file <js-install>/samples/resource_
bundles/sales_ro.properties, and select it.

c. In Locate File Resource, click Next. The Add a Report Resource page shows that
uploading the file was successful. The server recognized the type (resource
bundle) and name (sales_ro.properties) of the selected resource.

d. Enter the following information:

l Name – sales_ro.properties

l Resource ID – sales_ro.properties

l Description – Romanian resource bundle

e. Click Next. Controls & Resources lists all the files.
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Figure 134: List of Detected and Undetected File Resources

If you want to upload a different file for a named resource, click its resource ID in the
Resources list and locate the new file or repository object. You can change the name and
description of the resource, but not its resource ID. If there is a mistake in a resource ID:

l Locate the ID in the list of resources on the Controls & Resources page, and click
Remove.

l Re-add the resource, entering the correct resource ID.

Adding Input Controls
Input controls are graphical widgets that the server displays with the report. Input controls
perform the following functions:

• Prompt the user for input.

• Validate the format of the input.

• Pass the input to the report.
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Based on the input, the server modifies the WHERE filter clauses in SQL parametrized
queries.

Input controls correspond to the parameters defined in JRXML reports, such as $P{name}.
The server maps the value that the user enters for the input control to the parameter of
the same name. If you define an input control in the JasperReport and the server cannot
find a parameter by the same name in the JRXML, then the input control does not function
when the report runs.

The JRXML can define a default value for the input control. To prevent users from changing the
default, you can make the input control read-only or invisible.

When you create an input control, you provide a datatype. Datatypes define the expected
input (numbers, text, date, or date/time) and can include range restrictions that the server
enforces. The server uses the datatype to classify and validate the data.

To define a datatype, set properties on the Set the Datatype Kind and Properties page.
Properties differ for other datatypes that appear on the page.

Type The classification of the data, which can be Text, Number, Date, or Date-
Time.

Name The name of the datatype.

Resource ID The unique ID of the datatype that you cannot edit.

Description Any additional information that you provide about the datatype.

Pattern A regular expression that restricts the possible values of the field for the
Text data type.

Minimum value The lowest permitted value for the field.

Maximum value The highest permitted value for the field.

Minimum Is
Strict

If checked, the maximum value itself is not permitted. Only values less
than the maximum value are permitted.

Maximum Is
Strict

If checked, the minimum value itself is not permitted. Only values greater
than the minimum value are permitted.

After determining the list of values to be presented to the user, choose one of these widget
types for the input control:
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• Boolean - A checkbox widget for entering a yes/no value.

• Single value - A text, number, date, or date/time widget. Input can be constrained to
a minimum value, maximum value, or both. Text input can also be constrained by a
matching pattern. A text box widget for entering a value, or a calendar for selecting
the date and date/time.

• Multiple values - To present a static or a dynamic list of values to the user, choose
one of these:

• Dropdown list to select a single value.

• Radio buttons to select a single value.

• Multi-select list to select multiple values.

• Checkboxes to select multiple values.

The query in the SalesByMonth.jrxml file has several input control parameters, one for each
type of input control. These procedures show you how to add each type to the report unit.

Adding a Text Input Control
The simplest input control is a text box. In this example, the datatype for the input value is
a number. The server verifies that the user enters a number into the text box.

To add a text input control to the complex report example

Procedure
1. After completing the steps in Uploading Undetected File Resources, click Controls &

Resources in the JasperReport wizard.

2. On the Controls & Resources page, click Add Input Control. The Locate Input Control
page appears.

3. Select Define an Input Control in the next step.

4. Click Next.

5. On the Create Input Control page, accept the default (Single Value) from the Type
dropdown.

6. Enter the other properties for the input control:
The name is referenced in the main JRXML file, so enter it exactly as shown.
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l Prompt Text - The label the user sees next to the widget for this input: Text
Input Control

l Parameter Name - The name of the report parameter that receives the user
value: TextInput

l Description - An optional description that appears only within the report
wizard: leave blank in this example.

l Mandatory, Read-only, Visible - A setting that determines how the input control
appears: check only Visible.

Figure 135: Properties of the Text Input Control

To reuse an input control, add it to the repository independent of any report using Add
Resource > Input Control. Before using the input control in a report, check that the parameter
name in the JRXML matches the name in the Create Input Control page. If it does not, then the
server cannot run the report.

7. Click Next.

8. In Locate Datatypes, select Define a DataType in the next step and click Next:

Instead of defining a datatype, you can use one in the repository if its type and range
are compatible with your input control.

9. In Set the Datatype Kind and Properties, enter the properties for the datatype:
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a. In Type, select Number from the dropdown as the type of data the user can
enter.

The number format allows users to enter integers and decimals.

b. Enter a name - Integer Type.

c. Enter a resource ID - Integer_Type.
The name and resource ID are required, but are visible only when defining the
input control.

Figure 136: Integer Datatype Properties

d. Leave these properties blank in this example:

l Description - An optional description that appears only within the report
wizard.

l Minimum value - The lower bound of the value the user may enter.

l Maximum value - The upper bound of the value the user may enter.
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l Minimum is strict - Means the minimum value itself is not allowed.

l Maximum is strict - Means the maximum value itself is not allowed.

10. Click Save.

The Controls & Resources page now lists the Text Input Control.

Figure 137: Text Input Control in Input Controls List

Adding a Simple Checkbox Input Control
A checkbox input control accepts true/false (boolean) input from the user.

To add a simple checkbox input control to the complex report example

Procedure
1. Continuing with the previous example, on the Controls & Resources page, click Add

Input Control.

2. On the Locate Input Control page, click Define an Input Control in the next step.

3. Click Next.

4. On the Create Input Control page, select Boolean from the Type dropdown.

5. Enter the other properties:
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l Prompt Text - Checkbox Input Control.

l Parameter Name - Checkbox Input. Enter the parameter name exactly as shown
because the main JRXML file references this name.

l Description - Leave blank in this example.

l Mandatory, Read-only, Visible – Check only visible.

6. Click Submit. The Controls & Resources page appears with the new checkbox input
control.

Adding a Dropdown Input Control
The dropdown input control also called a list, gives the user a pre-determined list of
choices. As a report designer, you can choose a dropdown input control based on:

• To present a single-select or multi-select list to the user.

• To present a single choice as a dropdown list or a set of radio buttons.

• To present a multi-select control as a multi-select list or a set of checkboxes.

Radio buttons and checkboxes usually work well for five or fewer choices. This example
shows how to create an input control that presents three choices in a dropdown list. You
can create a new list of values for this input control or use a list of values in the repository.

To add a dropdown input control to the complex report example

Procedure
1. Continuing with the previous example, on the Controls & Resources page, click Add

Input Control.

2. On the Locate Input Control page, click Define an Input Control in the next step.

3. Click Next.

4. On the Create Input Control page, select Single-select List of Values from the Type
dropdown.

5. Enter the other properties:

l Prompt Text - List Input Control.

l Parameter Name – ListInput Enter the parameter name exactly as shown
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because the main JRXML file references this name.

l Description – Leave blank in this example.

l Mandatory, Read-only, Visible – Check only visible.

6. Click Next.

7. On the Locate List of Values page, select Define a list of values in the next step.

Note:
Instead of defining a list of values, you can use one in the repository if its
values are compatible with the parameters defined in the JRXML report.

8. Click Next.

9. On the Add List of Values page, enter a name, resource ID, and optional description
for the list of values. These properties are not visible outside of the input control.
Enter these values:

l Name – list type

l Resource ID – list_type

l Description – Leave blank in this example.

10. In the Name Value panel, enter names and values to present as choices to the user:

l Enter unique names. The server requires unique names to distinguish which
item the user chose.

l Enter values of the type that match the parameter definition in the JRXML
report.

After entering a name and value, click Add. If you make a mistake click Remove.

For this example enter:

l Name First Item with value 1.

l Name Second Item with value 2.

l Name Third Item with value 3.
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Figure 138: Definition of the List of Values

11. Click Submit. The Controls & Resources page appears with the new List Input control.

Adding a Date Input Control
This example uses a datatype from the sample data in the repository.

To add a date input control to the complex report example

Procedure
1. On the Controls & Resources page, click Add Input Control.

2. On the Locate Input Control page, select Define an Input Control in the next step,
then click Next.

3. On the Create Input Control page, select Single-Value from the Type dropdown.

4. Enter the other properties:

l Prompt Text – Date Input Control.
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l Parameter Name – DateInput Enter the parameter name exactly as shown
because the main JRXML file references this name.

l Description – Leave blank in this example.

l Mandatory, Read-only, Visible – Check only Visible.

5. Click Next.

6. On the Locate Datatypes page, select Select a Datatype from the Repository.

7. Click Browse.

8. In Select Resource from Repository, expand Input Data Types, and select the Date
Datatype.

9. Click Select. The Locate DataTypes page shows the location of this datatype in the
repository, /datatypes/DateDatatype.

10. Click Next. The Controls & Resources page appears with the new Date Input Control.

Adding a Query-Based Input Control
A query-based input control presents a dynamically created list of choices to the user. The
server performs a query whose results are used to create the list of choices. You must
perform the following tasks:

• Configure the query.

• Designate how to display the results in the input control.

• Specify the value to pass as the corresponding parameter.

To add a query-based input control to the complex report example

Procedure
1. On the Controls & Resources page, click Add Input Control.

2. On the Locate Input Control page, select Define an Input Control in the next step.

3. Click Next.

4. On the Create Input Control page, select Single-select Query from the Type
dropdown.
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5. Enter the naming properties for the input control:

l Prompt Text – Query Input Control

l Parameter Name – QueryInput Enter the parameter name exactly as shown
because the main JRXML file references this name.

l Description – Leave blank in this example.

l Mandatory, Read-only, Visible – Use the default settings in this example.

6. Click Next. The Locate Query page appears. Options are:

l To locate a reusable query in the repository

l To define a new query dedicated to this input control

7. For this example, select Define a Query in the next step.

8. Click Next.

9. On the Name the Query page, enter the naming properties for the new query. For this
example, enter testQuery in both the Name and Resource ID fields.

Figure 139: Entering a Query Name

10. Click Next. The Link a Data Source to the Report page appears. Options are:

l To use the same data source for the input control as you use for the report.



JasperReports® Server User Guide

330 | Adding Reports Directly to the Repository

l To define a new data source, dedicated to this input control.

l To select a reusable data source from the repository.

11. For this example, select Do not link a data source to use the same data source for the
input control as you use for the report. You will select the data source for the report
in Selecting a Data Source for Running the Complex Report.

Figure 140: Data Source Link for the Query Input Control

12. Click Next.

13. On the Define the Query page, select SQL from the Query Language dropdown.

14. Enter this Query String to retrieve the labels and values to be displayed for this input
control:

SELECT user_name, first_name, last_name FROM users
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Figure 141: Define the Query

15. Click Save.

16. For each row in the results of the query, the server presents a single value, such as
Sarah Smith, in the input type widget (dropdown, radio buttons, multi-choice,
checkboxes). On the Query Information page, name the database columns to
comprise the input value presented to the user. The column names must exactly
match those in the SELECT clause of the query string:

a. In the Value Column, enter the user_name.

b. In the Visible Column, enter first_name.

c. Click Add.

d. In the Visible Column, enter last_name.

e. Click Add.
For each column you want to display as a choice, enter the name then click
Add. If you make a mistake, click Remove.

17. Click Submit. The Controls & Resources page displays all the resources, including the
new input controls. Input Controls and Resources shows these resources.
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Setting the Input Control Options
In this procedure, you set the display mode in Input Control Options at the bottom of the
Controls & Resources page. Input Controls and Resources shows these options.

To configure the appearance of the input controls for the complex report
example

Procedure
1. Select a Pop-up window.

Note:
You can also select Separate page to display the input controls in a
separate browser window, Top of page to display them above the report,
or In page to display them on the side of the report.

2. Check Always prompt when you want the server to display the Input Controls dialog
to prompt the user when the report runs.

Note:
The definition of input controls in this example specified Visible and not
Mandatory. When input controls are not mandatory and the Always
prompt is not checked on the Controls & Resources page, the user must
click the Options button in the Report Viewer to change input controls.
Otherwise the report runs with default input controls.

3. Leave Optional JSP Location blank for this example.
You can use the Optional JSP Location option to specify the path to a JSP file that
affects the appearance of the input controls.



JasperReports® Server User Guide

333 | Adding Reports Directly to the Repository

Figure 142: Input Controls and Resources

Select the data source to finish the complex report example.

Selecting a Data Source for Running the Complex
Report
You need to select a data source to retrieve data for the report and the query input control,
otherwise the report, and the list of users in the query input control remain blank.

To select a data source and run the complex report

1. On the Controls & Resources page of the JasperReport wizard, select Data Source.
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2. On the Locate Data Source page, choose Select data source from repository.

3. Click Browse, choose Organization > Data Sources > JServerJNDI Data Source, and
lick Select.

4. On Link a Data Source to the Report, click Submit.

5. On the Locate Query Page, click Submit again to save the complex report.
Skip the Query and Customization pages of the JasperReport wizard to use the
default settings on those pages.
The server validates the report and a message appears indicating that the report was
added to the repository.

6. In the Repository, click the name New Complex Report to run and view the report.
Input controls appear.

7. Enter these input values, as shown in Input Controls Dialog for the New Complex
Report:

l Text Input Control: myText

l Checkbox Input Control: Check the checkbox.

l List Input Control: Select the Third Item.

l Date Input Control: Click and select December 31, 2010.

l Query Input Control: Select Sarah Smith from the dropdown.
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Figure 143: Input Controls Dialog for the New Complex Report

8. Click OK or Apply to run the report with the selected input, including the incorrect
non-numerical input for the Text Input Control.
The server enforces the proper format defined for each input control. You defined the
Text Input Control as a numeric type, so it accepts only valid numbers, as indicated
by the message to specify a valid float number, as shown in Invalid Input Message.

Figure 144: Invalid Input Message
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9. In Text Input Control, enter 3 and click OK or Apply.
The sample report includes a header that displays the value of each parameter
received from the input controls. Values and labels appear in the language specified
by the active resource bundle, in this case English.

Figure 145: Output Controlled by Input

In the Report Viewer, you can open the Input Controls dialog at any time by clicking
the Options button. Click OK to run the report using the chosen values and close the
Input Controls dialog. Click Apply to run the report using the chosen values, but
keep the Input Controls open for choosing other values and rerunning the report.

If you get an error when you run the report, open it for editing as described in Editing JRXML
Report Units. Review your settings. If you cannot find the problem, edit the SalesByMonth sample
report (in the repository at /reports/samples) and compare its settings to your report.

To see the message written by the scriptlet JAR on the last page of the report, click

in the Report Viewer.

Adding Cascading Input Controls to a Report
JRXML-based reports can include input controls that have dynamic values. The values
depend on a user's selection in other input controls. For example, a report has input
controls for country, state, and city. The options in the State input control depend on the
value selected in the Country input control. When the user selects a state, the list of City
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values includes only those in the selected state. These cascading input controls use queries
to determine the values to display in each input control field.

To use input controls as parameters for a query that populates another input control, you
use a special syntax to reference a parameter name in the input control's query. The syntax
is identical to the $P{parameter_name} and $X{...} syntax used in queries for .

For example, a report returns data identified by country and city. It includes input controls
called COUNTRY and CITY. COUNTRY is a query-based input control that returns the list of
countries in the data source. CITY is also a query-based input control, but its query uses
COUNTRY as input:

select address_city from accounts where $X{EQUALS, address_country, COUNTRY}

When the user selects a country from the COUNTRY input control, the value selected is
used by the query of the CITY input control. The CITY input control is refreshed to show the
list of cities for the chosen country. Making two selections from smaller lists is much
clearer and quicker for report users. For an example of viewing a report that has cascading
input controls, see Cascading Input Controls.

Note that there are other ways to use a parameter in a query. For details about the $P and
$X syntax and an example of creating a cascading input control, see the JasperReports
Server Administrator Guide.

Editing JRXML Report Units
After you add a report unit to the repository, you can edit any of its elements, including file
resources and input controls. This example modifies the display text of the ambiguous Text
Input Control.

To edit the complex report example

Procedure
1. Log into the server as an administrator and select View > Repository
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Note:
If you log in as a user, you can edit a report that you created. This example
requires an administrator login because an administrator created the
complex report.

2. Search or browse the repository to locate the report. In this example, go to
Organization > Reports.

3. Right-click the New Complex Report and select Edit from the context menu. The
JasperReport wizard opens the report unit.

4. Navigate to the page of the wizard for making the change; in this example, click
Controls & Resources.

5. Make changes to an input control prompt and the display mode of the input controls,
for example:

a. Click the name of the TextInput control. The Locate Input Control page shows
that this input control is locally defined.

b. Click Next. The Create Input Control page appears.

c. Change the contents of the Prompt Text field to Enter a number. Click Next.
The Locate Datatypes page appears. You can select a different datatype from
the repository. For this example, accept the existing datatype setting.

d. In Locate Datatypes, click Next.

e. In Set the Datatype Kind and Properties, click Save to accept the datatype
property settings.

6. On the Controls & Resources page:

a. Change the Display Mode to In Page.

b. Clear the Always prompt check box.

c. Click Submit.

7. Run the New Complex Report again.
Instead of appearing in a pop-up before the report, the input controls appear in the
Filters panel of the report. In Output of the Modified Report you can see the new
prompt Enter a number for the text input control. Because none of the input controls
in this example are required, the report can display with blank input controls. Enter
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values and click Apply to modify the report output according to your input.

Figure 146: Output of the Modified Report

Localizing Reports
You can adapt reports to global audiences by localizing input controls and field names:

• Input controls – The server supports multi-lingual prompts and static lists of values
in reports.

• Field names – The server supports multi-lingual field names in reports.

A $R expression that you write in the report design triggers linguistic changes in the report
output for different locales. Each $R expression refers to a name-value pair (your
translations) in a resource bundle. A resource bundle file is a text file that has a .properties
extension. You create a resource bundle in Jaspersoft Studio or a text editor. You set the
base name of the resource bundle in the header of the JRXML file:

<jasperReport name=”StoreSales” pageWidth=”595” pageHeight=”842” columnWidth=”515”
leftMargin=”40” rightMargin=”40” topMargin=”50” bottomMargin=”50”
resourceBundle=”simpleTable”>

For example, simpleTable is the base name of the resource bundle file for this report. If you
prefer using a graphical user interface to coding in XML, use Jaspersoft Studio to set the
base name of the resource bundle.
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Running a Localized Report
In this procedure, you run the Romanian version of the complex report that you added in
Uploading Undetected File Resources.

To run the Romanian version of the complex report

Procedure
1. Choose the Romanian locale on the login page of the server, and login as an

administrator.

2. Click View > Repository, and navigate to Organization > Reports.

3. Click the name of the complex report, New Complex Report. The Input Controls
dialog appears.

4. Enter input control values:

a. Text Input Control: 3

b. Check Box Input Control: Check the check box.

c. List Input Control: Select Third Item.

d. Date Input Control: Click and select March 31, 2010.

e. Query Input Control: Select Sarah Smith from the drop-down.

f. Click OK.
The fields in the title band and column names (sales person, sales account, and
sales amount), shown in A Report Localized for the Romanian Locale, appear in
the language set by the Romanian resource bundle sales_ro.properties:

title=Raport al v\u00E2nz\u0103rilor lunare
sales.person=Agent de v\u00E2nz\u0103ri
sales.account=Client
sales.amount=Sum\u0103
param.number=Num\u0103r
param.date=Dat\u0103

The currency and dates in the report output header map to Romanian locale
settings.
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Figure 147: A Report Localized for the Romanian Locale

By default, the web interface elements appear in US English when you choose an
unsupported locale, such as the Romanian locale. If you choose a supported language, the
web interface elements appear in that language. Supported languages are Chinese
(Simplified), French, German, Japanese, and Spanish. You can customize the server to
support additional languages. You can translate the web interface into a different language,
server property names, and messages in another language. For some locales, you may also
need to change the default locale and time zone. For more information about localizing the
server, see the JasperReports Server Administrator Guide.

Reusing Domain Localization Files
The location of a resource bundle determines whether it's reusable and the conditions
under which the server uses it. To resolve a $R expression in a report, the server scans
resource bundles at two levels in the order described in this table.

Order Level Description

1 Report/
Repository

A report-level bundle declares the resource bundle base name in
the header of its JRXML file. The Romanian resource bundle is a
report-level bundle. A repository-level bundle is independent of any
specific report and can be linked to multiple reports, as described in
JasperReports Server Data Management Using Domains.
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Order Level Description

2 Server A server-wide bundle typically contains server messages and labels
of user interface components, as described in the JasperReports
Server Administrator Guide. This bundle typically resides in the
WEB-INF/bundles directory of the server.

First, the server searches the report/repository level and stops scanning resource bundles if
it finds a resolution to the $R expression. If the server does not find a resolution, it scans
the server level for the resource ID of the field and uses this ID.

Using Default Fonts in JasperReports Server
By default, the server uses three fonts for reports:

• DejaVu Sans

• DejaVu Serif

• DejaVu Sans Mono

Using the DejaVu fonts included, the server ensures availability of fonts in all environments.
The PDF is pixel-perfected every time.

The DejaVu fonts replace the Java logical fonts used in previous versions of the server:

• SansSerif

• Serif

• Monospaced

SansSerif, Serif, Monospaced can still be used, but are deprecated because these Java logical
fonts map to different TTF files in different environments, and run the risk of text being cut when
exported to PDF due to font metric mismatches. Also, these Java logical fonts are not recognized
by some browsers, resulting in font substitutions. For example, Firefox in a Windows environment
renders the SansSerif logical font as Serif.

When using the DejaVu fonts coming from font extensions, you do not need to set any
other font attributes (such as the pdfXXX attributes) in the JRXML or specify font mapping.
The font extension file that makes these fonts available sets font attributes and mapping.

For more information about DejaVu, refer to its SourceForge project at:

http://dejavu-fonts.org/wiki/index.php?title=Main_Page.
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When you upload a TrueType font to the repository, the file name must include the correct
extension (.TTF).
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Jaspersoft Documentation and Support
Services
For information about this product, you can read the documentation, contact Support, and
join Jaspersoft Community.

How to Access Jaspersoft Documentation

Documentation for Jaspersoft products is available on the Product Documentation website,
mainly in HTML and PDF formats.

The Product Documentation website is updated frequently and is more current than any
other documentation included with the product.

Product-Specific Documentation

The documentation for this product is available on the JasperReports® Server Product
Documentation page.

How to Access Related Third-Party Documentation

When working with JasperReports® Server, you may find it useful to read the
documentation of the following third-party products:

How to Contact Support for Jaspersoft Products

You can contact the Support team in the following ways:

l To access the Support Knowledge Base and getting personalized content about
products you are interested in, visit our product Support website.

l To create a Support case, you must have a valid maintenance or support contract
with a Cloud Software Group entity. You also need a username and password to log
in to the product Support website. If you do not have a username, you can request
one by clicking Register on the website.

https://community.jaspersoft.com/documentation/
https://community.jaspersoft.com/documentation/
https://community.jaspersoft.com/documentation/
https://community.jaspersoft.com/documentation/
https://www.jaspersoft.com/support
https://www.jaspersoft.com/support
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How to Join Jaspersoft Community

Jaspersoft Community is the official channel for Jaspersoft customers, partners, and
employee subject matter experts to share and access their collective experience. Jaspersoft
Community offers access to Q&A forums, product wikis, and best practices. It also offers
access to extensions, adapters, solution accelerators, and tools that extend and enable
customers to gain full value from Jaspersoft products. In addition, users can submit and
vote on feature requests from within the Jaspersoft Ideas Portal. For a free registration, go
to Jaspersoft Community.

https://jaspersoftideas.tibco.com/
https://community.jaspersoft.com/
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Legal and Third-Party Notices
SOME CLOUD SOFTWARE GROUP, INC. (“CLOUD SG”) SOFTWARE AND CLOUD SERVICES EMBED,
BUNDLE, OR OTHERWISE INCLUDE OTHER SOFTWARE, INCLUDING OTHER CLOUD SG SOFTWARE
(COLLECTIVELY, “INCLUDED SOFTWARE”). USE OF INCLUDED SOFTWARE IS SOLELY TO ENABLE THE
FUNCTIONALITY (OR PROVIDE LIMITED ADD-ON FUNCTIONALITY) OF THE LICENSED CLOUD SG
SOFTWARE AND/OR CLOUD SERVICES. THE INCLUDED SOFTWARE IS NOT LICENSED TO BE USED OR
ACCESSED BY ANY OTHER CLOUD SG SOFTWARE AND/OR CLOUD SERVICES OR FOR ANY OTHER
PURPOSE.

USE OF CLOUD SG SOFTWARE AND CLOUD SERVICES IS SUBJECT TO THE TERMS AND CONDITIONS
OF AN AGREEMENT FOUND IN EITHER A SEPARATELY EXECUTED AGREEMENT, OR, IF THERE IS NO
SUCH SEPARATE AGREEMENT, THE CLICKWRAP END USER AGREEMENT WHICH IS DISPLAYED WHEN
ACCESSING, DOWNLOADING, OR INSTALLING THE SOFTWARE OR CLOUD SERVICES (AND WHICH IS
DUPLICATED IN THE LICENSE FILE) OR IF THERE IS NO SUCH LICENSE AGREEMENT OR CLICKWRAP
END USER AGREEMENT, THE LICENSE(S) LOCATED IN THE “LICENSE” FILE(S) OF THE SOFTWARE. USE
OF THIS DOCUMENT IS SUBJECT TO THOSE SAME TERMS AND CONDITIONS, AND YOUR USE HEREOF
SHALL CONSTITUTE ACCEPTANCE OF AND AN AGREEMENT TO BE BOUND BY THE SAME.

This document is subject to U.S. and international copyright laws and treaties. No part of this
document may be reproduced in any form without the written authorization of Cloud Software
Group, Inc.

Jaspersoft, JasperReports, Visualize.js, and TIBCO are either registered trademarks or trademarks of
Cloud Software Group, Inc. in the United States and/or other countries.

All other product and company names and marks mentioned in this document are the property of
their respective owners and are mentioned for identification purposes only. You acknowledge that all
rights to these third party marks are the exclusive property of their respective owners. Please refer to
Cloud SG’s Third Party Trademark Notices (https://www.cloud.com/legal) for more information.

This document includes fonts that are licensed under the SIL Open Font License, Version 1.1, which is
available at: https://scripts.sil.org/OFL

Copyright (c) Paul D. Hunt, with Reserved Font Name Source Sans Pro and Source Code Pro.

Cloud SG software may be available on multiple operating systems. However, not all operating
system platforms for a specific software version are released at the same time. See the “readme” file
for the availability of a specific version of Cloud SG software on a specific operating system platform.

https://www.cloud.com/legal
https://scripts.sil.org/OFL
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THIS DOCUMENT IS PROVIDED “AS IS” WITHOUT WARRANTY OF ANY KIND, EITHER EXPRESS OR
IMPLIED, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY,
FITNESS FOR A PARTICULAR PURPOSE, OR NON-INFRINGEMENT.

THIS DOCUMENT COULD INCLUDE TECHNICAL INACCURACIES OR TYPOGRAPHICAL ERRORS. CHANGES
ARE PERIODICALLY ADDED TO THE INFORMATION HEREIN; THESE CHANGES WILL BE INCORPORATED
IN NEW EDITIONS OF THIS DOCUMENT. CLOUD SG MAY MAKE IMPROVEMENTS AND/OR CHANGES IN
THE PRODUCT(S), THE PROGRAM(S), AND/OR THE SERVICES DESCRIBED IN THIS DOCUMENT AT ANY
TIME WITHOUT NOTICE.

THE CONTENTS OF THIS DOCUMENT MAY BE MODIFIED AND/OR QUALIFIED, DIRECTLY OR
INDIRECTLY, BY OTHER DOCUMENTATION WHICH ACCOMPANIES THIS SOFTWARE, INCLUDING BUT
NOT LIMITED TO ANY RELEASE NOTES AND "README" FILES.

This and other products of Cloud SG may be covered by registered patents. For details, please refer
to the Virtual Patent Marking document located at https://www.tibco.com/patents.

Copyright © 2005-2024. Cloud Software Group, Inc. All Rights Reserved.

https://www.tibco.com/patents
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